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http://www.oracle.com/accessibility/ .

Accessibility of Code Examples in Documentation
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This chapter provides overviews of the application and its components, explanations
of key concepts and features, as well as the application’s relationships to other Oracle
applications.

2 Using Oracle Service Contracts

This chapter provides process-oriented, task-based procedures for using the application
to perform essential business tasks.

3 Implementing Oracle Service Contracts

This section describes the setup forms and gives references that help you understand
the underlying dependencies.

The implementation section consists of the following topics:

• Confirming Setups of Oracle Applications, page 3-2

• Setting Up Service Contracts, page 3-8

Related Documents

Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI). This guide also includes information on setting user
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Contracts Core Implementation and User Guides

These manuals contain detailed information about implementing and using Oracle
Contracts Core, along with all the other Oracle applications that support a successful
implementation.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser,
database triggers, or any other tool to modify Oracle Applications data unless otherwise
instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus
to modify Oracle Applications data, you risk destroying the integrity of your data and
you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a row
in one table without making corresponding changes in related tables. If your tables get
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out of synchronization with each other, you risk retrieving erroneous information and
you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track of
who changes information. If you enter information into database tables using database
tools, you may store invalid information. You also lose the ability to track who has
changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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1
Understanding Oracle Service Contracts

This chapter provides overviews of the application and its components, explanations
of key concepts and features, as well as the application’s relationships to other Oracle
applications.

This chapter covers the following topics:

• Overview of Oracle Service Contracts

• Types of Contracts

• Contract Components

• Parties

• Lines

• Contract Lifecycle

• Creation

• Approval

• Entitlements / Fulfillment

• Pricing

• Billing

• Managing Contracts

• Integration with other Oracle Applications

Overview of Oracle Service Contracts
Service contracts are usually sold to customers to support, repair, and maintain their
products or services. These contracts frequently offer the advantage of billing on a
recurring basis either monthly, quarterly, or annually, and offer the customer the option
to pay in advance or in arrears of the period of service.

Oracle Service Contracts enables you to design, manage, and bill for service
offerings tailored to your customers’ needs. All contracts are held centrally;
subscriptions, warranties, extended warranties, or complex service agreements, thus
providing the service provider visibility to all service entitlement information.

Integration of Oracle Service Contracts with other Oracle applications, page 1-7
automates the contract process and provides access to information contained in other
Oracle applications.
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Types of Contracts
Oracle Service Contracts enables you to create and manage the following types of
contracts:

• Warranty: If a serviceable product has an associated warranty, the warranty contract
is automatically created when the product is shipped. You can view the new
contract in Oracle Install Base and Oracle Service Contracts. The contract start date
is set to ship date plus any delay time that is defined for the warranty. Whenever
possible, when multiple products are sold on one order, one warranty is created
for all the products. If the warranties on products sold on one order differ (for
example, by duration), one contract is created but the unique terms of the warranty
are tracked on separate contract lines. A warranty may also be created when a new
product, with associated warranty, is added directly to the installed base. To view
the contract in Oracle Install Base, query the product number and select the contracts
link. The Contact Detail page displays the covered products.

• Extended Warranty: An extended warranty contract is automatically created
when an extended warranty is sold on a sales order. The extended warranty may
cover products that are being sold at the same time (immediate service), or it
may cover products already owned by the customer (delayed service). To reduce
administrative overhead, extended warranty contracts can also be consolidated in
a similar way to warranties.

• Service Agreement: A service agreement contract is created when a service item is
sold via the contract authoring process.

• Subscription: You can use subscription contracts to sell tangible items such
as magazines, newspapers, CDs, or newsletters; or intangible items such as
memberships, digital assets, or services. For tangible subscriptions, a delivery
schedule can be created as part of the contract. This schedule drives the release of
the subscription items to the customer, via Oracle Order Management.

Contract Components
Contracts are made up of information at various levels of a hierarchy. Some information
is required only at the highest level, referred to as the Summary or Header. The
remaining information is available at lower levels, called Lines and Sublines, or may be
accessed from all three levels.

• Information found at the Contract Summary level includes:

• Contract number

• Effectivity dates

• Pricing and billing information

• Party information (customer information such as billing and shipping
information)

• At the Line level, the contract contains:

• Effectivity dates

• Billing information

• Billing and shipping addresses

• Service to be performed (such as service, usage, and subscription)
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• The Subline level contains:

• Products being covered

• Effectivity dates

• Billing information

The key components of Oracle Service Contracts are:

• Parties

• Lines and Sublines

Parties
The primary focus in a service contract is the customer. While focusing on
customers, Oracle Service Contracts enables you to define additional parties. For each
party on the contract, any number of contacts can be defined on the contract. You can
assign a role to each party, for example contract administrator, by selecting from the
roles supplied with Oracle Service Contracts. You can further modify roles to suit your
specific business requirements.

Information about the customer, including the bill to and ship to information for the
contract, is initially identified at the Contract Summary level, but can be refined at the
line level to make it more specific to each individual service being performed.

Lines
A contract can contain any number of lines. Each line inherits certain information from
the contract summary such as effectivity dates, bill to and ship to information, and
billing rules and schedules. These can be changed as appropriate to allow the contract
to conform to customers’ requirements. A contract line may be related to one or more
sublines.

The line level is also used to enter the individual services that must be provided. These
services consist of the following basic groups:

• Service: Service lines cover a broad category of items that can include activities
such as field service, depot repair, call center, technical support, or any other
user-defined business activities. Services may cover individual products or
a group of products, for example, all products at a specific location, or all
products grouped into a system. Service lines use sublines to indicate what
party, customer, site, system, item, or product are covered by a particular service. For
example, Service line 1 for field service may cover all of the computer equipment at
site A, or it may instead cover Laptop L451, L359 and L863.

• Usage: In addition to service line items, Oracle Service Contracts helps you define
usage line items in a contract. For example, if a customer is renting a photocopier, the
business can charge either on a per-copy basis or a fixed price. The business
may set a minimum charge, and vary the price depending on volume. Oracle
Service Contracts can contain definitions of usage items and also consumable items
(paper for printers, cash for ATM machines) that customers may want to have
replaced at regular intervals along with descriptions of service coverage (field
service, customer support) to customers. Oracle Service Contracts integrates with a
customer’s installed base to obtain actual usage information for products covered
in a contract. Usage lines can leverage sublines the same as Service lines. A usage

Understanding Oracle Service Contracts 1-3



line references a specific product that is owned by a customer, which contains
a meter, for example a copy machine. The subline contains information about the
meter on that individual copier and allows you to update the counter information to
facilitate billing.

• Subscription: Oracle Service Contracts provides support for businesses that
manage subscriptions. Subscriptions may include tangible products such as
magazines, newsletters, or CDs. Also, they may cover intangible items such as
memberships, web site access, or digital library downloads. Tangible subscription
products include schedules indicating when the item is to be delivered or
fulfilled. This schedule is then integrated with Oracle Order Management to
automatically generate the orders to manage the delivery process. Subscription lines
do not contain any sublines.

Contract Lifecycle
A contract lifecycle includes:

• Creation, page 1-4

• Approval, page 1-5

• Entitlements / Fulfillment, page 1-5

• Pricing, page 1-6

• Billing, page 1-6

• Managing Contracts, page 1-7

Creation
Warranty and extended warranty contracts can be created automatically, as a result of
selling products and services (see Types of Contracts, page 1-2). More complex services
can be sold by creating contracts directly in Oracle Service Contracts.

Authoring Contracts

Contract authoring involves the creation of a contract from defining an offering to
obtaining customer approval on the pricing, coverage, and other terms and conditions
set up in the contract.

Contracts can be created from scratch, by copying parts of an existing contract or by
using a contract template. Defining a contract requires the following steps:

• Select customer information, including bill-to and ship-to addresses.

• Define the duration of the contract and the price list used for pricing services
in the contract.

• Assign billing information such as the schedule of when and how much to bill
the customer. The billing engine can calculate amounts or you can define it
manually as well as decide when it is sent to Oracle Receivables. If a contract
line is terminated, then the billing engine automatically adjusts the amount that
needs to be sent to Oracle Receivables.

• Select and price the service, usage and subscription lines, provided as part of the
contract and identify the products covered.
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• For service lines, check and if required, edit the coverage times, response, and
resolution times and customer entitlements that defaulted from the coverage
template. For example, a field service visit may be covered from 9 to 5, with a 10
percent discount on replacement materials used. The customer would then receive
a 10 percent discount, defined in the coverages, for the material used but would
not receive any discounts on any labor charges incurred during the field service
visit. For subscription lines, verify or modify the delivery schedule defaulted from
the subscription template.

• For subscription lines, verify or modify the delivery schedule defaulted from the
subscription template.

• Check the contract is valid by running the QA check.

• Approve the contract.

Approval

Internal Approval

Before presenting the contract to the customer, it should be checked to ensure all the
information contained within it is valid and complies with internal policies. These
checks may range from basic checks to ensure that coverage dates are sequential, to
more complex checks to ensure service is not defined to cover decommissioned
products. Mandatory checks are already defined and will run against every contract you
create. You can also define your own checks to enforce your company policy.

Customer Approval and Signature

After authoring a contract, you may need to obtain customer approval on
pricing, coverage, and other terms and conditions set up in the contract.

Entitlements / Fulfillment
The contract defines the resource, support, or service to which a customer is
entitled. When the customer calls, these entitlements would be checked prior to
providing service as defined in the contract. Examples of entitlements include access to
tangible or intangible resources, maintenance, repairs, or replacements.

Service Entitlements

The process of checking service entitlements, such as verifying if customers are calling
during covered hours or finding agreed reaction times can be used by other Oracle
applications such as TeleService, Field Service, and Depot Repair to ensure that services
in these downstream applications are carried out according to the contract.

Subscription Fulfillment

Fulfillment starts after the contract approval process. Driven by each subscription
line’s instantiated fulfillment template, a concurrent program creates a sales order, for
each delivery, in Oracle Order Management. The order details are populated with
information from the subscription agreement. Once the order is created in Oracle Order
Management, you can release and ship.
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The integration to Oracle Order Management is bidirectional. Item and fulfillment
details are sent to Oracle Order Management to create a sales order. When the order is
ship confirmed, delivery and status details are sent from Oracle Order Management
so they could be recorded in the subscription contract.

Pricing
To ensure accurate pricing, Oracle Service Contracts retrieves the contractual prices of
services or usage from Oracle Advanced Pricing. Price breaks can be set up to vary the
price applied depending on volume used. Price adjustments can be automatically
applied to the contract, as well as simply adjusting the price manually. Any adjustment
applied is tracked and can be viewed from the contract.

Billing
Oracle Service Contracts can handle complex billing scenarios using a flexible billing
schedule that enables you to control the duration, timing and amount to be billed. You
can tailor the billing process further by defining bill settlement, invoice averaging, and
billing profiles.

Billing Profile

Oracle Receivables allows billing information to be defined for each customer. The
Billing Profile in Oracle Service Contracts enables you to define how billing should
be carried out for individual contracts. Billing profiles include information about
accounting and invoicing rules, type of billing, and its frequency. Invoices are generated
according to the billing profile attributes.

Billing for Customer Usage

Customers can choose to pay for actual quantities of products they use, pay for a fixed
quantity, or value each billing period. If a customer chooses to be billed for actual
usage but usage numbers are not received in time to issue an invoice, default values
can be used in place of actual numbers. Default values can be defined based on an
average of historical readings, otherwise known as the Average Monthly Counter
Volume. Oracle Service Contracts can contain usage price breaks for varying the price
applied depending on the volume used. A minimum quantity can also be defined so that
the customer is charged based on their actual usage as long as it is over the minimum
threshold, otherwise they are charged the minimum amount.

Billing Interface

Services, usages and renewals managed in Oracle Service Contracts can be interfaced
directly to Oracle Receivables, which then generates invoices from the pricing defined on
the contract, based on the invoicing rules. Invoice information and billing history can
automatically be retrieved from Oracle Receivables and tracked against the contract.

Self Service Invoices

Your customers can also have direct visibility to invoice information through
Oracle iReceivables (see Integration with Oracle iReceivables, page 1-8). This is a
self-service, interactive environment that allows your customers to drill up or down their
invoice details as necessary, to find the information they need to accept the invoice.
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Managing Contracts
Service Contracts provides contract management features for streamlining and
proactively controlling contract actions such as renewals and terminations.

Change Management and Versioning

Changes are often made throughout the contract lifecycle and come from multiple
sources. Oracle Service Contracts provides the necessary change management processes
that protect a contract so that only approved users can make the change, and approve
them before the contract can again become active. Versions of contracts are automatically
tracked before and after each change. Contract administrators can apply changes across
multiple contracts at one time. This supports scenarios such as extending all contracts
for a particular customer, or changing the price list on multiple contracts.

Expiration and Renewal

The AutoRenewal feature enables you to specify a period of time, prior to expiration
date, for renewing a contract. For example, the renewal process can be set up to
automatically pick up a contract prior to its expiration date and begin the renewal
process.

Events

Events can be set up to help you proactively act upon the terms and conditions
of the contract. Events can initiate workflow processes or any other predefined
functions. Using product and service counters, events can track product and service
usage. You can define events that will trigger certain actions at periodic intervals or
based upon a particular counter usage. For example, a preventive maintenance visit
could be scheduled when a product counter reaches 1,000, or a service counter may track
free calls covered on the support contract. Also, when milestones in call volumes are
reached, defined events can trigger a change in billing rate or terminate a customer’s
contract. Events can be based on actions for example, a contract signed, terminated, a
change request initiated, or date-based such as a contract expiration date.

Events are a combination of actions, conditions, and outcomes that allows you the
flexibility of handling a diverse range of event-related scenarios. Events can also be
leveraged by other Oracle Service applications. For example, if an important event
happens, you may want to automatically initiate a task, service request, workflow, or
other type of procedure if certain conditions are met.

Termination

Once a contract is terminated, certain actions need to be taken. Oracle Service Contracts
lets you enter the reasons for termination and any other notes that need to be tracked
regarding the circumstances of the termination. It calculates the final credit or debit
amount, allows you to override that value, and sends it to Oracle Receivables for
processing.

Integration with other Oracle Applications
Oracle Service Contracts integrates with other Oracle applications including:
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Oracle Contracts Core

Oracle Service Contracts leverages functionality provided in Oracle Contracts
Core to support common contract management activities such as contract
renewal, versioning, article management, and change management. However, not all
features that are available in Oracle Contracts Core are appropriate for Oracle Service
Contracts. Functionality such as defining line styles provided by Contracts Core, is not
supported in Oracle Service Contracts.

Oracle Contracts Core provides the foundation for Oracle Service Contracts and is a
required product.

Oracle Contracts

Oracle Service Contracts uses the Contract Terms Management functionality provided
by Oracle Contracts. You can use this functionality to create articles, reference standard
articles, and modify existing articles.

Oracle Order Management

Oracle Order Management is required for subscription, warranty, and extended
warranty management as it provides information from the sales order on associated
services that have been purchased.

Oracle Advanced Pricing

Oracle Advanced Pricing is required to retrieve pricing information for services or usage
purchased on the contract as well as to use advanced features such as modifiers.

Oracle Bills of Material

Oracle Bills of Material provides information on warranties that are to be included
as contracts.

Oracle Inventory

Oracle Inventory is required to define service, subscription, and usage items.

Oracle Receivables and iReceivables

Oracle Service Contracts integrates directly with Oracle Receivables for contract
billing and Oracle iReceivables for self service visibility to invoice information. For
tax calculation, Oracle Service Contracts integrates with Oracle Receivables Global
Tax engine and make the sales tax amount readily available when authoring a
contract. Integration of Oracle Service Contracts with Oracle iReceivables provides drill
down capability and enables customers to view the invoice details online.

Oracle Advanced Service Online

Integration of Oracle Service Contracts with Oracle Advanced Service Online enables
you to view the history and activities of any preventative maintenance program.

Oracle Install Base

To simplify selecting the products covered by a contract, Oracle Service Contracts
accommodates an expandable/collapsible set of data from Oracle Install Base. You can
select any node or data item for inclusion in or exclusion from coverage. Once the
products to be covered have been identified and included in a contract, any changes
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to them in Oracle Install Base (transfer of ownership, replacement, or returns) will be
reflected in the contract, ensuring that the information contained in the contract is
in line with that in Oracle Install Base.

During contract creation, entries are added to Oracle Install Base by Oracle Service
Contracts. A new item instance is created when an item with the Subscription category
is saved on a contract. Processes such as transfers and terminations that are done in
Oracle Install Base, have no effect on the contract. These actions should be handled
within Service Contracts authoring.

Oracle Service Applications

Oracle Service Contracts allows other Oracle applications to view the coverage for
a particular contract. Entitlement information is made available to any application
that requests it such as, Oracle Customer Support, Field Service, Install Base, Depot
Repair, and Charges.

Oracle Contracts Intelligence

Oracle Contracts Intelligence provides critical contractual information that can be used to
manage service contracts and renewals business. To enable reporting by hierarchy, Oracle
Contracts Intelligence can access the sales group information in Oracle Service Contracts.
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2
Using Oracle Service Contracts

This chapter provides process-oriented, task-based procedures for using the application
to perform essential business tasks.

This chapter covers the following topics:

• Offering Management

• Service Coverage

• Coverage Templates

• Coverage Process Flow

• Defining Service, Subscription, and Usage Items

• Warranties

• Defining Serviceable Products

• Defining Subscription Products

• Master Item Field Definitions

• Defining Usage

• Pricing Service and Usage

• Service Pricing

• Usage Pricing

• Usage Item Price Breaks

• Defining Usage Price Breaks

• Selling Products and Services in Order Management

• Automated Creation

• Flexible Service Programs

• Activating Service

• Service Coverage

• Controlled Service Availability

• Ordering Service Programs

• Cotermination

• Warranties and Extended Warranties
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• Warranty and Extended Warranty Process Flow

• Contract Details at Order Management

• Order Cycle

• Warranty and Extended Warranty Consolidation

• Reprocessing Orders

• Authoring

• Contract Authoring and Pricing

• Creating Contracts

• Contract Header

• Using the Summary Tab

• Summary Parties Tab

• Summary Pricing/Billing Tab

• Summary Renewals Tab

• Summary Administration Tab

• Summary Security/Text Tab

• Managing Contract Terms

• Applying Contract Templates

• Changing Contract Templates

• Removing Terms

• Adding and Deleting Sections

• Deleting a Section

• Adding and Updating Articles

• Adding Standard Articles

• Updating Articles

• Deleting Articles

• Creating Non-Standard Articles

• Comparing Standard and Non-Standard Articles

• Moving Contract Terms

• Renumbering Contract Terms

• Validating Contract Terms

• Check for Article Updates

• Using the Lines Tab

• Lines Accounts Tab

• Lines Effectivities Tab

• Lines Pricing/Products Tab
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• Lines Billing Button

• Lines Tax/Payment Options Tab

• Lines Counters Tab

• Lines Events Tab

• Using the Tools Menu Functions

• Revenue Distribution

• Create New Version

• Change Status

• Pricing Qualifier

• Pricing Adjustment

• E-mail Quote

• Update Service

• Terminate Subline

• Summary/Lines

• Invoice Details

• Notes

• Using the Actions Menu Functions

• Save as Template

• Copy from Template/Contract

• Counter Setup

• Counter Capture

• Check QA

• Submit for Approval

• Bookmark

• Event Details

• Show Index

• Delete Contract

• Cascade Service Price

• Allocating Sales Credits

• Pricing Attributes

• Cascade Attributes

• Revert Update

• Billing

• Billing for Contracts

• Billing for Services
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• Automatic Service Program Billing

• Summary Billing

• Bill Settlement

• Bill Termination

• Service Settlement

• Executing Main Billing

• Overview

• Running the Billing Program

• Running the Fetch AR Program

• Running Usage Averaging and Settlement for Billing Program

• Commitment and Credit Card Billing Methods

• Reviewing Entitlements

• Sharing Contract Information

• Overview of Entitlements Processing

• Entitlements Search

• Managing Contracts

• Editing a Contract

• Finding a Contract

• Cascading Service Price

• Renewing Contract

• Using Renewal Procedures

• Repricing a Contract

• Reviewing Renewal and Administration Rules

• Defining Security Attributes

• Determining Line Duration

• Reviewing Pricing Attributes

• Renewal Consolidation

• Using Renewal Consolidation

• Termination

• Contract Termination

• Terminating a Contract Line

• Terminating a Subline

• Extending Contract Line

• Grace Period

• Mass Change
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• Electronic Renewals

• Reassigning Resources

• Reporting

• Speeding Up Access to Other Applications Using the Quick Menu

• Creating or Modifying a Contact Record

• Creating or Modifying a Customer or Third-Party Contact Record

• Creating or Modifying a Contact Record for an Account in a Contract Line

• Creating and Enabling Templates for E-Mails to Customers

• Overview

• Creating and Enabling Templates for E-mail Attachments Sent by Agents

• Creating and Enabling Templates for Electronic Renewals

• Contract-Specific Data Available for Inclusion in Template Documents

• Viewing the Data Definition Structure

• Uploading and Registering a Template in Oracle XML Publisher

• Creating the Set of Templates Used for a Specific Renewal Flow

• Specifying How the Template Sets Are to Be Used

• Viewing PDF Attachments

• Viewing Sample Marked-Up Documents Provided with the Application

Offering Management
Your customers are unique. To define an individual contract from scratch for every
customer is not practical. To balance efficient contract creation with the unique needs of
your customer, Oracle Service Contracts provides Offering management. This permits
standard service offerings to be defined in advance, while allowing them to be tailored to
a customer’s needs in the actual contract. For example, you can offer gold, silver, and
bronze support options, each of which represents a set of available offerings.

Offering selection involves determining which offering most closely matches the
customer’s needs from all the current offerings, then configuring it for the customer’s
needs.

You can add or update offerings any time. The offering updates affect only new contracts
authored from the offerings; they do not affect existing contracts.

This section includes the following information:

• Service Coverage, page 2-5

• Coverage Templates, page 2-6

• Coverage Process Flow, page 2-7

Service Coverage
Service coverage describes the situation under which the customer is covered for
service. Services are broken down into business processes that can apply to the service
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(such as support, depot repair, and field service). Coverage terms are then defined for
these business processes.

Coverage reflects the service request reporting time stated in days or hours, and the
repair expenses. By setting effective start and end dates, you can phase in or phase
out a particular coverage. You can specifically define covered monetary amounts for
each service.

Coverage Templates
Oracle Service Contracts enables you to define a standard set of templates, to create
offers for a common set of agreements used by your organization and modify them
to meet your customers’ requirements. The coverage template defines the business
processes, times of coverage, days of coverage, reaction and resolution times for a service
request, preferred resources, and the bill types and bill rates that are covered.

For example, you can have a Gold coverage template which covers hotline support and
onsite support business processes. The hotline support includes 24 hours, 7 days a week
support with 2-hour reaction time for high priority requests and the onsite support
includes 9-to-5 coverage, 5 days a week. As part of defining coverages, you define the
entitlements. For example, the onsite coverage covers a transaction type of replacement
and for a replacement transaction, the customer is charged for material and labor. You
define coverage that you want to give to a customer, such as a 10 percent discount on
material, and a 5 percent discount on labor up to $500.

In addition, a preventive maintenance (PM) program may be linked to a coverage
template which, when instantiated in a contract, includes the schedule (Date or Date
Ranges) to perform activities associated to the PM program as part of preventive
maintenance. The preventive maintenance schedule is created in a manner similar to
the billing schedule. Multiple maintenance streams can be defined for a preventive
maintenance program. Preventive maintenance programs are defined in Oracle
Complex Maintenance, Repair, and Overhaul. For more information, see the Managing
Maintenance Routes section of Oracle Complex Maintenance, Repair, and Overhaul User’s
Guide.

If appropriate, prior confirmation from the customer may be required to schedule the
preventive maintenance service request. This is executed via a check box provided as
part of program schedule definition in the coverage. Define the general terms and
conditions using the following attributes:

• Services: This attribute refers to user-defined services that are to be provided
in the contract. For example, you can define a 9-to-5 service coverage, with a 10
percent discount for materials, which could include field service transactions and
hotline support transactions.

• Times of coverage: This attribute defines days of the week, hours, and the start and
end dates for coverage. For example, you can set up 9-to-5 coverage as in the above
example. You have flexibility in defining times based on the service coverage’s
needs. In the Coverage Template form you can also define multiple start and end
times for hours of service coverage in a day. For example, you can set up coverages
for a business that opens at 8 am, closes from 12 to 3 pm and re-opens from 3 to 7 pm.

• Available resources: In the Coverage Template, you can classify available resources
as Preferred, Primary, or Excluded. So, when responding to a service request, the
correct resource could be assigned to resolve the issue. For example, if you classify a
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resource as Excluded, the Assignment Manager module excludes the resource from
the list of available resources.

• Reaction times: The reaction time refers to the time in which the service provider
must respond to a service request such as, a two-hour reaction time. Reaction times
may be defined differently for each user-defined severity level. The reaction times
are automatically enforced through Oracle TeleService.

• Resolution times: In addition to indicating how long the service organization has to
respond to a request, you may wish to define the maximum amount of time available
to bring the open issue to a resolution. For example, the customer may wish to have
any issues for a critical system completely resolved within four hours

• Discounts: This attribute refers to discounts that can be given based on the type of
transaction performed. Using the example above, you could set up a discount of 10
percent on materials used when service is performed.

• Levels of coverage: Coverage can be defined for individual products or items, or can
be referenced as part of a larger group of products, for example, all products owned
by a customer or party, or located at a customer site, or included as part of a system.

• Counters associated with the contract: These apply to counters tied to the
service. You can also have events tied to counters. For example, you can have
a preventative maintenance scheduled for a copier if its counter reading reaches
10,000 copies, or you can track the number of calls a customer has made to a
customer support center.

• Preventive maintenance program: This would identify the preventive maintenance
program and the corresponding schedule of program activities. You can define
preventive maintenance programs at both Program and Activity levels.

See Coverage Process Flow, page 2-7 for flow diagrams.

See Defining Coverage Templates, page 3-12 for setting up coverages.

Coverage Process Flow
The following diagrams highlight the difference between a coverage template and
an actual instance of coverage.

The first diagram highlights the different process steps involved in both.

The process for coverage of a specific contract include:

• Coverage Maintenance for Service

• Edit Coverage Details

• Define Business Processes and Coverage Times, Reaction and Resolution
Times, Severities and Workflows, Resources, Billing Types, and Billing Rates.

The process for a coverage template include:

• Coverage Template Setup and Maintenance

• Create, Edit, or Delete Coverage Template

• Define Business Processes and Coverage Times, Reaction and Resolution
Times, Severities and Workflows, Resources, Billing Types, and Billing Rates.

The second diagram highlights the structural differences between a coverage template
and actual instance of coverage.
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The structure for coverage templates includes:

• Contract Header - Seeded Template Header

• Coverage Template

• Business Process

• Reaction Time

• Resolution Time

• Resources

• Bill Type

• Bill Rate

The structure for instance of service contracts includes:

• Contract Header

• Service Line

• Coverage Terms

• Business Processes

• Reaction Time

• Resolution Time

• Resources

• Bill Type

• Bill Rate

• Coverage Levels

• Party Level

• Customer Account Level

• Party Site Level

• Item Level

• System Level

• Installed product Level

• Usage Line

• Product/Service Counters

2-8 Oracle Service Contracts Concepts and Procedures



Coverage Process Flow
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Structure for Instance of Service Contracts

Defining Service, Subscription, and Usage Items
Services are items defined in the item master that determine the coverage terms that are
given or sold to a customer. Coverage Templates must be defined before you can create a
service item. Services that are given to the customer free of charge, since the price is
assumed to be included in the price of the associated product, are called Warranties. All
other services may have a price associated with them and can be sold on a sales order or
via the contract authoring form. If a service item is sold via the sales order process, the
resulting contract is termed an Extended Warranty. If a service item is sold via the
contract authoring process, the contract is a Service Agreement.

A service that can be provided as a warranty is distinguished from other services by the
attributes set on the item master.

Warranties
After a warranty has been defined, it must be associated with a serviceable product in
Oracle Bills of Material for a warranty contract to be automatically created (refer to the
Oracle Bills of Material User’s Guide for further information). When that product is shipped
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or is manually created in the installed base, the warranty is automatically created in
Oracle Service Contracts. Warranties allow a support service to be automatically
associated with a product. The warranty is automatically associated with the customer
product in the installed base upon ordering and shipment of the product to the customer.

Each serviceable product can be shipped with one or more base warranties defined as
components in the product’s bill of material. The table below highlights the main
differences between warranties and extended warranties.

Warranties Extended Warranties

Non-orderable and managed automatically Can be ordered as an immediate or delayed
service

Cannot be authored, can only be created by
integration with Oracle Order Management or
manually created in Oracle Install Base

Can be authored or created via Oracle Order
Management interface

Do not have a cost Have unit or percentage based pricing

Associated with serviceable items in Oracle
Bills of Material (BOM)

Are not included in Oracle Bills of Material
(BOM)

Have warranty inheritance rules Do not have warranty inheritance rules

Cannot be renewed, can be extended or
terminated

Can be renewed, extended or terminated

Defining Serviceable Products
For a product to be covered on a service agreement, subscription, warranty, or extended
warranty, the product item has to be classified as a serviceable product.

Prerequisites
Product items must be created using Oracle Inventory.

To define a serviceable product:
1. From the Responsibilities menu select, Inventory > Items > Master Items (T) Service.

2. Select the Enable Contract Coverage check box to identify this product as being
serviceable.

3. Identify whether this item is material, labor, or expense in Billing Type.

4. If defects for this item are to be tracked, then select the Enable Defect Tracking
check box.

5. Select the speed in which an item is returned for Recovered Part Disposition.

6. Save your changes. The product item is now a serviceable product.

Defining Subscription Products
A tangible subscription item may be set up like any other inventoried product. You may
enable Work In Process, Bill of Materials and other options for the product. In addition
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to setting the item up as a tangible product, define the Contracts-related properties
listed below.

Prerequisites
A Subscription template must be created.

Subscription Template
A subscription template contains attributes that can be associated to a subscription
item. The attributes include Subscription type, Media and Property type, Fulfillment
Channel, and Frequency. A subscription item can be a tangible item, like newsletters
and compact disks or an intangible item like membership, digitized assets, and
’software as a service’. Subscription type specifies the type of subscription item such as
Magazines, Journals, and Memberships. You can modify the list of available subscription
types. Media and Property type specifies the subscription’s property identifier
such as print material, audio, and digital image. You can edit the list of available
media and property types. Currently Oracle Order Management is supported as the
fulfillment channel. If no fulfillment channel is specified, it is considered an intangible
item, and no delivery schedule is created for that item. Subscription Frequency such as
Yearly, Monthly, Weekly, and Daily identifies how often an item should be delivered.

To define a subscription product:

1. From the Responsibilities menu select, Inventory > Items > Master Items (T) Service.

2. Select the Enable Contract Coverage check box to identify this product as being
serviceable.

3. Select the Subscription Template that should be associated with this item. This
defines the fulfillment schedule defaults.

4. Identify the Bill Type as Material.

5. For both Tangible and Intangible subscription items, select the Track in Install
Base check box.

6. If defects for this item are to be tracked, then select the Enable Defect Tracking
check box.

7. Select the speed in which an item is returned for Recovered Part Disposition

8. Save your changes. The subscription item is now an inventory part as well as a
serviceable product.

Master Item Field Definitions
The table below displays the field descriptions for master service items.

Field Description

Main Tab -

Unit of Measure region The unit of measure must be time based, since
a service is to cover a set period of time.

Service Tab -
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Field Description

Service region Information for creating Serviceable Items

Service Request Select the Enabled option if you want service
requests be created for the item.

Enable Contract Coverage Select this check box, if the item being created
is a product that is eligible to be covered on a
service contract.

Enable Defect Tracking Select the check box, if defects should be
tracked for this product.

Enable Provisioning Select the check box to make the item eligible
for electronic fulfillment by Service Fulfillment
Manager.

Service Contracts Region Information for creating Service Items

Contract Item Type Select Service from the list of values.

Duration Enter the default duration of the service. For
example, if the service should default to 1
year, set the duration period as year and the
duration as 1. This may be overridden when
selling the service on a sales order or on the
contract.

Duration Period Select the Service Duration Unit of Measure
(for example, hour, day, month, and so on).

Template Select the template to be associated with the
service from the list of values. (Do not select
a template for a usage item.) This creates a
one to one relationship between the item and
the coverage so that the service can be priced
appropriately. For example, you may wish to
charge more for a 24X7 type of coverage than
you would for a 9X5 coverage.

Starting Delay (Days) Enter the number of days after the product
is shipped that the warranty or extended
warranty should become active.

Installed Base Region -

Track in Installed Based This flag enables life cycle tracking in Oracle
Install Base and Oracle Enterprise Install
Base. Once set, this flag should not be
changed. This flag should be set at the master
organization level.

Create Fixed Assets This indicates whether the item creates a
depreciable asset used in Enterprise Install
Base.
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Field Description

Instance Class This flag is used only in the Telecommunication
Service Ordering solution for defining a
configured link.

Debrief and Charges Region

Recovered Part Disposition Indicate if replaced parts are to be recovered
and how quickly.

Enable Service Billing Select the check box to enable the Billing Type
field.

Billing Type Indicate whether the customer is charged for
the following:

Material: Material usage expenses your
support organization incurs while providing
the service.

Labor: Labor expenses your support
organization incurs while providing the
current service.

Expense: Incidental expenses your support
organization incurs while providing the
current service.

Bills of Material Tab -

BOM Allowed Ensure the BOM allowed check box is selected
if the service is a warranty.

Invoicing Tab -

Invoicing Enabled Select this check box if the item is to be sold
to customers (not a warranty) such as, an
extended warranty contract, a subscription, or
a service agreement.

Order Management Tab -

Customer Orders Enabled Select this check box if the service can be
ordered externally.

Shippable Select this check box if this item is shippable.

Internal Orders Enabled Select the check box if the service can be
ordered internally.

For additional information see the Oracle Inventory User’s Guide chapter on Items, Service
Attribute Group.
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Defining Usage
As well as selling services on a service agreement, usage can be sold, such as copies on
a printer or supports calls to be made. Usage must be defined as an item in the item
master to be priced and sold on a contract.

To define usage:
1. From the Responsibilities menu, select Inventory > Items > Master Items (T) Service.

2. In the Contract Item Type, select the Usage option from the list of values.

3. Open the Order Management tab.

4. Select the Customer Order Enabled check box.

5. Open the Invoicing tab.

6. Select the Invoicable Item and Invoice Enabled check boxes.

7. Save your changes.

Pricing Service and Usage
This topic group includes the following:

• Service Pricing, page 2-15

Usage Pricing, page 2-16

Usage Item Price Breaks, page 2-18

Defining Usage Price Breaks, page 2-22

Service Pricing
The list price of a service is defined in Oracle Advanced Pricing through price lists. Fixed
or variable values can be assigned to each service program. Fixed prices are expressed as
actual prices on the price list. Variable prices are expressed as a percentage of the list price
of the serviceable product. When sales orders are entered in Oracle Order Management
for service programs, Oracle Order Management references the appropriate price list to
find or dynamically calculate the price of the ordered service program. Services can be
defined in multiple price lists. For example, corporate, standard, and seasonal list with
different list prices. However, only one price list can be associated with a service contract
at any given time. There are two main methods for the pricing of services:

• Unit-Based Pricing: Prices are based on a fee per period per product for service.

• Percentage-Based Pricing: Prices are based on a percentage of the list price of the
product(s) that is being covered. This is also based on a fee per period per product.

For pricing services that are entered on a contract, the mechanism works as
follows: First, a price list is associated with a contract. When services are entered on a
contract, a price can be retrieved from Oracle Advanced Pricing either as a list price (for
unit-based pricing) or a percentage (for percentage-based pricing). In computing an
extended price, a number of factors must be considered whether:

• Price needs to be applied to the number of products covered

• Price needs to be applied to the duration of the contract or service
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For example, consider a service priced using unit-based pricing at $100 per month. If
the service duration is 12 months, and the coverage is for 50 pieces of equipment, then
the extended price is:

• $100 per month x 12 months x 50 installed base items = $60,000

In the same example, priced using percentage-based pricing at 10% per month where the
list price is $1,200. For the same duration of 12 months and coverage for 50 pieces of
equipment, then the extended prices is:

• ($1,200 x 10%) x 12 months x 50 installed base items = $72,000

Once a price has been retrieved from the price list, you can manually override that price
by entering a value in the subtotal field for that subline. Prices entered manually can
be positive or negative values.

Discounting and Applying Surcharges

Prices on a contract may also be discounted or increased using Oracle Advanced Pricing
by applying modifier lists either automatically or manually. Qualifier lists may be
used to determine when to automatically apply certain modifier lists. Modifiers can
uplift as well as discount pricing.

For more information, please refer to Pricing Adjustment, page 2-86s.

Please refer to the Oracle Advanced Pricing User’s Guide, for information on setting up and
using Modifiers and Qualifiers.

Covered Levels and Pricing

Covered Levels define the level of product coverage and include the following types:

• Site: Covers all products at a particular customer site.

• Item: Covers all products of a particular item type for the customer (for example, all
Dell PC’s, Model: OptiPlex GXa). Items are defined in the inventory item master.

• Product: Covers a particular product from the customer’s installed base (for
example, Dell PC, Model: OptiPlex GXa, Serial #123456789).

• System: Covers all products of a particular system configuration.

• Customer: Covers all products for that customer account.

• Party: Covers all products for that party.

If the covered level is Product or Item, then the price of the product is obtained from the
price list. In all other cases you must manually enter the price.

Usage Pricing
Usage is an item in the item master and is priced on a price list defined in Oracle
Advanced Pricing. Usage tracks the customer’s use of a product or service. You can
define counters to monitor the usage of customer products and services and execute
business processes based upon the usage information. Common everyday objects
that have counters are automobiles (the odometer), gas meters, and photo copy
machines. Examples of service counters include the number of calls made to a help desk
or visits to a health club. Counters provide a mechanism for tracking new product
warranties, service contracts, support agreements, and similar business needs.
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Counter group templates are defined for groups of counters and are associated with
products or services. Once the counter group is created it can be modified for an instance
or for all instances. Counters are automatically made when a customer product is
created in Oracle Install Base or when service item that is associated with a counter
group template in the item master is placed on a contract line. Counters cannot be
manually created.

Counters may be defined in any of four types:

• Regular: These represent the physical counters found in tangible objects like
automobiles, gas meters, and photocopy machines. Also Service Counters can track
events that take place but they are not associated with a piece of equipment. For
example, if the number of service calls per customer is tracked manually you would
set up a counter of type Regular and have the agents increment the counter after
each call.

• Group function: This type enables you to derive counters using SUM and
COUNT. Group Function counters can be used in Formula Counters.

• Formula: Formula type counters enables you to use simple math to derive the
counter value. For example you may have a photocopy machine that provides black
& white copies and color copies. You may wish to track the total number copies. You
would create a Counter Group with three Counters:

• A Regular counter for total black & white copies

• A Regular counter for the total color copies

• A Formula counter for the total black & white + the total color copies

• Time Based: Time based counters are updated by a concurrent program, Time Based
Counters Engine, based upon the unit of measured assigned. For example, you may
wish to count the number of months since the product or service was purchased, the
number of weeks since the last maintenance, and so on.

Product counters are created when you create a customer product instance in Oracle
Install Base through the Create Customer Product form of Oracle Customer Support or
from the Add a Product feature of Oracle iSupport. In the same manner service counters
may be created upon the creation of a service contract, such as warranty, extended
warranty, and service agreement.

The Counters readings can be captured manually from the Capture Counters User
Interface (UI). The Capture Counter reading UI is available from the Service Request
UI, Field Service UI, or the Service Contracts Authoring UI.

The pricing for usage of products and services (tracked by counters) involve the
following:

• Products and services that are priced and tracked by counters, as well as the usage
item, should be defined as items in Oracle Inventory.

• The pricing of usage is defined in Oracle Advanced Pricing using price lists via price
breaks. Usage can be in multiple price lists (for example, corporate, standard)
with different list prices.

• In Oracle Install Base, counter group templates (groups, counters, properties) should
be defined and associated with either products or services.

• While authoring contracts, it is necessary to select the price list at the contract header
level. This price list is used to price usage and service lines. If selected from the
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price list Oracle Service Contracts creates a pricing rule and stores the price for a
service line. However, this is not the case for usage lines. While billing, the amount
to be billed is calculated through Oracle Advanced Pricing. Oracle Service Contracts
also supports usage pricing based on a negotiated amount, which supersedes the
calculated amount based on price breaks.

Usage Item Price Breaks
Similar to any items defined in the item master, usage items are set up in the price
list. Price breaks are defined with line type as Price Break Header that allows the entry
of price breaks. In addition, the Price Break Type is defined as either Point or Range
method. Point method designates that pricing is based on a specific range in the price
break. Range designates that pricing is based on all the price break ranges up to the level
corresponding to the counter reading.

The following example distinguishes the difference between Point and Range price break
types for a net counter reading of 3500 copies:

Break Price

0-1000 $.05

1001-3000 $.04

3001-5000 $.03

5001-10000 $.02

Point Amount

3500 Xs $.03 $105.00

Total Invoice $105.00

Range Amount

1000 Xs $.05 $50.00

2000 Xs $.04 $80.00

500 Xs $.03 $15.00

Total Invoice $145.00

Detailed Price Break Billing

To explain how billing amounts are calculated, Service providers can send billing
statements to their customers that include pricing details such as quantity billed and
unit price. When billing Usage items from counter readings, Oracle Service Contracts
sends the quantity billed and unit price for both Point and Range price breaks to Oracle
Receivables. Service providers can use this information to include price break details in
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invoices. The Price Break details are stored in the Billing History tab. To enable transfer
of detailed billing information to Oracle Receivables for price breaks, the Interface Price
Break check box, in the Global Contracts , page 3-52Defaults form, must be selected.

Advanced Meter Based Solutions

Oracle Service Contracts enables service providers to create contracts based on product
usage. Usage billing can be based on actual, estimated counter readings, or negotiated
values. For example, the usage of an office printer may be billed based on the number of
pages printed. Oracle Service Contracts also provides Advanced Meter Based solutions
to support usage estimation, price break proration, and contract specific price breaks:

Usage Estimation

When billing is due based on actual usage for a contract, and no counter readings
are available, Service Contracts can use either a user-defined default usage, or use
the AMCV (Average Monthly Counter Volume). Also when setting up a counter
template in Counters, an estimation method can be mapped to the counter template. The
estimation method can be changed at the counter instance level. The estimation
functionality available in Counters is supported for the usage calculation in Oracle
Service Contracts. Usage can be estimated for a full billing period, or as of a specific
date that may fall in the middle of a billing period. For example, estimate usage as of
24-Nov-2003. The type of estimation process that the Billing program would use, is
based on the value selected for Estimation Method and Fill fields of the Usage Line
type. The following table describes the possible scenarios:

Option # Fill check box Estimation Method Behavior

1 Selected AMCV If no reading is
available for the
billing period, the
AMCV method will be
used for estimation. If
AMCV returns null,
then the default will
be used for estimation.

If only partial reading
is available for the
billing period, then
the remaining period
will be estimated
using the AMCV
method, if no AMCV,
then the default will
be used for estimation.

Minimum check will
be honored.
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Option # Fill check box Estimation Method Behavior

2 Not Selected AMCV The same as option
#1. If no reading
is available for the
billing period, the
AMCV method will
be used for estimation.

If the AMCV returns
null, then the default
will be used for
estimation. If any
reading available for
the billing period, no
estimation will be
done.

Regular minimum
check will be honored.

3 Not Selected Not Selected The same as option #1.

If no reading is
available for the
billing period, then
the default will be
used for estimation.

If any reading is
available for the
billing period, no
estimation will be
done.

Regular minimum
check will be honored.
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Option # Fill check box Estimation Method Behavior

4 Selected Counter If no reading available
for the billing period,
the Counter method
will be used for
estimation.

If the Counter returns
null, then the default
will be used for
estimation. If only
partial reading is
available for the
billing period, then
the remaining period
will be estimated
using the Counter
method, if no Counter,
then the default will
be used for estimation.

Minimum check will
be honored.

5 Not Selected Counter If no reading available
for the billing period,
the Counter method
will be used for
estimation.

If the Counter returns
null, then the default
will be used for
estimation. If any
reading available for
the billing period,
no estimation will
be done. Regular
minimum check will
be honored.

Counters provides the following additional methods for estimating usage:

• Fixed value estimation

• Estimation based on percent usage of the associated counter

Prorating Price Breaks

Oracle Service Contracts provides the functionality to prorate price breaks. This
functionality supports the following business scenarios:

• When you want to simplify the definition of usage pricing and use one price break
definition for different billing periods

• When a contract starts in the middle of a billing period

• When a contract is terminated in the middle of a billing period
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Contract Specific Price Breaks

Service providers typically define standard price breaks for usage
agreements. Non-standard pricing terms sometimes need to be negotiated for specific
contracts. Oracle Service Contracts supports the ability to store, modify, and lock price
breaks for each usage lines in a contract. Changes to the price list do not change a price
break that has been locked against a contract line.

Defining Usage Price Breaks
After setting up the usage item, price breaks are set up in a price list that will be used for
contract pricing.

Prerequisites
The usage item must be created using Oracle Inventory. The price list must be defined
using Oracle Advanced Pricing.

To define a price list:
1. From the Responsibility menu select Pricing > Price Lists and Discounts > Price

Lists > Price List Set Up.

2. Query the applicable price list. Navigate to the List Lines tab to enter the usage
price breaks.

3. Enter Item for Product Context.

4. Enter Item Number for Product Attribute.

5. Enter the item name, for example QP-LPTR-U, for Product Value.

6. Enter Ea as the Unit of Measure (UOM).

7. Enter Price Break Header for Line Type.

8. Enter Point or Range for Price Break Type.

9. Click Price Break to enter the price breaks.

10. Enter the break ranges as required in the Value From and Value To.

11. Enter the price for each range.

12. Click Save to commit and close the window.

References

• Refer to the Oracle Install Base Concepts and Procedures for instructions on how to
create a counter group template and different types of counters.

• Refer to the Oracle Install Base Concepts and Procedures for instructions on how to
manually create a customer product.

• Refer to the Oracle iSupport Concepts and Procedures for instructions on how to
manually create a customer product.
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Selling Products and Services in Order Management
When ordering a serviceable product in Oracle Order Management, if it has an associated
warranty it will be automatically created as a contract when the product is shipped. At
the same time a serviceable product is placed on a sales order, associated services may
also be sold which will be interfaced to Oracle Service Contracts as extended warranties.

This section covers the following information:

• Automated Creation, page 2-23

• Flexible Service Programs, page 2-23

• Activating Service, page 2-24

• Service Coverage, page 2-24

• Controlled Service Availability, page 2-25

• Ordering Service Programs, page 2-25

• Cotermination, page 2-26

• Warranties and Extended Warranties, page 2-27

• Warranty and Extended Warranty Process Flow, page 2-27

• Contract Details at Order Management, page 2-29

• Order Cycle, page 2-30

• Warranty and Extended Warranty Consolidation, page 2-31

• Reprocessing Orders, page 2-32

Automated Creation
Warranties and extended warranties can be automatically created with the act of
selling goods or services. Integration with Oracle Order Management facilitates this
process. When a product is ordered, if it has an associated warranty in the bill of
materials, then the warranty contract is automatically created. Likewise, if a customer
chooses to buy extended service on their products, then the information regarding the
service to be supplied is passed to Oracle Service Contracts.

Additionally, warranties can be created automatically when a product that includes a
warranty is added to Oracle Install Base manually.

Flexible Service Programs
Oracle Service Contracts can be used to create, maintain, and administer as many service
programs as are necessary to meet the service needs and price expectations of each
market segment.The following scenarios describe how service programs can be used
to provide customer support:

Provide targeted support based on product characteristics

• To support a low-priced, high-volume product you can define a service program for
hotline support. To support a more complex, higher-priced product you can define
a service program for onsite support.
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Provide multiple service programs to support the same product

• For a customer who uses your product for critical applications, you can create a
service program that ensures support 24 hours a day, seven days a week, while a
customer who uses the product for less critical applications can purchase a service
program that limits support to weekdays.

Allow customers to purchase multiple service programs for the same product

• One service program may not allow the flexibility to satisfy all of a customers
diverse needs. A customer can purchase multiple service programs for the same
product. Should your customer want both hotline support and regular preventive
maintenance, you can define two different service programs that can be attached to
the same customer product.

Defining service programs that support the unique needs of each market segment
allows you to meet all customer expectations. For example, using Oracle Order
Management, each service program can be priced to achieve the market penetration and
volume that needed to sustain the growth of your organization.

Service programs also let you design mass customizing solutions. You can provide
service solutions that not only satisfy customers but also help to retain and generate
additional business. To ensure better administration, the availability of service programs
can be controlled by product, by customer, or a combination of both. To simplify the
management of service programs, a group of service programs can be coterminated at
the same time, so that they can also be renewed at the same time.

Oracle Service Contracts enables status tracking of each service program purchased by a
customer regardless of the time of its purchase. Customers can order service programs at
the same time as a product order, or later when the customer requires support. Expiring
service programs can also be identified and customers notified, in order to prevent any
breaks in the support services they receive by using Events.

Activating Service
Oracle Service Contracts offers several ways to activate the support services customers
receive. During order entry, start and end dates can be specified for service programs, or
the start date alone can be specified, with Oracle Order Management determining the
end dates from service program duration information.

The Service Starting Delay can be defined as an attribute of the serviceable products
when they are defined in Oracle Inventory. The Service Starting Delay represents the
time, in days, a service program or warranty should commence after the shipment
date. For example, a radio has a service starting delay of five days. If the radio ships
on January 15, five days are added to the shipment date and the service program
starts on January 20. The start date of the warranty is the ship date plus the starting
delay. The end date is calculated by adding the duration to the start date of the support
service. Starting delays do not apply if an installation date is entered. Coverage becomes
effective immediately upon installation.

Service Coverage
Service coverages list the actual days during the week and hours during the day when
customers are covered under their contract for services they request. The definition of a
service coverage also determines what percentages of labor, material, and expenses are
covered, and whether a maximum limit exists for each. As many coverages as necessary
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can be defined, then each associated with a service program or warranty. Because
service personnel have online access to all customer service information, they can
easily verify whether customers are contacting them at authorized times, or whether
material, labor, and expenses are covered by a support service. Charges are discounted
based on material, labor and expense billing types.

Controlled Service Availability
By default, a service program is available to be assigned to any serviceable product. If
necessary, the availability of a service program can be restricted by product, party, or
both. For example, your company still sells Product ABC because it has refurbished
products in stock. However, since the items are refurbished, you do not want people to
sell your extended warranty package A123. You can define the Service Availability form
to identify that package A123 can be sold on any product except ABC, or you may wish
to create a special support service, X23, for product ABC and define Service Availability
to indicate that service X23 is only available for product ABC.

Service availability by product is available regardless of whether the product is in the
installed base. It is applicable for the covered levels of covered item as well as covered
product. These restrictions will be highlighted when the QA check is executed in the
Service Contract Authoring form.

Ordering Service Programs
As sales orders are entered for serviceable products, one or more service programs can
be selected to cover each serviceable product. Ordering service at the same time as
ordering the serviceable product is termed Immediate Service. For immediate service the
reference type on the sales order line for the service is ORDER. The service is associated
with the appropriate serviceable product by selecting the order number and the line
number where the product is sold. The product may be on a different order than the
service. The serviceable product and its service programs will then be on the same
sales order and the same invoice.

Service programs can also be sold after the sale of the serviceable product. This is termed
Delayed Service. For delayed service, the reference type on the sales order line could be
either ORDER or CUSTOMER PRODUCT. The service is associated with the appropriate
serviceable product by selecting the product from the installed base, or by selecting the
order on which the serviceable product was sold. For example, you sell a telephone with
a warranty that expires after 90 days. After 90 days, the customer decides to purchase
extended service coverage for the telephone. You can then sell the extended coverage as
a service program three months after the original sale.

Note: Service programs must always apply to a serviceable product and
cannot be sold without referencing a serviceable product.

Regardless of how a service order is started, there are a variety of order processing
options from which to choose, including dynamically calculated service program
prices, sales credits, and approval cycles that can be applied to the entire order or
specific order lines.

Using Oracle Service Contracts 2-25



Cotermination
Oracle Service Contracts enables a common expiration date (cotermination date) to be
specified for all service programs for a specific customer or system. This date can be set
at the customer level so that all service programs for products ordered by a particular
customer end simultaneously, or at the system level so that all service programs for
products associated with a particular system end simultaneously. The customer level
cotermination is defined in Oracle Service Contracts. The system cotermination is
defined in Oracle Install Base.

Cotermination is used to determine the end date for service programs that are ordered in
Oracle Order Management or in Oracle Service Contracts. When the cotermination check
box is selected on an order or a contract, the system cotermination date is checked first; if
none is found, then Oracle Service Contracts checks the customer cotermination date.

As an example, suppose you set a cotermination date at the system level for October
31, and a customer cotermination date for December 1. Service programs first check
for the system cotermination date and set the end dates to October 31. If no date had
been set at the system level when the system was defined, then the customer level
cotermination date is used. Another customer has five systems, each with a different
cotermination date. For each system, the individual cotermination date becomes the
cotermination date for that system only. In turn, if the system had not been assigned a
cotermination date, the customer cotermination date would be used.

A customer is notified late in December that the current service programs covering their
power generators will be replaced on December 1 of the following year with a more
comprehensive service program, and the current service program will not longer be
valid. A cotermination date is set at the customer level of November 30. The same
customer renews a current service program in January for an existing power generator. In
March, the customer orders three more power generators and service programs for other
sites. All service programs are checked for cotermination. All four service programs will
coterminate on November 30, so the new service programs can start on December 1.

When a service program is ordered, if there is no cotermination date set at either the
customer or system level and if the Coterminate check box or button has been selected
when ordering the service program, then the cotermination date is the end date of the
service program and the duration is one year. For example, if a service start date is June
26, 2003, then the cotermination date is June 25, 2004.

Any service programs applied to customer products use the cotermination date that
is current at either the system level or the customer level. If the cotermination date is
changed at either the customer or system level, then services ordered after the change
use the new cotermination date. For example, if a customer level cotermination date is
August 31, and five service programs are ordered for customer products in February, the
cotermination date is August 31. If the date is then changed to July 31, and new service
programs are ordered, then the cotermination date for the existing five service programs
remains August 31, but the cotermination date for the new service programs is July
31. All subsequent new service programs have the July 31 cotermination date until the
date is changed.

Minimum service duration (in days) can be applied. For example, you have a
cotermination day and month of December 31, and a minimum service duration of 30
days. All services ending on or before December 1 coterminate on December 31 of the
current year, and services ending after December 1 coterminate on December 31 of
the following year. If coterminating a service program sets its duration to less than
the minimum duration, then the service program will be set to coterminate during
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the following year. For more information, see the OKS: Minimum Service , page
3-36Duration profile option.

Warranties and Extended Warranties
Warranties and extended warranties are service contracts. When a customer orders
a product that has an associated warranty or the customer orders an extended
warranty with the product, Oracle Service Contracts automatically creates the
warranty contracts based on the information from the sales order. When products are
returned, replaced, upgraded, or transferred, the warranty and extended warranty are
updated appropriately.

Manage your warranties and extended warranties with the following activities:

• Define serviceable products in the item master.

• Define warranties and extended warranties in the item master with a corresponding
coverage template.

• Associate or link warranties to the serviceable product in the bill of materials.

• Create warranties as service contracts when serviceable products are ordered.

• Create extended warranties as service contracts when serviceable products are
ordered or added to an existing order line or serviceable product that has already
been sold.

• Update warranties and extended warranties when customer products are
upgraded, replaced, transferred, returned or split.

• View warranties and extended warranties in the Service Request window.

Warranty and Extended Warranty Process Flow
The following diagrams illustrate the process flow for the integration between Oracle
Order Management and Oracle Service Contracts and the logic that is involved in
creating a warranty and extended warranty.

A sales order creates a contract that can be viewed (in read-only mode for warranties)
using the Oracle Service Contracts Authoring window. Oracle Quoting is notified by
Oracle Order Management through the Process Order API/Update Notice API about
any changes occurring in the orders such as header and line attributes. Oracle Quoting
in turn passes the information on to update the Installed Base and to create or update
the warranties and extended warranties in Oracle Service Contracts. This integration
happens behind the scenes.
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Process Flow - Integration Between OC/OM to Oracle Service Contracts

Process Flow - Integration Between OC/OM to Oracle Service Contracts
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Contract Details at Order Management
Using the Order Management Actions button on the Line tab, contracts details may
be defined which specify the renewal rules, PO required, pricing method, cap price
list, markup/markdown, and customer contact. In addition, merging rules may be
specified to determine to which contract an order line is to be merged. An order line may
be merged to an existing contract or to a contract on the current order. This window is
available to the service line only.

To add contract details:
1. From the Order Management Responsibility navigate to Orders, Returns > Sales

Orders (T) Line Items

2. Click Actions. The Contract Details window is displayed. The upper region of the
form displays the order details.

3. If applicable, select the Apply All check box. If an order has multiple service
lines, subsequent lines may inherit the same renewal and merging attributes as
specified in the initial order line.

4. Select a Line Renewal Type. If an order line is merged to an existing contract, its
duration may be less than the target contract. In order to facilitate renewals, the
order line will coterminate with the target contract header. The Duration Inheritance
attribute determines the desired duration of the service line. The valid values are:

• Full: The service contract line inherits the duration of the renewed contract.

• Remaining: The service contract line retains its original duration and
coterminates with the renewed contract.

• Do Not Renew: The service contract line is allowed to terminate and will not
be processed by the renewal event.

5. If the order line is to be merged with the current order, click New Option. The
Existing option button is disabled.

6. Select a Renew Type from the list of values. The Renewal Type determines how the
renewal is to be processed and whether the sales rep is to be notified to select
the renewal type. The valid values are:

• Notify Sales Rep: The renewal event sends a notification to the sales rep, based
on the territory in which he/she resides, to facilitate the renewal. For
example, the sales rep negotiates the pricing with the customer prior to sending
the contract for approval.

• Submit for Approval: This will create a renewed contract in an entered
state awaiting review and approval before it can become active. If the
Autorenewal process has been implemented, a contract with an Active
Contract renewal type will either become signed or active, depending
on whether the start date has passed. If the contract has not passed QA
however, it will remain in the entered state.

• Evergreen: The renewal event automatically approves and activates the
contract.

• Electronic Renewal: The renewal event places the renewed contract into
entered status and sends a notification to both the sales representative
and the customer. The customer receives notification in the form of an
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e-mail with a link to a web page where customer can review the quote and
accept, reject, or request changes to the contract renewal.

• Do Not Renew: The contract cannot be renewed.

7. If applicable, select the PO Required check box if a PO is required for contract
renewal.

8. Select a Renewal Pricing Type from the list of values within the Repricing Details
region. These attributes determine how the renewed contract is going to be
priced. The valid values are:

• Price List: Renewal pricing is based on the current price list.

• Markup: Renewal pricing is based on a markup percentage (%) and a
cap price list. For example last year’s negotiated markup% is subject to
cap list price. The fields Markup% and Price List are enabled. Enter the
markup percent. This may be a positive or negative percent. Select the
price list from the list of values.

• Manual: Renewal pricing uses last year’s negotiated price.

9. Select a Role from the list of values within the Customer Contacts region. One or
more customer contacts may be associated with the new contract.

10. Select the Contact Name from the list of values. The customer address is
automatically displayed.

11. If the order line is to be merged to an existing contract, click Existing Option. The
New option button is disabled along with all the renewal and pricing attributes. This
specifies the type of merging to take place and the valid values are:

• Order: Merge the current order line to the contract to be created for the current
order. The list of values displays the applicable contracts for the current order.

• Contract: Merge the current line to a contract with the same customer and
service line. The list of values include:

• Contracts that begin before and after the start date of the new order line

• Contracts that their end dates are before and after the end date of
the new order line

The start date of the selected contract will be moved forward, if the
start date of the new order line is earlier than the original start date of
the contract (after running the Order Capture Integration concurrent
program).

The end date of the contract will be extended if the end date of the order
line is beyond the original end date of the contract line.

12. If type is Order, select the contracts from the current order from the list of values.

13. If type is Contract, select the contract from the list of values. The Contract
Number, Contract Line No, Service, Start Date and End Date entries are displayed.

Order Cycle
After the sales order has been booked, it should progress through the order cycle that
has been defined.
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For more information about the order cycle, see the Oracle Order Management Concepts
and Procedures Guide.

For orders that include shippable items, the order cycle will typically involve a pick
release process and ship confirm. The ship confirm process includes a process that
updates the installed base with the details of the newly shipped product. This program
will also initiate the transfer of contract information from Oracle Order Management to
Oracle Service Contracts if the product has associated services or warranties.

For orders that do not include shippable items, for example delayed service orders, the
ship cycle does not apply. In this case, the order should be progressed from Oracle Order
Management. To initiate the transfer of contract information, the Service Contracts Order
Capture Integration concurrent program should be run.

Warranty and Extended Warranty Consolidation
Large sales orders may contain many products and services, which in turn means
many warranties and extended warranties may be generated. Wherever possible, these
agreements are consolidated into a single warranty or extended warranty per sales order.

For each different warranty that is included with the products from the order, a separate
warranty line will be created within the single warranty that is generated for a given
sales order. Depending on how the products are created in Oracle Install Base (serialized
or non-serialized with Auto Split on or off) each of these warranty lines may have
multiple sublines to represent the various products under that coverage. If partial
shipments are made from an order, the original warranty will be updated whenever
possible. New lines or sublines will be added to the warranty originally created for that
sales order unless that agreement is in terminated status. This would require a new
warranty to be generated. Because dates and durations may vary from one warranty
line to the next, the agreement will begin on the earliest start date and end on the latest
end date of all the lines.

Extended warranties are consolidated in the same way as, but separately from, the
warranties. All those sold on a single sales order are captured on one agreement with
separate lines for each different extended warranty. The products under each line
create one or more sublines based on how they are created in the installed base. As
with the warranties, the extended warranties are updated by subsequent shipments
from that order unless the agreement is in terminated status, then a new agreement is
generated. Start and end dates for extended warranties are also handled the same
way as warranties.

Serialized Products

When products are serialized, a separate item instance in Oracle Install Base is created
for each item ordered. For example, when quantity of three is ordered of a product, for
each serial number an item instance is created in Install Base. A single warranty contract
is created with one warranty line and one subline for each item instance. In this case
three sublines are created under that one line. A separate extended warranty contract is
created for the order with one subline for each item instance.

Note: The CSI Auto-split Instances During Instantiation profile option does not apply
when products are serialized. The reason is, serialized products create separate item
instances.

Using Oracle Service Contracts 2-31



Partial Shipments

When partial quantity of a booked order is shipped, in most cases, only one contract
is created. At the time the remaining items are shipped, new sublines are created for
the additional products under the appropriate line (or if the item is covered by a
different warranty or service, a new warranty or service line is created). The warranty
or extended warranty contract would need to be signed and the Active or Hold status
updated. If the warranty or extended warranty is expired when the remainder of the
order is shipped, the contract duration is extended to accommodate the subsequent
shipments by adding new lines and sublines. If the warranty or extended warranties
is terminated or canceled, a new agreement is created.

Reprocessing Orders
When a product under warranty is sold with an extended warranty, the product details
are added to Oracle Install Base and the corresponding warranty and extended warranty
contracts are created in Oracle Service Contracts.

If the process for creating a contract fails, you can use the Order Reprocess window to
identify the errors and, after fixing the errors, reprocess the orders. You can also use
the Order Reprocess window to review:

• Information (error messages) about service order lines that failed to interface
to Oracle Service Contracts

• Install Base transactions affecting customers’ products such as
split, transfer, replace, return, and terminate

• Contracts and contract lines that have been updated or created

To reprocess orders:
1. From the Navigator, choose Service Contracts Manager > Reprocess Order. The

Reprocess Order window includes Line Details and Transaction Details tabs.

2. Line Details tab: Use the Line Details tab to view the statuses of all orders that have
been executed. The Line Details tab includes:

• The Processed column displays the statuses of all orders that have been executed
as Processed or Error. You can use the Order Reprocess form to create new
service order lines and submit them for processing. To create a new service order
line, you need to set the status in the Processed field to New.

• Select All button changes the status of orders from Error to Reprocess.

• Deselect All button reverts the changes in status performed by the Select
All button.

• Submit button updates the Service Contracts process table and calls the
concurrent program to process all lines with the New and Reprocess
statuses. To prevent an order line being resubmitted for processing while it
is already in process, the concurrent manager ID is stored along with other
details in the Service Contracts process table.

3. Transaction Details tab: The Transaction Details tab includes Products and Contracts
subtabs:

• Use the Products subtab to query and review information related to the customer
product including:

2-32 Oracle Service Contracts Concepts and Procedures



• Order Line

• Order Number

• Transaction Type

• Transaction Date

• Reference Number

• Item Name

• Parameters

• Use the Contracts subtab to review the history of transactions performed on
a customer product. The Covered Levels Before and After regions display
the transaction history details about the contracts and contract lines that
are created or modified as the result of the following transactions being
performed on the product:

• Split

• Replace

• Transfer

• Terminate

• Return

• New

• Installation Date Change

• Update

Authoring
The Authoring function of Oracle Service Contracts enables you to define offerings that
meet your customers’ specific requirements, that are not available in standard offerings.

The following features are available in the Authoring form:

• Specifying bill to and ship to addresses for related customers

• Specifying vendor and customer contacts

• Specifying a specific payment method at the header or line level

• Specifying contract specific renewal and re-pricing rules

• Recording sales credits at the contract header and line levels

• Specifying and applying pricing adjustments at the header and line levels

• Displaying the sales tax at the covered level, service and contract header levels

• Distributing revenue across one or more General Ledger accounts

• Maintaining pricing attributes for a covered product

• Defining a flexible billing schedule

This topic group consists of the following:

• Contract Authoring and Pricing, page 2-35
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Creating Contracts, page 2-36

Contract Header , page 2-37

Using the Summary Tab, page 2-38

Summary Parties Tab, page 2-39

Summary Pricing/Billing Tab, page 2-41

Summary Renewals Tab, page 2-44

Summary Administration Tab, page 2-47

Summary Security/Text Tab, page 2-48

Using the Lines Tab, page 2-57

Lines Accounts Tab, page 2-59

Lines Effectivities Tab, page 2-61

Lines Pricing/Products Tab, page 2-64

Lines Billing Button, page 2-76

Lines Tax/Payment Options Tab, page 2-83

Lines Counters Tab, page 2-83

Lines Events Tab, page 2-84

Using the Tools Menu, page 2-84

Revenue Distribution, page 2-84

Create New Version, page 2-85

Change Status, page 2-85

Pricing Qualifier, page 2-86

Pricing Adjustment, page 2-86

e-mail Quote, page 2-86

Update Service, page 2-86

Terminate Subline, page 2-88

Invoice Details, page 2-88

Summary/Lines, page 2-88

Notes, page 2-86

Using the Actions Menu, page 2-90

Save as Template, page 2-90

Copy from Template/Contract, page 2-90

Counter Setup, page 2-90

Counter Capture, page 2-90

Check QA, page 2-91

Submit for Approval, page 2-91
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Bookmark, page 2-91

Event Details, page 2-91

Show Index, page 2-91

Delete Contract, page 2-91

Cascade Service Price, page 2-91

Sales Credits, page 2-91

Pricing Attributes, page 2-92

Cascade Attributes, page 2-92

Revert Update, page 2-109

Contract Authoring and Pricing
You can define an offering using the contract authoring function and then saving the
contract as a template.

After you define the appropriate template, you can use it to create a contract and obtain
customer approval on the pricing, coverage, and other terms and conditions defined in
the contract. You can also create a contract from scratch. In general, contract authoring
and pricing entails the following steps:

• Select the contract template that best matches the customer’s needs. If you are using
a template, specify the party and customer account information.

• Define the contract’s terms, conditions, and coverage.

If you have created a contract using a template, you can either use the existing terms
and conditions, or modify them as necessary. For a new contract, you need to
define the following:

• Parties: This refers to all the parties on the contract, for example, vendor and
customer parties. The customer party’s bill-to and ship-to addresses are also
defined. If required, contacts can be defined for each party.

• Billing Information: This includes accounting and invoicing rules. A Billing
schedule may be defined at the header level, which is automatically cascaded to
the lines when they are added. If required, a Billing schedule can be defined
at the individual line level. In addition, a payment method can be specified at
the header that would default to the lines. Optionally, a line level payment
method may be defined.

• Pricing: The price list specified on the contract is used to price the
service, usage, and subscription lines. Modifiers, both discounts and
surcharges, may be specified at the header level, which cascade down to the
lines. Optionally, a modifier may be specified at the line level. For usage
lines, the price breaks may be displayed.

• Renewals: Renewal and re-pricing rules may be specified at the contract
level. This would include specifying the quote to contact for electronic renewals.

• Services: This refers to the services defined on contracts. The start and end dates
default from the contract header, but they can be different, as long as they
are within the header effective dates.
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• Covered Levels: For a service line, different covered levels can be defined
including: party, customer, customer site, system, item, and customer
product. For covered products and items, the pricing is automatic (based on the
price list). For the other covered levels, the pricing is manual.

• Coverage Details: You can update the coverage details of a service, which
can default from the Coverage Template. Coverage details include coverage
days and times, reaction and resolution times, preferred resources and billing
types, for example, material, expenses, and labor. If required, a preventative
maintenance schedule can be defined. The preventive maintenance schedule
can be defined for specific dates or a date ranges. Additionally, the schedule
can be defined for the preventive maintenance program, or for each activity
in the program. For tangible items in subscriptions, a fulfillment schedule is
automatically created. Based on the fulfillment schedule, the Service Contracts
Subscription Fulfillment concurrent request automatically generates orders in
Order Management for fulfillment. When the order is shipped, the status of
the order, in the fulfillment schedule, is updated.

• Counters: Service and Product counters can be referenced in contracts. Both
Service and Product counters can be used for usage billing. Also, an action can
be triggered based on the counter reaching a threshold value. This is facilitated
by an event. For example, for a service counter, a preventive maintenance
service request could be generated every three months.

• QA Check the contract. The QA Check is an automated process that verifies the
contract contains the required and correct information. A default QA checklist is
seeded in the application. However, if required, the default QA checklist may
be modified to include other checks. A process within the QA checklist can be
defined with two severity levels, error and warning. Errors must be corrected before
submitting the contract for approval. For additional information, see Creating QA
Checklists, page 3-11. You can launch the QA Check from one of three places:

• On the Summary Administration tab, there is a Submit button that launches the
QA check and, if it passes, allows the contract to progress through the Approval
workflow. This is useful for checking a single contract during authoring. Results
of the QA check are displayed immediately, so you can make any necessary
corrections.

• Launch the QA check from the Actions menu when you are in the contract. This
will also display the results immediately. However if the contract passes, it will
not launch the Approval workflow.

• Run the Contracts QA Report concurrent program. You can select a range
of contracts and run QA for all of them at one time. The process produces a
report listing the results of each contract. This process could optionally launch
the Approval workflow after the QA is complete.

• Approve the contract: Oracle Workflow processes the contract approval and
signing. After the contract has been signed, its status is changed to Active.

Creating Contracts
To create a new contract, you need to provide general information regarding the
customer (such as the customer’s identification, shipping, and billing addresses), define
the services you are providing for the customer, and define the coverage terms associated
with each service. Use this procedure to create a contract:
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To create a contract:
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window

appears.

2. In the Contract Navigator tab, select a contract group.

3. Right-mouse click anywhere and choose the New option. The Create a New
Contract window appears.

4. Select Create a New Contract Manually.

5. Select a category. You can select: Service Agreement, Subscription Agreement, or
Warranty and Extended Warranty.

6. Click the Create button to open the Service Contracts Authoring window.

7. Enter the header information for the contract.

8. Save your work.

9. In the Summary tab, enter summary information. Most of contract summary
information will default down to the lines, unless overridden at the line level.

10. In the Lines tab, choose Usage, Service, Subscription (for Subscription
Agreements), or Extended Warranty (for Warranty and Extended Warranty) for the
line type. Enter the necessary information for each line.

11. Save your work.

Guidelines

You can save your contract at any time as a template.

See Contract Header, page 2-37 for field descriptions for the header section of
the window.

See Using the Summary Tab, page 2-38 for the procedure to enter summary
information.

See Using the Lines Tab, page 2-57 for the procedure to enter line information.

Contract Header
While authoring a contract, the top portion of the Service Contracts Authoring window
includes the following fields as listed in the table below:

Field Description

Contract Number The contract number may be entered manually
or is system generated the moment the contract
is saved.

Known As Provides an alternative, free format reference
for the contract. Can be used to enable an easy
search for the contract at a later date.

Order The Order Number is populated when
a contract is automatically created from
Order Management via the Installed Base
Interface. This is applicable only for warranty
and extended warranty contracts.
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Field Description

Short Description Enter a short description of the contract.

Version Displays the contract version number. You can
choose to create a new version by using the
Version option from the Tools menu within the
Authoring form or via a change request. The
history of versions can be reviewed by double
clicking on a contract from the Contract
Navigator to open the Execution form

Start Date Enter the contract start date.

End Date Enter the contract end date. The end date
is automatically calculated when either the
period or the duration is changed.

Duration Enter the duration in whole numbers. The
duration is automatically calculated if the start
and end dates are entered.

Period Select the period from the list of values (for
example, month, year).

Category The Category is a read-only field and defaults
based on the category selected when creating a
new contract.

Status The status is always defaulted to Entered or
the status that you set as the default.

Subtotal Displays the sum of all line level subtotals after
the contract has been saved.

Tax Displays the sum of all line level estimated
taxes after the contract has been saved.

Currency The currency code defaults based on your
responsibility’s operating unit.

Total The total amount for a contract is updated
after the contract has been saved. The Total
represents the sum for all service lines
including estimated taxes.

Terminated Displays the total amount terminated.

Using the Summary Tab
The Summary tab in the Service Contracts Authoring window provides a summary
of the contract data. The summary information sets defaults used throughout the
contract, many of which can be overridden at the line level. Use this procedure to
enter your contract summary information.
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To enter contract summary information:
1. Navigate to Summary > Parties tab.

2. Select the persons or business entities that have a business relationship to
the contract. In the Party Role field, you can select the Customer role only
once. However, you can select any additional party roles, which have been defined
in setup.

3. Select any contacts that relate to a selected party.

4. Select the correct bill and ship addresses for the party.

5. Select the Pricing/Billing tab.

6. Enter the default pricing and billing rules for the contract including the payment
method and tax exemption status.

7. Select the Renewals tab. Enter renewal rules to be used for the contract.

8. Select the Administration tab.

9. Enter the QA checklist and approval workflow associated with the contract.

10. Select the Contract Terms button to reference standard articles, create non-standard
articles, and organize articles in different sections.

11. Select the Security/Text tab.

12. Optionally enter free form text for description or comments and contract specific
security by user or group.

13. Save your work.

Guidelines

The summary billing schedule is based on contract billing parameters set in the
Pricing and Billing tab. Subsequently, this will default the billing schedules on the
lines. If required, line specific billing schedules can be defined. Please note that
any modifications to the summary billing schedule could override all line specific
billing schedules.

Workflow processes can be launched from the Administration tab by clicking the
Submit button. Click the Monitor button to view the progress of the workflow
process. Click the Stop button to stop the workflow process.

See Summary Parties Tab, page 2-39 for field explanations.

See Summary Pricing/Billing Tab, page 2-41 for field explanations.

See Summary Renewals Tab, page 2-44 for field explanations.

See Summary Administration Tab, page 2-47 for field explanations.

See Summary Security/Text Tab, page 2-48 for field explanations.

See Managing Contracts Terms section, page 2-49 for more information and field
explanations.

Summary Parties Tab
The following table displays the fields and field descriptions for the Parties tab:
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Field Description

Party region -

Role The seeded roles that are supplied with Oracle
Service Contracts are:

• For Service, Warranty, and Extended
Warranty category contracts: Vendor,
Customer, and Third Party

• For Subscription category contract:
Merchant, Subscriber, and Third Party

User-defined roles can also be used. The
vendor role will default to your company
name. You must also enter a role of
Customer. A role of Third Party can
optionally be entered. You can only have
one occurrence of each role for a contract.

Name Select the party name from the list of
values. Your company name automatically
defaults as the vendor.

Party No The party number is automatically displayed
when the party name is entered. This is a
display-only field.

GSA This designates the contract as a government
supply agency contract. This flag is set up in
the party and is automatically defaulted when
the party is identified.

Contacts region -

Role Enter the role that the contact is expected
to play from the list of values. Individuals
can be assigned to the contract along with
the specific role each person has for the
contract, depending on their legal relationship
to the contract parties.

Name Enter the contact name from the list of values.

Sales Group The vendor’s sales group is defaulted
when the contact is identified. If nothing
is applicable, the Unassigned group is
defaulted. Optionally, select the appropriate
Sales Group for the contact from the list of
values. Oracle Contracts Intelligence uses
the Sales Group information for reporting by
hierarchy.

e-mail The e-mail address is defaulted when the
contact is selected. For customer contacts, the
e-mail address can be updated.

Start Date Effective start date for a party contact
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Field Description

End Date Effective end date for a party contact

Bill To Address and Ship To Address regions -

Bill to Address This also includes the Account/Party and
Location for related parties. Select the Bill
to Address from the list of values. Select the
Location.

Ship to Address This also includes the Account/Party and
Location or related parties. Select the Ship
to Address from the list of values. Select the
Location.

Summary Pricing/Billing Tab
The following table displays the fields and field descriptions for the Pricing/Billing
tab. Many of these fields are also found on the Billing tab for lines.

Field Description

Agreement Optionally, select an agreement. Information
from the agreement will appear in price
list, accounting rule, invoicing rule, and
payment terms.

Price List Specify the price list to be used from the list of
values. This price list should be in the same
currency specified at the header.

Accounting Rule If an agreement was not selected, then specify
the accounting rule from the list of values. The
accounting rule determines when revenue
is recognized for service performed. The
accounting rule is defaulted in the billing
schedule.

Payment Terms Enter the payment terms from the list of
values. AR uses this field to determine when
the payment is due on the invoice.

Invoicing Rule Choose the invoicing rule from the list of
values for the contract header. The invoicing
rule is defaulted in the billing schedule.

Billing region -

Transaction Type Select the Transaction Type from the list of
values to be associated with billing for the
contract. The default is NULL and is assumed
to be the service contract transaction type.
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Field Description

Summary Print Can be used by a customized invoice print
program to control printing the invoice. If the
check box is selected, it will print at summary
level or brief invoice. If the check box is not
selected, it will print a detailed invoice.

Summary Transaction If selected, the system profile OKS: Summary
Transactions will be ignored for that contract
and only summary level transactions will
be sent to AR for that contract. If left
deselected, the system profile will be used
to determine how the contract should be
billed. By default, this check box will be
unchecked.

Note: When deselected, it does not mean that
detailed transactions will be sent to Oracle
Receivables. The check box is only considered
when it is selected. When deselected, it is
ignored

Purchase Order Required Select if using a purchase order to pay for the
contract.

PO Number If you want the to reference the PO number on
the invoice, enter the purchase order number
in this field. The Contract Billing process sends
the purchase order number along with billing
transactions to Oracle Receivables.

Note: If the Purchase Order Required
check box is selected but no PO Number is
entered, you can still save the contract. The QA
check will only alert you that the PO number
must be entered.

AR Interface Controls which contracts are eligible to be
interfaced to AR. The default setting is checked.

Hold Credits You can use the Hold Credits check box to
place a hold on credit memos until the next
billing cycle. This setting does not hold
invoices. The default setting is unchecked
which allows changes in the billing amount to
be picked up immediately.

Payment Type Optionally select a payment type from the list
of values. You can select:

• Null (the default value)

• Credit Card: Select this option if the
customer chooses to pay for the service
agreement by credit card.

• Commitment Number. See Commitment
and Credit Card Billing Methods, page
2-104..
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Field Description

Credit Card Number and Expiry fields If the Credit Card option is selected, enter the
credit card number and expiration date.

The level of validation to be applied to the
number can be controlled by the Contracts
profile option OKS: Credit Card Validation
Level.

The minimum authorized amount is validated
by the profile option OKS: Minimum
Authorized Amount.

The card details are passed to Oracle
Receivables during the Billing process.

Commitment Number The system displays this field, if in the Payment
Type field; the Commitment Number option
is selected.

Select the commitment number from the
list of values. For more information, see
Commitment and Credit Card Billing Methods,
page 2-104

Billing Button Opens the Billing Schedule window to allow
creation of header level billing schedule that
can be rolled down to the lines and sublines.

Tax Exemption region -

Status Specify the tax exemption status, if applicable.

Number If the tax exemption status is Exempt, enter the
tax-exempt certificate number.

Reason If the tax exemption status is Exempt, enter the
reason for exemption.

Currency Conversion region If the contract currency is not the same as the
functional currency, this region is enabled.

From Currency The contract currency code is defaulted in this
field. This is a read-only field.

To Currency The functional currency is defaulted in this
field. This is a read-only field.

Type Enter the conversion type from the list of
values.

Date Enter the date for the entered conversion rate.

Rate If the currency conversion type is the
User, enter the conversion rate. Otherwise the
rate is defaulted based on the information in
the Type and Date fields.

Service Charges region -
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Field Description

Pre-Payment Required This feature is reserved for future functionality

Purchase Order Required Select if using a purchase order for payment of
charges for services rendered.

PO Number Enter the purchase order number to be used
for payment.

Note: If the Purchase Order Required
check box is selected but no PO Number is
entered, you can still save the contract. The QA
check will only alert you that the PO number
must be entered.

Terminated region The fields in this region display termination
details.

Unbilled The field displays the unbilled amount due to
termination,

Credited This field displays the credit amount issued
due to termination of the contract.

Suppressed This field displays the amount that was
suppressed when the credit was calculated and
issued.

Overridden This field displays the amount that was
overridden during termination.

Adjusted region The fields in this region display adjustment
details.

Discount This filed displays the total discount amount.

Surcharge This filed displays the total surcharge amount.

Total This field displays the sum of discount and
surcharge.

Billed This filed displays the total amount billed for
the contract, line, and subline.

Summary Renewals Tab
The renewal rules defined on this tab will be applied during manual or automatic
renewal of the contract. If rules are not defined at the contract level, the rules will be
retrieved from the Global Contracts Defaults. See Contract Renewal, page 2-110.

The following table displays the fields and field descriptions for the Renewals tab:
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Field Description

Renewal region -

Type The renewal type specifies how the renewal
is to take place. Select the renewal type from
the list of values:

• Active Contract: This specifies that the
contract will automatically be renewed
without any manual intervention.

• Do not Renew: This specifies that the
contract will not be renewed.

• Electronic Renewal: This specifies that the
contract will be renewed along with an
e-mail quote sent to the customer contact.

• Notify Sales rep: This specifies that the
contract will be renewed along with a
notification to the sales rep.

• Submit for Approval: This specifies
that the contract will be renewed and
automatically submitted for approval.

Renew Up To This field is only available for contracts with
renewal type of Active Contract. This records
the date when the automatic renewal process
should stop renewing the contract. This will be
the end date of the final renewed contract.

Notification If a renewal event has been set up, this field
identifies who was notified of an impending
renewal. This field will not be populated until
after the renewal event has picked up the
contract and has sent the notification.

Pricing Method This determines how pricing is to take place
during contract renewal. Select the pricing
method from the list of values:

• Manual: The contract is renewed at last
year’s price.

• Markup Percent: The contract is renewed
at a markup with a cap price list.

• Price list: The contract is renewed with the
specified price list.

Price List If the Pricing Method is Price List or Markup
Percent, select the price list.

Markup If in the Pricing Method field, you selected the
Markup Percent option, enter the percentage
(positive or negative) that should be used to
adjust the price of the renewed contract. The
new price will be compared to the cap price
list and renew the contract at the lower of the
two prices.
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Field Description

Billing Profile This is used to identify the billing profile that
sets up the billing parameters in the renewed
contract. Select the billing profile from the list
of values.

PO Required check box This specifies that a purchase order is required
during renewal process. If selected, the
renewal cannot be sent for approvals without
a purchase order.

PO Number During contract renewal, you need to enter
the PO number, if the PO Required check box
is selected.

Grace Duration Enter the grace period duration. See Grace
Period, page 2-121

Grace Period Select the grace period type from the list of
values. For example, Day or Month.

Estimated Percent This is used to specify the probability that
the renewal will be booked within the
estimated time frame. From a forecasting
perspective, this percentage represents the
amount to be booked at renewal.

Duration The duration in which the renewal will be
booked.

Period Enter the period from the list of values.

Renewal History region The Renewal History region is a read-only
region and is updated when the contract is
renewed. All the fields are the same as the
Renewal regions except for the following:

Active Threshold This represents the threshold that was defined
for contracts that were automatically renewed.

Electronic Threshold This represents the threshold that was defined
for contracts that were electronically renewed.

Quote To region This region is used to specify the customer
contact that will receive the quote for renewal.

Account/Party Select an account/party from the list of
values. This list of values refers to parties
identified on the Parties tab.

Contact Select the contact from the list of values. These
contacts are associated with the party selected
above.

Address Select the street address from the list of values
that is applicable to the individual contact
listed above.
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Field Description

e-mail This field will default from the contact setup. It
can be overridden.

Phone This field will default from the contact setup. It
can be overridden

Fax This field will default from the contact setup. It
can be overridden.

Summary Administration Tab
The following table displays the fields and field descriptions for the Administration tab:

Field Description

Quality Assurance Checklist Enter the QA checklist that is to be used for
this contract.

Effective region -

Date Approved Displays the date that the contract was
approved.

Date Signed Displays the date that the contract was signed.

Date Canceled Displays the date that the contract was
canceled.

Date Terminated Displays the date that the contract was
terminated.

Date Renewed Displays the date that the contract was last
renewed.

Grace Duration Enter the grace period duration. See Grace
Period, page 2-121

This field is enabled if the profile option
OKS: Enable Grace Period is set to Yes.

Grace Period Select the grace period type from the list of
values. For example, Day or Month.

Grace End Date The system displays the grace end date based
on information you entered in the Grace
Duration and Grace Period fields. This is based
on the end date of the contract.

Estimation region -

Percent Enter the percentage revenue that is estimated
to be achieved for this contract. This can be
used by a salesperson to give some measure of
the revenue that may be generated for a new
contract.

Using Oracle Service Contracts 2-47



Field Description

Date Enter the date by which the estimated revenue
is predicted to close.

Contract Groups region -

Group Name Select one or more contract groups to which
this contract belongs. A contract is visible in
the Contract Navigator only, if a contract group
has been specified here.

Description The group description appears when the group
name is selected.

Approval Workflow region -

Name Enter the name of the process that will be used
to approve the contract.

Process The approval process name is displayed
here. This is a read-only field.

Submit Clicking the Submit button launches the
QA check and then, if it passes, allows the
contract to progress through the Approval
workflow. The QA check results are displayed
immediately, so you can make any necessary
corrections.

Monitor and Stop button Use the Monitor and Stop buttons to monitor
the approval process.

Contract Terms Button See Managing Contracts Terms, page 2-49

Summary Security/Text Tab
Contract access is a combination of security granted both by the responsibility and at
the individual contract level. You do not restrict access at the contract, you can only
grant additional access. For example, if a user logs in with a responsibility that grants
modify access to contracts they will not be restricted on a particular contract by a Read
Only security level for a particular contract. However, someone logging in with a
responsibility of Read Only may be granted Modify access for a particular contract.

The following table provides descriptions of the fields on the Security/Text tab:
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Field Description

Security region -

Type Identifies Group or User access.

Group or User Name Enables you to choose either a group or user
name.

Level Enables you to select either Modify or
Read-Only access level.

Text region -

Description This is free formatted text. Enter contract
details, if applicable.

Comments This is free formatted text. Enter additional
contract comments, if applicable.

Managing Contract Terms
Oracle Service Contracts provides the Contract Terms Management features including:

Contract Terms Library

Oracle Service Contracts enables you to standardize business relationships through the
use of the Contract Terms library. This library provides the legal department and selling
organization a powerful tool to create reusable articles.

Contract Authoring

You begin the Authoring process by selecting a Contract Template, based on the
requirement of that specific contract, and then select or remove terms from the
contract. Also, you can create non-standard articles that pertain to a specific contract.

This section covers the following topics:

• Applying Contract Templates, page 2-49

• Changing Contract Templates, page 2-50

• Removing Contract Terms, page 2-51

• Adding and Deleting Sections, page 2-51

• Adding and Updating Articles, page 2-52

• Moving Contract Terms, page 2-55

• Renumbering Contract Terms, page 2-56

• Validating Contract Terms, page 2-56

• Checking for Article Updates, page 2-57

Applying Contract Templates
Contract templates consist of articles that can be applied to contracts.
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Prerequisites:
Contract Template. For more information, please see the Defining Contract Templates
section of Oracle Contracts Implementation and Administration Guide.

To apply contract templates:
1. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)

Contract Terms. The system displays the Contract Terms page.

2. Click Search for Contract Template, to search and select a template in the Library.

3. Enter your search criteria.

4. Click Go. The Results page displays all templates that:

• Match the search criteria for Template Name and Description.

• Are active as of the start date of the contract

• Are relevant to the organization authoring the contract

5. Select the appropriate template from the list and click Select.

6. In the Contract Terms page, click Apply Template to bring in all the articles from the
template to the Contract Term page.

Contract Terms Page:

The Contract Terms page also displays the following columns:

• Non-Standard: A check mark in this column indicates that the article is
non-standard. For more information, please see: Create Non-Standard Articles,
page 2-54

• Mandatory: Articles that are marked as Mandatory cannot be deleted.

• Select Alternate: A Plus (+) sign indicates that the article has alternates. Click
the Plus sign, to view and select an alternate article.

• Update: Click the Update icon if you want to make any changes to an article.

• Delete: Click the Delete icon if you want to remove an article. You cannot delete
articles that are marked as Mandatory.

Changing Contract Templates
You can choose a different template after making an initial choice. To use this feature the
contract must be in the Entered status.

If you change the template on a contract:

• All standard articles will be deleted from the contract.

• All manually added standard and non-standard articles are retained. However, they
are moved to an ‘Unassigned’ section.

• Any other changes, such as formatting and layout, are removed.
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To change contract templates:
1. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)

Contract Terms (B) Change. The system displays the Change Contract Template
page.

2. Click Search for Contract Template, to search and select a template from the library.

3. Enter your search criteria.

4. Click Go. The Results page displays all templates that match your search criteria.

5. Select the appropriate template from the list.

6. Click Select. The system displays the Change Contract Template page.

7. Click Apply to bring in all the articles from the template to the contract.

Removing Terms
After applying a Contract Template, page 2-49 to a contract, you can choose to remove
all the articles and sections that are in the contract. To use this feature the contract
must be in the Entered status.

To remove terms:
1. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)

Contract Terms. The system displays the Contract Terms page.

2. In the Actions field, select the Remove Terms option.

3. Click Go.

4. Click Yes to confirm removal of all the articles and sections in the contract. Once the
terms are removed, the system displays the initial page and the Apply Template
button becomes available.

Adding and Deleting Sections
Sections allow Articles to be grouped together for logical display in the contract. For
each section, you can add subsections and group articles as necessary. You can manually
create a section for the contract or select a pre-defined section from the Sections library. To
add a section to a contract, select the location for the section. You can select an existing
section and choose to add the new section before, after, or within the section. If you
choose to add the section within the selected section, it would be treated as a subsection.

You can only update sections that are manually added. Sections that are added from
the Sections Library or the Unassigned section (Unassigned is a seeded section) cannot
be updated.

For more information, please see the topic about defining sections in the Oracle Contracts
Implementation and Administration Guide.

To add a section:
The steps for adding a new section manually or from the Sections Library are:

1. Create a new contract or open a contract in the Entered status.
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2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. Select an existing section.

4. Click Add Section. If no sections exist on the Contract Terms Page, select the
Contract Terms node and click the Add Section button. The system displays the
Add Section page.

5. In the Location field select the appropriate location for the new section.

6. In the Create field, select one of the following options:

• From Library: Select this option if you want to select a section from the Sections
library. In the Title field, enter the title for the section. You can also use the
Search for the Title icon to search for the title and select it in the Search and
Select Title page.

• New: Select the New option if you want to add a section manually. Enter the
Title and Description for the new section.

7. Click Apply.

Deleting a Section
If you delete a section, all articles and subsections within that section are deleted. A
section with mandatory articles in it, cannot be deleted.

To delete a section:
1. Open a Contract in the Entered status.

2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. Click Delete, for the section you want to remove. The system displays the Delete
Section page.

4. Click Yes, to confirm.

Adding and Updating Articles
As part of creating contract terms, you can:

• Adding Standard Articles, page 2-52

• Updating Articles, page 2-53

• Deleting Articles, page 2-54

• Creating Non-Standard Articles, page 2-54

• Selecting Alternate Articles, page 2-54

Adding Standard Articles
Articles can be added in two ways:

• Search and Add Articles
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• Browse and Add Articles

To search and add articles:
1. Create a new contract or open a contract in the Entered status.

2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. To add a standard article, select the location where it needs to be added to the
contract.

4. Click Add Article. The system displays the Add Article page.

5. Search for the article by:

• Keyword

• Title

• Type

• Number

• Default Section

6. Click Go. The Results section displays all articles that are active as of the start
date of the contract.

7. To review the article text prior to adding the article, click the Show link for the
article you want to add.

8. Select the check box for articles you want to add.

9. Click Apply.

To browse and add articles:

1. Create a new contract or open a contract in the Entered status.

2. Navigate to Service Contracts Authoring (T) Summary (T) Administration
(B) Contract Terms. The system displays the Contract Terms page.

3. To add a standard article, select the location where it needs to be added to
the contract.

4. Click Add Article. The system displays the Add Article page.

5. Instead of using the Search option, click Browse to search for articles by
Article folders. For more information, please see the Defining Article Folders
section of Oracle Contracts Implementation and Administration Guide.

6. Select the check box for articles you want to add.

7. Click Apply.

Updating Articles
Articles can only be updated for contracts in the Entered status.

To update articles:
1. Open a contract in the Entered status.
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2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. Click the Title link for the article you want to update. The View Article page displays:

• Complete article text

• Article attributes: Mandatory, Provision, Lock Text, Non-Standard

Note: If the Lock Text check box is selected, the article cannot be made
non-standard.

4. Click Update to open the Update Article Page. To open the Update Article page, you
can also click the Update icon in the Contract Terms page.

5. Make the necessary changes to the article.

Note: The Article Variables table is reserved for future functionality.

6. Click Apply.

Deleting Articles
Articles marked as Mandatory cannot be deleted.

To delete articles:
1. Open a contract in the Entered status.

2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. Click Delete for the article you want to remove. The system displays the Delete
Article page.

4. Click Yes to confirm the action.

Creating Non-Standard Articles
There are two ways to create a non-standard article. You can:

• Create a new non-standard article

• Create a non-standard article from any standard article

To create a new non-standard article:
1. Open a contract in the Entered status.

2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page.

3. Select the section for the new article.

4. Click Add Article. The system displays the Add Article page.

5. Click Create Non-Standard Article. The system displays the Create Non-Standard
Article page.

6. Enter the following parameters:

• Article Title (Required)
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• Display Name (Optional)

• Description (Optional)

• Article Text (Required)

7. Use the Provision check box to mark those articles that can only be used in
negotiation documents and not in contractual documents.

8. The Non-Standard check box is selected automatically.

9. Oracle Service Contract does not support the Article Variables functionality. Do not
add article variables to the article text.

10. Click Save to save your work.

11. Click Apply to add the article.

To create a non-standard article from any standard article:

1. To create a non-standard article from a standard article, the Text Lock option
for the standard article must be set to No.

2. Open a contract in the Entered status.

3. Navigate to Service Contracts Authoring (T) Summary (T) Administration
(B) Contract Terms. The system displays the Contract Terms page.

4. Click the Title link for the standard article you want to use to create a
non-standard article. The system displays the View Article page.

5. Confirm that the Lock Text check box is not selected, for the standard article.

6. Click Update to open the Update Article page.

7. Click Make Non-Standard.

8. Make the necessary changes to the article.

9. Click Apply to save your changes and close the Update Article page.

Comparing Standard and Non-Standard Articles
You can use the Compare feature to compare the differences between standard and
non-standard articles. To use this feature:

Click the Title link for the non-standard article to open the View Article page.

Click the Compare to Standard Article button. The system displays the Compare
Articles page. The inserted texts are marked with an Underline line, and deleted texts
are marked with a Strike-through line.

Moving Contract Terms
You can move contract terms (sections and articles) within a contract. The contract
must be in the Entered status.

To move contract terms:
1. Open a contract in the Entered status.
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2. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)
Contract Terms. The system displays the Contract Terms page

3. Select the article or section that you want to move.

4. Click Move to open the Move Term page.

5. Use the Destination Location field to specify the insert location by selecting one
of following options:

• Before Selection

• After Selection

• Within Selection

6. Select the appropriate radio button as the destination for the article or section.

7. Click the Apply button.

8. To achieve proper numbering, you need to manually renumber the contract
terms. For more information, see Renumbering Contract Terms , page 2-56.

Renumbering Contract Terms
After making any changes, such as moving or deleting sections and article, you need to
manually renumber the contract terms. Numbering schemes are defined in the Contract
Terms Library. For more information please see the Defining Numbering Schemes
section of Oracle Contracts Implementation and Administration Guide.

To renumber contract terms:
1. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)

Contract Terms. The system displays the Contract Terms page.

2. Click Renumber. The system displays the Renumber page.

3. In the Pick Numbering Scheme filed, select a scheme from the list.

4. Review the numbering scheme before applying the changes to the contract terms.

5. Click Apply.

Validating Contract Terms
As part of the quality assurance process for a service contract, you can validate contract
terms.

To validate contract terms only, you can launch the Validation process at any time
during the contract terms authoring process.

The system also validates contract terms automatically when a service contract is
submitted for approval.

To run the validation process:
1. In the Contract Terms page, click the Validate button. (N) Service Contracts

Authoring (T) Summary (T) Administration (B) Contract Terms (B) Validate.
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2. Review the results. The Validation Results page displays the number of errors and
warnings, and information related to errors and warnings including:

• Type

• Title

• Section

• Severity

• Problem

• Problem Description

• Suggestions for fixing the errors or warnings.

3. For a service contract to be submitted for approval, you need to fix all reported
errors. For more information, please see the Validation Errors and Warnings section
of Oracle Contracts Implementation and Administration Guide.

Check for Article Updates
Use the Check for Article Updates function to view the list of articles that have newer
versions in the library, and then select the applicable ones to apply to the contract
terms. This feature checks for latest updates for only those articles that are currently in
the contract.

To apply the latest version of an article:
1. Navigate to Service Contracts Authoring (T) Summary (T) Administration (B)

Contract Terms. The system displays the Contract Terms page.

2. In the Actions field, select the Check for Article Updates option.

3. Click Go. The system displays the Check for Article Updates page. This page
includes the following fields:

• Article: Article Name

• Section: The location of article in the document

• Current Version: The article version used in the document

• Latest Version: The latest version available

• Compare Text: Click the icon to open the article text and review differences
between the current and library versions.

4. Select the articles you want to update.

5. Click Apply.

Using the Lines Tab
Contracts that are authored (versus those that are automatically created) may contain
service, subscription or usage type lines. Services, subscriptions and usages are
all items that have been created in the item master (see Defining Service, , page
2-10Subscription, and Usage Items). The line types available for a contract will depend
on the contract category that has been selected. If the category is Service Agreement
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or Extended Warranty, two line types will be available - Service and Usage. For a
Subscription Agreement, line types are Service, Usage and Subscription.

When a service line is added to a contract, the coverage terms associated with that
service are defaulted onto the contract line. The default coverage terms can be modified
as necessary on the contract, but the price is unaffected. For example, you could choose
a service for 9x5 (nine hours a day for five days a week), and increase the coverage to
24x7, but the price will not increase because it was a 9x5 service that was selected on the
contract. However, when a tangible subscription item is added, the fulfillment schedule
defaults from the subscription template based on the duration of the contract. Changes
to the contract’s duration could impact the price and the number of items shipped.

To enter a contract line:
1. Navigate to the Lines > Accounts tab.

2. Enter a service, subscription, extended warranty, or usage line.

3. Enter customer contact, and address information.

4. Select the Effectivities tab.

5. Make any changes necessary to the effectivity dates for the lines. For a service or
extended warranty line, optionally edit the coverage. For a subscription line, the
quantity and unit of measure are defaulted. Optionally edit the fulfillment
schedule. For usage lines, specify the usage type.

6. Select the Pricing/Products tab.

7. For service lines, enter the covered levels and pricing information.

8. If you want to review details about the product, from Oracle Install Base for a
serviceable product, then click Product Details.

9. If you want to view the components of the price calculation, then click Price
Calculation.

10. For Usage lines, enter the counter and the pricing estimation attributes.

11. Click Billing.

12. Enter the billing information for the line.

13. Select the Tax/Payment Options tab.

14. Enter tax exemption and payment method information for the line.

15. Select the Counters tab.

16. Review counter information.To review the counter, right-click the counter line
and choose Counter Setup, or select the Counter Setup option from the Actions
menu. The system displays the Setup Counters window.

17. To capture counter values, right-click the counter line and choose Counter
Capture, or select the Counter Capture option from the Actions menu. The system
displays the Capture Counter Reading window.

18. Select the Events tab.

19. Select the Event Details option from the Actions menu, to review the event details.

20. Save your work.
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Guidelines

There is no limit to the number of contract lines that can be defined for a
contract. However, only one set of coverage terms can be defined for each
service, although it may include several business processes. For each business
process (for example, Depot Repair) a unique set of terms can be defined (for
example, coverage times, reaction times, or bill rates.)

There is no limit to the number of business processes that can be defined for a
coverage terms contract line. Also there is no limit on the number of billing types
that can be defined for a business process.

The contract information defined in the Summary tab (header) governs the terms
and conditions of the entire contract. However, these may be overridden by
explicitly entering alternative values in the Lines tab.

Counters that track usage of products and services are defined in Oracle Install
Base. For instance black and white copies and color copies made on copy machines
are examples of product counters. Total number of support calls and total number of
service requests are examples of service counters. To enter a usage type of product
and service line, it must be defined as an item in the Item Master and flagged
as a Usage Item serviceable product. Usage type information is entered on the
Effectivities tab.

See Lines Accounts Tab, page 2-59 for field explanations for the Customer Account
information.

See Lines Effectivities Tab, page 2-61 for field and button explanations.

See Lines Pricing/Products Tab, page 2-64 for field and button explanations.

See Lines Billing Button , page 2-76for field explanations for Billing.

See Lines , page 2-83Tax/Payment Options Tab for field explanations.

See Lines Counters Tab, page 2-83 for field explanations for Counters.

See Lines Events Tab, page 2-84 for field explanations for Events.

Lines Accounts Tab
The following table displays the fields and field descriptions for the Accounts tab:

Field Description

Line Number The line number is automatically generated.
This number is unique to the contract and will
not be reused even if the line is deleted and
new lines are added.

Line Type Select Service, Subscription, Extended
Warranty, or Usage. This field can be defaulted
by setting the profile option OKS: Default Line
Style, page 3-36.

Extended warranty line type is only available
for the Warranty and Extended Warranty
categories. Service and usage lines types are
available for Service Agreements. Service,
subscription and usage lines types are available
for Subscription agreements.
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Field Description

Name Select the name of the item from the list of
values.

Line References Allows entry of a user-defined free format line
reference for each contract line. This may be
used to represent the customer’s reference, for
example, a PO line number, or a CLIN
reference. This field is not system generated.

Order/Line If service contract has been interfaced with
Order Management, this shows the order/line
number. If a service contract is created
manually, this field is blank.

Bill To Account This defaults automatically from the
Summary/Parties tab. If different, select
the Bill to Account Number from the list of
values. If there is no Bill to at the line level, you
can use the Cascade Attributes option of
Actions menu to copy the Bill to Address from
the header to the lines.

Bill To Location This defaults automatically from the
Summary/Parties tab. If different, select the
Bill to Location Name from the list of values.

Ship To Account This defaults automatically from the
Summary/Parties tab. If different, select
the Ship to Account Number from the list
of values. If there is no Ship to at the line
level, you can use the Cascade Attributes
option of Actions menu to copy the ship to
address from the header.

Ship To Location This defaults automatically from the
Summary/Parties tab. If different, select the
ship to location name from the list of values.

Customer Contacts Region For each line entered on the contract, the
following information can be entered:

Role Enter the role from the list of values. Similar to
the header contacts, customer contacts can be
created for the party that the customer account
is associated with.

Name and Address Enter the party name from the list of
values. The Address field is populated
automatically.
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Field Description

Start Date and End Date For each contact, enter the start and end dates
to indicate the effective dates of that contact, if
applicable.

Bill To and Ship To Address The bill to and ship to addresses in this portion
of the tab are those addresses that belong to
the customer account as entered or defaulted
above.

Lines Effectivities Tab
The following table displays the fields and field descriptions for the Effectivities tab:

Field Description

Line Number Defaulted from the Lines-Accounts tab.

Line Type Defaulted from the Lines-Accounts tab.

Name Defaulted from the Lines-Accounts tab.

Status Defaulted from the header status.

Start Date This defaults from the contract start date. Enter
the service line start date, if different.

End Date This defaults from the contract start date. Enter
the service line end date, if different. If a
duration and period are entered, then the end
date is calculated.

Duration Enter the duration in whole numbers.

Period Select the period type from the list of
values. For example, Month or Year.

Qty Enter the quantity per delivery (Available only
for Subscription lines)

UOM Select the unit of measure from the list of
values. For example, Each, or Dozen. (available
only for Subscription lines)

Renewal Type This determines line duration for renewal. By
default, it is Full Duration, but it may be
manually changed during the renewal
review. See Determining Line Duration, page
2-114. The valid values are:

• Full Duration: The line is renewed for the
full duration of the contract.

• Do Not Renew: The line is not renewed.

• Keep Duration: This line is renewed for
the original duration of the line.
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Field Description

Description Displays the item description for the selected
line.

Invoice Text This text is defaulted based on the item
description and effective dates, but can be
overridden. The text is sent to AR during the
billing process.

Coterminate (button) Sets the end date of the currently selected
contract line to be the same as the end date
established by the Service Cotermination
setup.

Coterminate All (button) Sets the end date of all of the lines on the
contract to be the same as the end date
established by the Service Cotermination
setup. For additional information see Defining
Service Cotermination, page 3-25 in the
Implementing Service Contracts portion of
the Oracle Service Contracts Concepts and
Procedures Guide.

Coverage Region for Service Line Every service item defined in inventory is
associated with a coverage template. When
you select a service item in authoring and
save it, the associated coverage template is
used. The coverage name and description
appear.

Name Displays the coverage name

Description Displays the description for the coverage.

Edit Coverage button Click Edit Coverage button to view or edit the
coverage.

Exception Coverage Region If the coverage has an exception coverage
defined, then the exception coverage name and
description appear.

Name Displays the exception coverage name

Description Displays the description for the exception
coverage.

View Coverage button Click the View Coverage button to view the
exception coverage.

Template Region for Subscription Line -

Name Displays the name for the Subscription
template.

Description Displays a short description for the
Subscription template.
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Field Description

Edit Schedule button Click the Edit Schedule button to open the
Subscription Schedule form. This form
displays the order details and order fulfillment
history for each schedule delivery. You can
also use this form to update the subscription
schedule by editing the patterns.

The patterns specify the schedule for the
subscription item delivery. The Schedule
patterns consist of Year, Month, Week, Weekday
and Day. For each of these components, you
can enter individual values or range of values
separated by commas (,). Use a hyphen (-) to
specify a range by entering a hyphen between
the lowest and highest values. For example, the
value 1,3-6,9 in the month component would
mean January, March to June and September.

A value of * in any of the component means
’ALL’. For example, a ’*’ in the month field
would mean January to December.

Usage Type Region for Usage Line -

Fixed Per Period Select this usage type if the customer will pay
for the same number of units each month
regardless of the actual counter reading.

Actual Per Period Select if the billing is based on an actual net
usage in a billing period. This usage type
allows default and minimum counter values. If
no counter reading is captured for a period, the
default is billed. If the net reading for a billing
period is less than the minimum, the minimum
is billed. In addition, usage averaging is
enabled where an average billing is allowed if
no counter readings are captured for a given
period. This type can only be billed in arrears.

Actual by Quantity Select if the billing is based on an actual usage
by quantity. This usage type allows default
and minimum counter values. If no counter
reading is captured for a period, the default is
billed. If the net reading for a billing period
is less than the minimum, the minimum is
billed. This type can only be billed in arrears.

Negotiated Price Negotiated price is selected if the customer is
going to pay a fixed dollar amount regardless
of the usage reading. Negotiated Price usage
type can be billed in advance or arrears, as can
Fixed Per Period usage type.

Period Enter the period that is applicable to the
fixed, default, and minimum quantities
defined for the counter.

Using Oracle Service Contracts 2-63



Field Description

Termination Method Set the termination process you want to use by
selecting a termination option from the list of
values. The options are:

• Amount Based Termination: The amount
billed for a period is used to calculate the
credit memo amount. Amount billed for a
billing period is prorated for termination
date and credit memos are issued for
remaining part.

• Counter Based Termination: The counter
value billed for a period is used to calculate
the credit memo amount. Counter value
for a billing period is calculated based on
the price list and prorated for termination
date. This amount is then decremented
from billed amount to obtain the credit
memo value.

Average and Settlement (Actual per Period Usage Type.)

Averaging Allowed Select if averaging is allowed across invoices. If
the Averaging check box is checked, the
averaging interval is mandatory entry.

Averaging Interval (Bills) The averaging interval is a whole number and
is based on the period defined in the Usage
Type region.

Settlement against actual usage allowed Select if settlement against actual usage is
allowed. If checked, the Settlement against
Actual Usage concurrent request compensates
or settles billing against actual usage. If
a minimum or default invoice amount is
generated, this may be executed after the
counter reading is taken. If the counter
reading is greater than the previously billed
amount, an invoice is generated to compensate
for the under billing. If the counter reading
is less than the previously billed amount, a
negative invoice is generated to make up for
the over billing. In addition, this generates
an additional billing history line in the Lines
/ Billing tab.

Lines Pricing/Products Tab
The Pricing/Products tab is where sublines are created for each service line to add the
items that are covered for the particular service. The Effectivity tab is where you select
the coverage level and associated product(s) for each subline. If the products to be
selected are not already in the Install Base, they can be added from the Covered Product
Selection window’s New button. On the Pricing tab, you can view, enter, or override
the price of each subline as appropriate. Once the sublines are priced, billing schedules
can be established. The following table displays the fields and field descriptions for the
Pricing/Products tab:
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Field Description

Line Number Line number is automatically generated when
the line is created on the Lines Accounts tab

Line Type Defaults from the Lines Accounts tab.

Name Defaults from the Lines Accounts tab.

Line Ref Defaults from the Lines Accounts.

Duration Defaults from the Effectivities tab.

Period Defaults from the Effectivities tab.

Price (Last Contract) Displays the price of the contract line from the
previous contract, prior to renewal.

Currency (Last Contract) Displays the currency code of the contract line
from the previous contract, prior to renewal.

Subtotal This field displays the total price of all the
covered levels.

Tax This field displays the estimated line level tax
amount for all the covered levels.

Total The Total represents the sum of the line level
Subtotal and estimated Tax fields.

Invoice Print Flag A custom invoice print program uses this
flag, not the standard Receivables invoicing
process. The Invoice Print Flag check box
is available for each contract line to indicate
whether the line should be printed on an
invoice. There may be business practices that
do not require the lines to be printed on the
invoice. The default setting for this check box is
selected. Deselect the check box, if you do not
want to print the invoice for the corresponding
line item.

Show All Products (Button). Only enabled
for Warranty and Extended Warranty Service
Lines.

Lists Products for all sublines that are covered
under a particular Service Line. Items under
other coverage levels (site, item) will not be
displayed.
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Field Description

Price Break (Button) for usage line Click the button to open the Price Break form
to:

• Review the price break details

• Lock price breaks: If required, the price
breaks can be locked for the contract
to ensure that the price break details
agreed on the contract are protected
from price list changes. If the breaks are
already locked, the Locked check box is
checked. Optionally, the price breaks can
be unlocked by pressing Delete.

• Prorate price breaks: Price breaks can
be defined based on different billing
schedules. For example, if the price
breaks are defined assuming a monthly
schedule, and the contract starts part way
through a month, the price breaks can be
prorated appropriately. To prorate the
price breaks, the profile option QP: Break
UOM Proration Allowed must be set to
Yes and the break UOM must be defined
for the usage item in the price list. Select
whether or not the price breaks are to be
prorated using the drop down list. The
valid values are All and None. If you select
All, the entire price breaks are prorated
based on the break unit of measure. If you
select None, none of the price breaks are
prorated.

See Usage Item Price Break, page 2-18 for
more information.

Price Calculation (Button) To review the components of the price
calculation, then click Price Calculation button.

This is applicable to Subscription lines only.

• List price: This is the list price of the line.

• Quantity: This is the quantity ordered.

• UOM: This is the unit of measure of the
quantity ordered.

• Adjusted Price: This is the adjusted price.

• Extended Amount: This is the total of the
Quantity multiplied by the Adjusted Price.

• Status Text: This is the status of the
pricing, normally it is Success.

Reprice (Button) Enables the repricing of service items
in a contract when a new price list is
selected. Repricing can be done at any
time, not just while Renewal, at Contracts level
or Covered Product Level.
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Field Description

Billing (Button) This button allows you to create a line level
billing schedule.

Effectivity Subtab (Service Line)

Line Number This is the system generated line number.
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Field Description

Level This identifies the covered level for the
service. When searching for covered products
in this field, there are two different LOV
formats available. The standard Oracle
applications window will open, if you enter
a partial name or number with the wildcard
(%). Oracle Service Contracts has a special
search form that can be accessed by clicking
LOV in the Covered Level field. This form
allows you to search using the fields and filters
described below. If the product to be covered
is not already in the installed base, clicking the
New button, in the Cover Products Selection
window, will open Install Base to allow new
products to be manually added. The covered
levels are:

• Site: Covers all products at a particular
customer site. You can search for
sites of the Customer named on the
contract, any parties that are related to
that Customer, both the Customer and
their related parties or all customers. This
covered level is not priced automatically.

• Item: Covers all products of a particular
item. This covered level is priced
automatically by entered the quantity and
unit of measure.

• Product: Covers a particular product
from install base. You can search the
installed base of the named Customer, any
parties related to that Customer, both the
Customer and their related parties, or all
customers. You can filter your search to
look for just items, models or systems. Or
you can search all installed products for a
site, party, or customer. This covered level
is priced automatically.

• System: Covers a particular system
configuration for the Customer
and/or related parties as well as all
customers. This covered level is not priced
automatically.

• Customer: Covers all products for a given
customer account. You can search for the
Customer and/or parties related to the
Customer as well as all customers. This
covered level is not priced automatically.

• Party: Covers all products for a given
party. You can search for the Customer
and/or parties related to the Customer as
well as all customers. This covered level
is not priced automatically.
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Field Description

Name For the Item level this is the item name.

For the Party level this is the party name.

For the Product level this is either the installed
base product name, if the OKS: Item Display
Preference profile option is set to Name, or
product description if the OKS: Item Display
Preference profile option is set to Description.

For the Site level this is the site number for the
customer.

For the System this is the system name in the
installed base.

For the Customer this is the customer’s name.

With the Product level, you can select one
or more entries from the Product search
window. Upon selecting the products
and clicking the OK button, the covered
products are automatically added to the
contract and priced accordingly. For all
other covered levels, you can designate the
coverage of multiple products on a single
subline. However, except for item, the pricing
for this entry would be manual.

Line Ref Allows entry of user-defined free format
reference for each contract subline. This
may be used to represent the customer’s
reference, for example, a PO line number, or
a CLIN reference. This field is not system
generated.

Start Date This defaults from the line start date. Enter the
start date for this subline, if different.

End Date This defaults from the line end date. Enter the
end date for this subline, if different.

Duration Defaulted from the Effectivities tab.

Period Defaulted from the Effectivities tab.

Date Terminated The date at which the covered level was
terminated.

Description Displays the product description, if profile
option OKS: Item Display Preference is set to
Description. Displays the product name, if
profile option OKS: Item Display Preference is
set to Name.

Invoice Text This text is defaulted based on the item
description and effective dates, but can
be overridden. The text is sent to Oracle
Receivables during the billing process.
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Field Description

Product Details (Button) Click the button to access the Customer
Products window. This window displays
details such as product name, serial number,
reference number, address, installation
date, and quantity.

Effectivity Subtab (Usage Line)

Line Number The is a system-generated line number.

Name Select the name of the product or service
counter from the list of values. The name is
displayed, if profile option OKS: Item Display
Preference is set to Name. The description is
displayed, if profile option OKS: Item Display
Preference is set to Description

Reference This identifies the counter reference details.

• If this is a product counter, it includes the
product designation, serial number, and
reference number.

• If this is a service counter, it includes
the service designation, contract
number, modifier, and line number.

Line Reference This is the user-defined free format text.

Start Date This defaults from the line start date. This is
a read-only field.

End Date This defaults from the line end date. This is
a read-only field.

Duration This defaults from the Effectivities tab. This is
a read-only field.

Period This defaults from the Effectivities tab. This is
a read-only field.

Date Terminated The date that the counter (product or service)
was terminated.

Description Displays product description, if profile
option OKS: Item Display Preference is set
to Description. Displays product name is if
profile option OKS: Item Display Preference is
set to Name.

Product Details (Button) For product counters only. The Customer
Products window displays details such
as product name, serial number, reference
number, address, installation date, and
quantity.

Pricing Subtab (Service Line)
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Field Description

Line Number The line number is automatically generated.
This is a read-only field.

Level Defaults from the Effectivities tab. This is a
read-only field.

Name Defaults from the Effectivities tab. This is a
read-only field.

Line Reference Displays the sub-line reference, set on the
Effectivity Tab. This is a read-only field.

Quantity Enter the quantity to be covered for all covered
levels, except product. This is a display-only
field for a covered level of Product.

UOM Select a unit of measure from the list of values
for all covered levels, except product. This
is a display-only field for a covered level of
Product.

Unit Price If the covered level is Product or Item, then
Oracle Advanced Pricing is called to retrieve
the price including any modifiers, for
example, discounts and surcharges. The
pricing is based on the profile option
OKS: Default Pricing Date. In all other
cases, you must manually enter the price. This
is a display-only field for covered levels
Product and Item.

Extended Price The extended price is the unit price multiplied
by quantity. This is a display-only field for
covered levels Product and Item.

Price UOM Allows you to choose what unit of measure
to price for service, regardless of the unit of
measure of the service itself. For example, the
service may be 450 days duration, but the user
may choose to price in years. This will ensure
that a consistent price is retrieved per unit of
time, for different lengths of service. This is
enabled for covered levels Product and Item
only.

Subtotal The Subtotal is equal to the extended price. You
can manually override the subtotal, if desired.

Tax Displays the covered level estimated tax.

Total The Total represents the sum of the covered
level Subtotal and estimated Tax fields.

Description This is the same as description/name displayed
in the Effectivity tab.
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Field Description

Billing (Button) This enables you to create or modify a covered
level billing schedule.

Reprice (Button) Allows re-pricing of a covered level when a
new price list is selected. This is applicable to
covered level Products and Items only.

Price Calculation (Button) Allows you to review how the price
derived. This is applicable to covered level
Product and Item only.

• List price: This is the list price of the item.

• Quantity: This is the quantity of the
products covered.

• UOM: This is the unit of measure of the
products covered.

• Extended Amount: This is the extended
amount.

In addition the line level details are
displayed:

• List price: This is the list price of the line.

• Operator: This represents how the service
is priced (amount based or percentage
based).

• Quantity: This is the quantity of service
ordered.

• UOM: This is the duration of the service
ordered.

• Adjusted Price: This is the adjusted
price, if modifiers have been applied.

• Extended amount: This is the extended
amount.

• Status Text: This is the status of the
pricing, normally it is Success.

Pricing subtab (Usage Line)

Line Number This read-only field is a system-generated line
number.

Name This is the name displayed on the Effectivity
subtab.
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Field Description

Reference This read-only field identifies the counter you
enter in the Name field:

• For product counters, it includes the item
name, the Oracle Install Base item instance
number, and the serial number

• For a service counter, it includes the
service name, the contract number, the
contract modifier, and the line number
where the service appears.

Line Reference Read-only field defaulted from the Effectivity
subtab.

Subtotal Currency amount the customer is charged for
usage. Agents can make entries in this field for
the Negotiated Price usage type. This field is
disabled for other types.

Tax Application-calculated tax.

Total Subtotal and tax added.

Price Break (Button) Click this button to open the Price Break
window where you can:

• Review price break details.

• Lock price breaks: If required, the price
breaks can be locked for the contract
to ensure that the price break details
agreed on the contract are protected
from price list changes. If the breaks are
already locked, the Locked check box is
checked. Optionally, the price breaks can
be unlocked by pressing Delete.

• Prorate price breaks: Price breaks can
be defined based on different billing
schedules. For example, if the price
breaks are defined assuming a monthly
schedule, and the contract starts part way
through a month, the price breaks can be
prorated appropriately. To prorate the
price breaks, the profile option QP: Break
UOM Proration Allowed must be set to
Yes and the break UOM must be defined
for the usage item in the price list. Select
whether or not the price breaks are to be
prorated using the drop down list. The
valid values are All and None. If you select
All, the entire price breaks are prorated
based on the break unit of measure. If you
select None, none of the price breaks are
prorated.

See Usage Item Price Break, page 2-18 for
more information.
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Field Description

Counter Details (Usage Line)

Line Number Read-only field copied from the Effectivity
subtab.

Name Read-only field copied from the entries you
made in the Effectivity subtab.

Reference Read-only field copied from the entries you
made in the Effectivity subtab.

Fixed This field is enabled for entry only for the
Fixed Per Period usage type. Use it to enter
the quantity you are going to be charging
the customer. The amount is based on the
period you selected in the Period field in the
Effectivities subtab.

Minimum This field is enabled only for Actual by
Quantity and Actual Per Period usage
types. Use it to enter the minimum counter
value. The customer is charged this minimum
if a counter reading or estimate falls below this
number in any billing period. The amount is
based on the period you selected in the Period
field in the Effectivities subtab.

UOM Unit of Measure

Fill This check box is available only for the Actual
Per Period usage type.

When unselected, the application estimates
usage only when there is no reading during
the period.

Selecting the check box also estimates usage
for any remaining days in a billing schedule
period since the reading was entered.

For example, if the you are billing the customer
monthly, and a reading is entered on 15
January, then selecting the Fill check box
causes the application to estimate usage for the
remaining half of January.
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Field Description

Estimation Method This field is available only for the Actual Per
Period usage type.

Select an estimation method from the list of
values. You can select:

• Average Monthly Counter Volume
(AMVC): AMCV is applicable to the
Actual per Period and Actual by Quantity
usage types only. It is used to calculate an
estimate based on readings from the start
of the contract when a counter reading is
not available.

• Counter Estimation: Counter estimation
is used for usage billings based on the
options selected in the estimation template
for the counter defined in Oracle Install
Base. For more information, see the
Implementing and Using Counters section
of Oracle Install Base User’s Guide.

Estimation Start Date This field is available only for the Actual Per
Period usage type.

If in the Estimation Method field, you selected
the Counter Estimation method, optionally
enter the date from which counter readings are
to be taken when calculating an estimate. If
you leave this field blank, counter readings
will be taken with a reading date on or after
the start date of the line.

Default If the usage type is Actual per Period or Actual
by Quantity, enter the mandatory default
counter value. If a counter reading is not taken
for a given period, a default invoice will be
generated. For example, the default counter
value defined on the contract would be used to
determine the invoice amount.

Level If multiple counters are defined on a contract
and one or more counter readings are
significantly higher than the others, usage
leveling can be used to equalize or distribute
the readings across all the counters for a given
billing period. This simplifies the customer’s
invoice by showing an even billing distribution
across all the counters. If applicable, check
Level for each applicable counter.

Reading A list of values (LOV) with all historical
readings for this counter. You can use this
LOV to enter the initial base reading for the
countract. The monthly net counter reading is
based on this base reading. If left blank, the
application assumes that the base reading is
zero (0).
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Field Description

Net Reading This display-only field tracks all historical
activity for the counter such as roll-overs.

Description This is the same description/name displayed
in the Effectivity tab.

Administration subtab Service Lines

Line Number The is the system-generated line number.

Name Select the name of the product or service
counter from the list of values. The name is
displayed, if profile option OKS: Item Display
Preference is set to Name. The description is
displayed, if profile option OKS: Item Display
Preference is set to Description.

Reference This identifies the counter reference details.

• If product counter, this included the
Product designation, serial number, and
reference number.

• If service counter, this includes the Service
designation, contract number, modifier,
and line number.

Line Reference This is the user-defined free format text.

Price (Last Contract) Displays the price of the covered level on the
previous contract, prior to renewal.

Currency (Last Contract) Default from contract line.

Renewal Type This determines line duration for renewal. By
default, it is Full Duration, but it may be
manually changed during the renewal
review. See Determining Line Duration. , page
2-114The valid values are:

• Full Duration: the line is renewed for the
full duration of the contract.

• Do Not Renew: the line is not renewed.

• Keep Duration: this line is renewed for the
original duration of the line.

Lines Billing Button
The Lines Billing button gives you the ability to determine a flexible billing amount and
schedule. This billing schedule gives the liberty to bill whatever amount you want to bill
for a given period of time. For example, you can choose not to bill in the first month
and adjust that amount in the billing for the subsequent months. The billing schedule
can be set up at the header and rolled down to the line level or created individually for
each line on the contract.
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You have an option of conveniently billing for different billing periods. This can be
decided by choosing the Billing Type from the Schedule header. The three choices are:

• Equal Amount

• Top Level (not available for Subscription type contracts)

• Covered Level (not available for Subscription type contracts).

You can select one of these levels as the default so that each time you create a billing
schedule, that choice will appear automatically. The billing level default is selected in the
OKS: Billing Schedule Level profile option.

For Equal Amounts, you can bill for equal amounts over the billing period and has full
control over the amount to be billed and the billing periods. Or by using the Prorate
button, the amount can be spread across the billing periods. The start and end dates of all
top lines and their sublines must be the same. The schedule form, once generated, cannot
be modified for the covered product line.

For Top Level, you can define the billing periods and the billing engine calculates the bill
amounts (therefore the amount fields will be disabled). Line level start and end dates
can differ from the sublines. The Prorate button will be disabled. When creating billing
schedules at this level, the total stream level amounts from the sublines will roll-up to
the line levels. Also, once a line level billing schedule exists, all new sublines added
will automatically update the billing amount per period without needing to revisit
the line level and click Schedule again.

Also, for Top Level bill schedules, whenever the duration of the line is increased, an
additional billing stream will be created. If the contract has a later end date, the unit
of measure of the billing stream is taken from the previous stream. If the duration is
reduced, billing streams may be removed, as long as those streams are entirely outside
of the new contract duration. If these changes are cascaded to the sublines, those
billing schedules will be updated when the cascade is initiated. If the changes are not
cascaded, only the line level billing schedule will be automatically updated.

When the covered level effective dates are not the same as the service line effective
dates, you have the option to create a covered level specific billing schedule. As a
prerequisite, the service line billing schedule level must first be set to the Covered
Level. By default, all the covered level lines inherit the service line billing schedule. If
required, the billing schedule can be modified and updated for a given covered
level. Amounts can be entered for every period or the Prorate button may be used. This
level of billing schedule is not available when you are creating a header level billing
schedule.

When creating a header level billing schedule, it will become the default information
for all service and usage lines in the contract. If changes are made to the line level
billing schedules, it is important to note that refreshing the header level billing schedule
will overwrite these changes since the header schedule is rolled down to the lines
each time the schedule is refreshed. A warning message will appear reminding you
that this is about to happen. The header billing schedule does not receive billing
history information. It cannot be updated or used to schedule lower levels once billing
has happened.

Stream Level Window

A billing schedule may have many billing streams. Each stream level is a set of billing
periods. For example: A contract starts on 17 December 2003 and runs till 31 December
2004, duration of 380 days. Due to this irregular duration, the billing period would have
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been calculated at a daily rate and would have given varying billing amounts, depending
on the length of each calendar month. Billing stream levels allows you to set up a
separate stream for the irregular period of 15 days, followed by a second stream of 12
months. The stream level in this case would be “bill for 1 period of 15 days at $500
followed by 12 periods of 1 month at $1,000.”

Schedule and History Tabs of Billing Schedule Window

The Schedule tab displays the termination and adjustment details. The History tab
displays the billing history. The Billing Schedule window opens once the Billing button
is clicked from Lines > Pricing/Products.

Field Description

Schedule Tab -

Invoicing Rule. Choose the invoicing rule from the list of
values for the contract line. The invoicing rule
is defaulted from the contract header invoicing
rule

Accounting Rule Defaults from the contract header accounting
rule. The accounting rule determines when
revenue is recognized for the service contract
billing.

Level Select a level from the list of values: Equal
Amount, Top Level or Covered Level. Note:
The Covered level is not available for usage
lines and only the Equal Amount level can be
used for Subscription contracts.

Start Date This field is a display-only field and shows the
start date of the contract line.

Amount Displays contract price.

End Date Enter the end date of the contract.

Terminated Region The fields in this region display the termination
details.

Unbilled The field displays the unbilled amount due to
termination,

Credited This field displays the credit amount issued
due to termination.

Suppressed This field displays the amount that was
suppressed when the credit was calculated.

Total The total of Unbilled, Credited, and Suppressed
fields.

Overridden This field displays the credit amount that was
overridden during termination.
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Field Description

Adjusted Region The fields in this region display the adjustment
details.

Discount This filed displays the total discount amount.

Surcharge This filed displays the total surcharge amount.

Total This field displays the sum of discount and
surcharge.

Billed This filed displays the total amount billed for
the contract, line, and subline.

Stream Level Region -

Seq No Enter the sequence in which you wish to have
the billing stream levels billed.

Number of Periods Enter the number of billing periods to be
included in this stream level. For example, to
set up a stream level of “bill for 1 period of 15
days at $500,” the value in this field should be
one (1).

Start Date This field is a read-only field and displays the
start date for the contract line.

End Date Enter the end date for the stream level.

Duration Enter the number of periods to be included in
this stream level, in the above example, the
value in this field should be 15.

Period Enter the unit of measure for the billing
period, in the above example, the value in this
field should be Day.

Amount Enter the amount to be billed for each period
in the stream level. For a level of Equal
Amount, you must enter a value in this field or
use the Prorate button to create the value. For
a level of Top Level, this field is disabled
as Oracle Service Contracts can calculate a
value automatically based on the price of
the contract line. When viewing a Top Level
billing schedule, the stream level values for
the sublines beneath it will be rolled up and
displayed in this field.

Total Amount This field displays the total amount for all
periods in the billing stream.
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Field Description

Invoice Offset For an invoicing rule of Advance, the
invoice date is determined by Oracle Service
Contracts. Enter the number of days (plus or
minus) from which the invoice date should
be set from the bill from date. The invoice
date must be on a later date than the current
date but may be prior to the start date of the
contract.

For arrears billing, the Invoice Offset field is
disabled.

Interface Offset Enter the number of days from which the
Interface date should be set from the bill from
date. The Billing program uses the information
to determine the date for sending the billing
records to Oracle Receivables. Oracle Service
Contracts will enforce that the interface date
is the earlier of either the Invoice Date or the
Bill from Date. As the result, only offsets less
than 0 will have any effect on the interface
date. Using the interface offset to create an
interface date prior to the start date of the
billing period may, during the first billing
cycle, result in the interface date being prior to
the start date of the contract. The billing engine
will find any billing stream where the interface
is on or before the date specified. Therefore, an
interface date in the past will not prevent
billing from running successfully.

Cascade Dates After making a change in the start or end dates
of the billing sequences, click this button to
automatically set the dates to cascade from one
to the next, so that the billing schedule does
not have any gaps or overlapping dates.

Prorate Use this button for Equal Amount billing to
have Oracle Service Contracts automatically
calculate the invoice amounts based on the
billing sequences that have been defined.

Schedule Use the Schedule button to display the billing
schedule after creating or making any changes
to the billing schedule or contract effectivity
dates at any level that affects the billing
schedule. It creates schedules for sublines
(where applicable) and must be clicked to save
the schedule.

Schedule Region All fields in this region are display only and
show the result of the values that have been
entered in the previous region.

Seq No This field shows the sequence number of the
billing schedule from the previous region.

Level Seq This field shows the sequence number of each
stream level.
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Field Description

Invoice Date This field displays the invoice date that is sent
to AR. However, for the Advance invoicing
rule, this date can be changed by using the
Invoice Offset field in the previous region.

Bill From This field shows the start date of the billing
period. This date is used to derive the
accounting period for which revenue is to be
recognized for the contract line.

Bill To This field shows the end date of the billing
period.

Interface Date This field shows the date when Oracle Service
Contracts billing program will pick up the
record to send to AR. This date can be changed
by using the Interface Offset field in the
previous region.

Amount This field shows the amount that will be billed
in the billing period.

History Tab This tab displays the billing history.
Information is updated first by the Service
Contracts main billing and then updated by
the Fetch to display actual amounts billed
including tax and invoice numbers. Only the
line level billing schedule histories will be
populated with actuals. Header level billing
schedules will not show any billing history. If
summary transactions are selected with either
the profile option or the contract check box, the
history will contain one transaction line per
billing period. However, if detail transactions
are being sent to Oracle Receivables, the
billing history will show the details for each
subline per billing period. In the billing
history, right-mouse click Details on a line to
view the details for that billing transaction.

Lines Tax/Payment Options Tab
The application checks tax exemption effectivity at time of billing.

Since tax exemptions for a contract may not be effective for all of the billing periods on
the contract, the application validates that the billing period is valid for the exemption
associated with the period. The validation checks that the transaction date for the
billing period falls within the defined period of effectivity for the tax exemption. If the
billing period does not, then the billing period does not pass a tax status to Oracle
Receivables. The application still passes the tax exemption number and the tax engine
determines the tax handling for the billing period.

Tax exemptions can be defined for a specific date, for a date range, or for an open-ended
period of time. If there are billing periods on a contract that have a transaction date that
falls outside the period the tax exemption is effective, a warning message informs the
user that not all billing periods on the contract will qualify for the tax exemption.
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The tax amount displayed by the application takes into consideration the number of
billing periods that qualify for the tax exemption.

The following table displays the field names and descriptions for the Tax/Payment
Options tab:

Field Description

Tax Exemption region -

Line Number This is the system-generated line number.

Line Type Indicates Service or Usage line

Name Identifies the Service or Usage item

Tax Status Select the tax status for the item selected. You
can select:

• Exempt

• Require (or Override Exemptions)

• Standard

The Tax Status list of values (LOV) makes
the Require and Override Exemptions
values mutually exclusive.

The LOV displays Override Exemptions
if tax is mandatory and the tax database
is Oracle. It displays Require if tax is
mandatory and the tax database is Vertex
or Taxware.

A QA check warns if tax exemption is not
valid for all billing periods on the contract.

Number Enter the tax exemption certificate number
from the list of values (if applicable). Not
available if Status is other than Exempt.

Reason Indicates the reason this item is tax exempt (for
example, Reseller). Not available if Status is
other than Exempt.

Tax Code If Status referenced above is other than
Exempt, this field provides a list of values from
which to select the appropriate tax code for
this item.

Entry in the Tax Code field is optional when
the Tax Status has been set to Required.

A tax status of Required means that the
application overrides any exemptions entered
in the contract as tax is mandatory for the
transaction. It does not mean that the tax code
must be sourced from the contract in order to
calculate tax. By leaving the Tax Code field
blank, users permit the tax engine to derive the
applicable tax code.
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Field Description

Tax Inclusive Flag The Tax Inclusive Flag check box is defaulted
based on the tax code setup in Oracle
Receivables.

Payment Method region -

Purchase Order Required If using a purchase order for payment, select
the Purchase Order Required check box.

PO Number If you want to reference the PO number on the
invoice, enter the purchase order number in
this field.

Payment Type Optionally select a payment type from the list
of values. You can select:

• Null (the default value)

• Credit Card: Select this option if the
customer chooses to pay for the service
agreement by credit card.

• Commitment Number. See Commitment
and Credit Card , page 2-104Billing
Methods

Lines Counters Tab
The following table displays the fields and field descriptions for the Counters tab:

Field Description

Name Counter name

Type Counter type

UOM Code The code for the unit of measure

Net Reading The difference between the current counter
reading and the last reading that was billed.

Timestamp The date the net reading was recorded.

For the Usage line type, in addition to above fields, the Counter tab displays:

Field Description

Source Details Counter details

Serial Number Serial number

Reference Number Reference number
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Lines Events Tab
Events are normally linked to a counter, whether it be a unit based or time based
counter. Events are defined in the Condition Template form. The Events tab shows the
anticipated outcome that is a PL/SQL procedure that executes some business logic. For
example XYZ Company wants to schedule a preventive maintenance service request after
a time-based counter has elapsed 3 months. In this case, the outcome is a custom PL/SQL
procedure that uses the Create/Update SR API to call a Service Request template.

The following table displays the fields and field descriptions for the Events tab:

Field Description

Name Event name such as counter update.

Description Event description

Date Active Date event becomes active.

Date Inactive When event has become inactive.

One Time Identifies whether the event will be evaluated
once only, rather than potentially being
triggered on a recurring basis.

Using the Tools Menu Functions
The following functions can be accessed from the Tools menu

• Revenue Distribution, page 2-84

• Create New Version, page 2-85

• Change Status, page 2-85

• Pricing Qualifier, page 2-86

• Pricing Adjustment, page 2-86

• e-mail Quote, page 2-87

• Update Service, page 2-87

• Terminate Subline, page 2-88

• Invoice Details, page 2-88

• Summary/Lines, page 2-88

• Notes, page 2-89

Revenue Distribution
This provides the ability of distributing revenue for service items on a contract into
accounts other than the default account that has been set up. You can enter new revenue
information for some lines without changing others. You can change the default revenue
distribution of an Entered status contract or you can open an Active contract for update
(or create a change request). You can change the revenue distribution for a contract even
after a line has been billed but this will only change the revenue distribution for future
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billing. If the contract is copied, renewed or used as a template these distributions
will also be copied to the new agreement.

To distribute revenue:
1. Navigate to Service Contracts Authoring > Tools > Revenue Distribution.

2. Review the account defaulted in the GL Account field.

3. Select the Override account field. A list of values is displayed with the different
account aliases.

4. You can choose the overriding account by selecting the segment values, or by
choosing from the list of combinations.

5. Enter the percentage to be allocated to the account in the Percent field. The Total
Percentage should equal 100%.

6. Save your work.

Create New Version
Provides the ability to create a new version of an existing contract.

To create a new version of an existing contract:
1. From the Contract Navigator, click the contract to be versioned.

2. Navigate to Contracts Authoring >Tools > Create New Version.

3. The new version of that contract is created.

4. In order to view the new version or any previous versions, from Contract Navigator
go to Launch Contracts > Contract Navigator > Service. Double click the contract. A
window will open. On the bottom of the window click the History tab. The different
versions of the contract would be listed there and you can pick any version for
read-only access.

Change Status
Provides the ability to change the current status of the contract to another status.

To change the contract status:
1. Navigate to Service Contracts Authoring > Tools > Change Status.

2. The Change Status window will open.

3. Select the new status from the list of values.

4. Select a Reason Code from the list of values.

5. Enter any relevant comments.

6. Commit and the status of the contract will be changed.
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Pricing Qualifier
This provides the ability to define the pricing qualifiers that are eligible for the
contract. This information is passed to Oracle Advanced Pricing to calculate the
appropriate discounts or surcharges. For more information about Qualifiers and
Modifiers, please refer to the Oracle Advanced Pricing User’s Guide.

To define pricing qualifiers:
1. With the cursor at the line level, navigate to Tools > Pricing Qualifier.

2. The Pricing Qualifier window will open.

3. Select segments from the list of values.

4. This will qualify if the contract is eligible for any discounts or surcharges.

Pricing Adjustment
Price adjustments that have been applied automatically can be reviewed using
this feature, and also additional adjustments can be applied manually. If done
manually, make changes and save them. Then apply the changes and reprice the
contract for the changes to appear. You can enter price adjustments at the contract
header, line or subline.

For header level pricing adjustments:

• If the price adjustment is a percentage, that percentage would be applied to each
subline.

• If the adjustment is a fixed amount, the adjustment would be applied to each
subline. For example, if the amount entered in the Adjustment window is a $10
discount, each subline would be reduced by $10 with lines above reflecting the
cumulative effect of those discounts. For a line containing three sublines, each
subline is discounted by $10. As the result, the cumulative effect on the price of the
line would be a $30 reduction.

To perform pricing adjustments:
For Header Level Price Adjustments:

1. Navigate to Service Contracts Authoring > Tools > Pricing Adjustments.

2. The Pricing Adjustment window will open.

3. Select a modifier number from the list of values. The modifier number is a type of
pricing adjustment set up in Oracle Advanced Pricing.

4. Apply the changes.

For Line Level Price Adjustments:

Highlight the line or subline to be adjusted.

5. Navigate to Service Contracts Authoring > Tools > Pricing Adjustments.

6. The Pricing Adjustment window will open.

7. Select a modifier number from the list of values. The modifier number is a type of
pricing adjustment set up in Oracle Advanced Pricing.
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8. Apply the changes.

E-mail Quote
Quote letters can be generated and e-mailed to a customer as part of the renewal
process. The person who receives this e-mail quote is specifically identified on the
Summary Renewals tab, as described previously.

Prerequisites
The following profile options must be set up in order to use the e-mail Quote
functionality:

OKS: SMTP Domain

OKS SMTP Host

OKS: SMTP Port

Refer to the Implementing section ofOracle Service Contracts Concepts and Procedures for
more information regarding these profile options.

To generate an e-mail quote:
1. Navigate to Service Contracts Authoring > Tools > e-mail Quote

2. Select the quote printing report to be run (these will be specific to the
environment). This is not generated from Oracle Quoting. It is a report summarizing
the contents of the renewal contracts.

3. The To field will default from the Quote To field in the Summary Renewals tab. Enter
a Reply To/Copy e-mail address of the sales representative or other individual who
should be copied or replied to about this e-mail. This field is free-format text.

4. Add additional recipients if necessary.

5. Enter any text for the body of the e-mail.

6. Click Send. Clicking Send creates two concurrent requests. The first generates
the quote using the quote printing report specified above and the second creates
and sends the e-mail.

Update Service
This form enables you to review existing service information and choose one or more new
replacement services for the covered products on the contract line. It allows you to assign
a percentage of the price of the former service to the new service line(s). It is intended
as a tool for use on entered status contracts, generally during the renewal process. For
example, a customer has a contract with a line that covers 500 laptops for Bronze service
which covers Monday through Friday from 8am to 5pm. After restructuring their service
offerings, Bronze service is no longer offered but Level II support is the comparable
offering. In order to make contracts reflect the new offering, rather than having to add
a new line and add all the covered products to that line, simply select the old service
line, click Update Service, choose the new service and indicate what percentage of the
existing service’s price should be applied to the new service. This amount does not need
to equal 100% it can be more or less depending on the appropriate value for the new
service. Contract value and billing schedule amount are adjusted accordingly. Coverages
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and invoice text are not changed. The renewal relationship to the prior contract is not
lost when Update Service is performed on a service line. The Update Service function is
not available for Usage and Subscription lines.

To review and update services:
1. Navigate to Service Contracts Authoring for the contract being updated.

2. From the Lines - Pricing/Products tab, place cursor on the Service Line item that is
being updated.

3. From the Tools menu select Update Service.

4. Under Contract Line at the top of the form, review the information to make sure
this is the line that should be updated.

5. Under Update Service select from the List of Values the new service item that is
replacing the item shown at the top of the form.

6. In the Prorate column, indicate the percentage of the price from the existing service
item that should apply to the new service item. For example, if the existing item
is $150 and the new item should cost $75, enter 50 to see a final price on the new
line that is equal to 50% of the old line.

7. Enter additional service lines as necessary. The prorate column does not need to total
100%. You will receive a message indicating that the total is more or less, select OK
to proceed or cancel to return to the form.

8. When all of the new lines have been entered, click Apply. The existing service item
will be gone and the new service items will appear instead. The new price will be
reflected for the line item. The billing schedule will reflect the new pricing as well.

Terminate Subline
For information on this topic, see the Terminating a Subline, page 2-120 section.

Summary/Lines
Use the Summary/Lines function to open the Summary or Lines tab.

Invoice Details
Use the Invoice Details function to review payment, credit, and adjustment information
applicable to the contract, lines, and sublines.

To view invoice details:
1. Navigate to Service Contracts Authoring > Tools > Invoice Tools

2. The Invoice Details window displays: Invoice Number, Date, Source, Transaction
Type, and Amount.

3. Click the Payment Details button to open the Payment Details window. This
window displays:

• Payment Amount
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• Payment Date

4. To review details for a specific line, select the line and click the Line Details
button. The Line Details window displays:

• Item Names and Descriptions

• Unit of measure

• Unit Price

• Billed Amount

• Tax Rate

Notes
Use the Notes function to add extra information to the contract. The note can contain
any free format text. For examples, you can include notes for contract administrators
regarding the management of the contract, or to customer care agents regarding the
services provided under the contract.

You can create two types of notes in Oracle Service Contracts:

• Contract Coverage notes: Contract Coverage notes allow you to add further
information to either the coverage template or to service included on a contract. With
the exception of Private notes, any note added to the coverage template is
automatically added to the instantiated coverage definition when the service
is included on a contract. Service application users as well as Service Contract
application users can view these types of notes.

• Contract Admin notes: Contract Admin notes allow you to add further information
to the contract. These types of notes can be associated to the contract header and
coverage. Only Oracle Service Contracts users can view Contract Admin notes.

The following table displays the fields and field descriptions for the Notes form:

Field Description

Notes Enter the note text in the Notes region

Type The default for the Note Type field is Contract
Coverage. You can accept the default or select
another type from the list of values.

Status Select a particular status for the note from the
list of values. You can select:

Publish: All users can view it.

Public: The creator and other users can read
and write to it.

Private: Only the creator can view it.

More button Click More to open the Detailed Note page and
enter additional information.

New button Click New to add a new note.
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Using the Actions Menu Functions
The following functions can be accessed from the Actions menu:

• Save as Template, page 2-90

• Copy from Template/Contract, page 2-90

• Counter Setup, page 2-90

• Counter Capture, page 2-90

• Check QA, page 2-91

• Submit for Approval, page 2-91

• Bookmark, page 2-91

• Event Details, page 2-91

• Show Index, page 2-91

• Delete Contract, page 2-91

• Cascade Service Price, page 2-91

• Sales Credits, page 2-91

• Pricing Attributes, page 2-92

• Cascade Attributes, page 2-92

• Revert Update, page 2-109

Save as Template
You can create contracts with minimum required information. At any time you can save
a contract as a template, using the Save as Template option from the Actions menu. For
more information, see the Save as Templates section of Oracle Contracts Core User Guide.

Copy from Template/Contract
Use the Copy from Template/Contract function to copy a contract or a condition
template into your contract. For more information, see the Copying a Condition
Template section of Oracle Contracts Core User Guide.

Counter Setup
To review the counter, select the Counter Setup option from the Actions menu. The
system displays the Setup Counters window.

Refer to theUsing the Lines Tab, page 2-57 section for more information.

Counter Capture
If you want to edit counter values, select the Counter Capture option from the Actions
menu. The system displays the Capture Counter Reading window.

Refer to theUsing the Lines Tab, page 2-57 section for more information
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Check QA
For information on this topic, see the Check QA of Contract Authoring and Pricing ,
page 2-35section.

Submit for Approval
The Submit for Approval function launches the QA check and, if successful, allows the
contract to progress through the Approval workflow.

Bookmark
Use the Bookmark function to add the contract, to your personal list of contracts in
the Home Page.

Event Details
When you are on a contract line, you can go to the Actions menu and select
Event Details. The Condition Template form appears where you can enter either
action (for example, counter updated) or date based (for example contract signed)
conditions. Events (conditions) that are already associated with the contract can be
viewed on the Events tab. For more information, see the Defining Condition Templates
section of Oracle Contracts Core Implementation Guide.

Note: When creating a service contract, if there is no counter and event attached with the
service item, the Event Details menu option will be grayed out.

Show Index
At any point once the contract has been created, you can use the Show Index feature
from the Actions Menu to see some of the high-level details of the agreement. The index
shows the parties, line level service items, the covered level products at the sublines and
the names of any rules or articles attached to the contract. By selecting an item on the
index and clicking Go, you can navigate to that point in the contract.

Delete Contract
Use the Delete Contract function to delete contracts with statuses of Entered and
Canceled.

Cascade Service Price
For information on this topic, see the Cascade Service Price, page 2-110 section.

Allocating Sales Credits
Contract authoring allows the allocation of sales credits to multiple sales reps. Sales
credits can be assigned at the header level and the line level (for either service or usage
lines). Cascade attributes can be used to copy header level sales credits to line levels. If
a contract containing sales credits is copied, renewed or used as a template the sales
credits are also copied to the new agreement.
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To allocate sales credits:
1. Navigate to Service Contracts Authoring > Actions > Sales Credit.

2. Review the Contract Number, Service Name, Party Name, Modifier, and Start and
End dates. These are read-only fields.

3. Select a Sales Person from the list of values.

4. A Sales Group defaults once the Sales Person is entered. The sales group can be
changed, if the sales person belongs to more than one group.

5. Select the Credit Type from the list of values. The valid values are:

• Quota Sales Credit

• Non Quota Sales Credit

6. Enter the percent allocated to the given salesperson.

7. Review the Revenue Total that is a running total of revenue credits. This is a
read-only field and must equal 100%.

8. Review the Non Revenue Total that is the running total of non-revenue credit. This
is a read-only field and may not exceed 100%.

9. Select OK to save.

Pricing Attributes
The pricing attributes may be maintained for any of the covered products. To access
these attributes, the covered product should be highlighted when selecting Pricing
Attributes from the Action menu.

To maintain pricing attributes:
1. From the Authoring window navigate to Actions > Pricing Attributes.

2. Select the Pricing Context from the list of values. For each Pricing Context, the
pricing attributes may be entered in the corresponding descriptive flexfield.

3. Click Apply to save the pricing attributes

Cascade Attributes
Provides the ability to cascade contract attributes from each level, header to lines and
lines to sublines. For example, changes to the start and end dates can be rolled down
to the next level in the contract.Attributes that can be cascaded from header to line
are Date, Accounting Rule, Bill to Address, Bill to Contact, Ship to Address, Invoice
Rule, Tax Status, Exemption Number, Billing Profile ID, Recalculate Tax, Sales
Credit, and Payment Method. Attributes that can be cascaded from line to subline are
Date, Invoice Text, Renewal Type, and Invoice Print Flag. After selecting the attribute to
be cascaded, you can select the lines or sublines to receive the changes.

To cascade attributes:
1. From the Authoring window navigate to Action > Cascade Attributes

2. Select Cascade type ‘Header to Lines’ or ‘Lines to Sublines’ from the Cascade field.
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3. Select the attributes to be cascaded by selecting the appropriate check box.

4. When cascading line to sublines, the sublines can be viewed by double clicking the
line indicator box. This will open a window displaying all the sublines for that
line. The sublines to be selected can be indicated with a check box.

5. Review the lines or the sublines to be changed and identify any to be excluded from
the change by clearing the check box.

6. Click Submit.

7. Review the transaction log to check for errors.

8. Apply the changes.

9. For date-related changes, check the billing schedule and Refresh as necessary to keep
the billing schedule dates in synch with the effectivity dates.

Revert Update
For information on this topic, see the Revert Update , page 2-109section.

Billing
Contract billing involves determining the exact amount to be charged for services
provided against a contract. Oracle Service Contracts lets you set up flexible billing
cycles. For example, you can set up a monthly billing cycle for a contract and bill the
customer when they want to be billed. Oracle Service Contracts can calculate the
amounts for each period and execute them through an invoicing system, such as Oracle
Receivables.

In addition to billing for services, contract billing is able to support flexible usage (or
meter) billing based upon minimum usage, defaults, AMCV, and estimation.

This topic group consists of the following:

• Billing for Contracts, page 2-93

Billing for Services, page 2-96

Automatic Service Program Billing, page 2-97

Summary Billing, page 2-97

Bill Settlement, page 2-97

Bill Termination, page 2-98

Service Settlement, page 2-100

Executing Main Billing, page 2-101

Commitment and Credit Card Billing Methods, page 2-104

Billing for Contracts
Billing for Contracts enables you to define billing schedules with one-time or recurring
billing in Oracle Service Contracts. Billing can be defined for Advanced or Arrears
invoicing. Invoice Date for a billing period can be adjusted, as well as the date that the
billing period interfaces to Oracle Receivables. Recurring billing can be defined with
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equal amounts defined for each billing period in the billing schedule, with user-defined
amounts for each billing period in the billing schedule, or a combination of user-defined
and calculated amounts for billing periods in the billing schedule.

For example, suppose you create a $10,000 service agreement for a customer starting
from April 1, 2004 to March 31, 2005. The customer wants to pay monthly on the first of
every month. The billing schedule can be set up so the amount of the first bill is $1,000
for the payment on April 1, 2004, and prorate the balance evenly over the remaining
months. It then sends the calculated amounts to Oracle Receivables for invoices to
be processed. The bill dates do not necessarily need to be the same every month or
even on regular intervals. You can offer the customer no payments the first month (or
any point in the contract) and schedule the subsequent billing dates and amounts
for anytime you choose.

In addition to interfacing billing transactions to Oracle Receivables, you can send the
billing transactions to special “preview” tables. From these tables, you can create custom
reports that reflect the information that is used in your customer invoices. This allows
you to see the information that the customer will see on their invoice before billing is
run. If there are any problems with the billing information, it can be corrected easily in
the contract before it is interfaced with Oracle Receivables.

To stop a contract from being billed as a result of finding errors on the pre-invoice
process, the status of the contract should be set to one where the operation Invoicing
Allowed is not selected. After corrections have been made, the status of the contract
should be changed to one that allows invoicing to occur.

Using Advance and Arrears Billing Schedules

The Invoicing Rule and the Payment Terms on a contract are interfaced to Oracle
Receivables when the contract is billed. The Invoicing Rule determines when the invoice
is sent to the customer and when to record (post) the receivable amount on the invoice.

If Advance, the earliest accounting rule start date is used as the invoice GL date.

If Arrears, the latest accounting rule start date is used as the invoice GL date.

The Invoicing Rule is not used to determine the date for sending records from Oracle
Service Contracts to Oracle Receivables. The billing schedule in a contract determines
the frequency and timing for interfacing billing records to Oracle Receivables. The
Interface Dates shown in the billing schedule indicate when a billing period is scheduled
to interface and the Invoice Date indicates when the billing period will invoice to the
customer. The Interface and Invoice dates in the schedule can be adjusted using the
Invoice Offset and Interface Offset fields when defining billing streams. Entering a
negative invoice offset results in earlier invoice date. Entering a positive invoice offset
delays the invoice date for the billing period. A negative Invoice Offset also results in
an earlier interface date in the billing schedule. The reason is, the billing period must
interface to Oracle Receivables early in order to Print the invoice early.

In a situation where the billing program is run later than the scheduled Invoice date, the
invoice date will be set to the current date. When the invoice date is in the future, this
date will remain unchanged when interfaced to AR. The Service Contracts Main Billing
program sends the invoice dates to AR Interface Tables for both Advance and Arrears
billed contracts. However, for Advanced Billed contracts you can use the Invoice Offset
field to adjust the invoice date.

The following table shows an example of a billing schedule when the billing program
is run after the start of a contract and has to catch up billing for the first few billing
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periods. The contract effective dates are 01/01/03 to 12/31/03 and are to be billed
monthly.

Today is 03/15/04 and the default date that is entered when running the billing program
is 04/01/04. The first 3 months that should have already been billed would have their
invoice date set to 03/15/04 since their original invoice date is in the past. The fourth
month has an invoice date of 04/01/04, which is later than today’s date, but since the
default date when running the billing program is 04/01/04, then the invoice for April
would also be sent to Accounts Receivable, with an invoice date of 04/01/04. The
Interface Date will default to the Bill From Date unless adjusted using the offsets. This
means that the billing transaction is eligible to be sent to AR on or after the first day of
the billing period.

Invoicing Rule - Advance Invoice

Invoice Date Bill From Bill To Interface Date

03/15/04 01/01/04 01/31/04 01/01/04

03/15/04 02/01/04 02/28/04 02/01/04

03/15/04 03/01/04 03/31/04 03/01/04

04/01/04 04/01/04 04/30/04 04/01/04

05/01/04 05/01/04 05/31/04 05/01/04

06/01/04 06/01/04 06/30/04 06/01/04

07/01/04 07/01/04 07/31/04 07/01/04

08/01/04 08/01/04 08/31/04 08/01/04

09/01/04 09/01/04 09/30/04 09/01/04

10/01/04 10/01/04 10/31/04 10/01/04

11/01/04 11/01/04 11/30/04 11/01/04

12/01/04 12/01/04 12/31/04 12/01/04

For the Arrears Invoicing Rule, the Invoice Date defaults to the Bill To Date unless
adjusted using the offsets. The Interface Date will default to the Bill To date plus one
day. This means that the transaction is eligible to be sent to AR the day after the billing
period ends.

The following table shows an example of a billing schedule for arrears.
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Invoicing Rule - Arrears Invoice

Invoice Date Bill From Bill To Interface Date

01/31/04 01/01/04 01/31/04 02/01/04

02/28/04 02/01/04 02/28/04 03/01/04

03/31/04 03/01/04 03/31/04 04/01/04

04/30/04 04/01/04 04/30/04 05/01/04

05/31/04 05/01/04 05/31/04 06/01/04

06/30/04 06/01/04 06/30/04 07/01/04

07/31/04 07/01/04 07/31/04 08/01/04

08/31/04 08/01/04 08/31/04 09/01/04

09/30/04 09/01/04 09/30/04 10/01/04

10/31/04 10/01/04 10/31/04 11/01/04

11/30/04 11/01/04 11/30/04 12/01/04

12/31/04 12/01/04 12/31/04 01/01/05

Revenue Tracking in Oracle Receivables

In order for all earned, unearned, or unbilled revenue for the contract to be visible in
Oracle Receivables, all billing transactions for the contract should be interfaced to
AR. Postings need to be made into the correct period.

To meet this requirement, the Bill From date on the contract billing schedule will become
the invoice rule start date, which will take the accounting rule into consideration and
will determine the date for the transaction. If it is required that all bills are interfaced at
the start of the contract, when running the Service Contracts Main Billing program, the
default date parameter should be set far enough in advance to pick up all bills for
the contract.

Billing for Services
The Service Coverage defined for a service contract determines the exact amount to be
charged to a customer for services provided.

For example, suppose you have created a 9-to-5, 100 percent material coverage, and you
define a 10 percent discount on labor. When a service technician replaces parts for
a customer, the customer is charged only for labor with a 10 percent discount. The
customer is not charged for parts replaced.

The entitlement engine determines the coverage for each billing line based on the
combination of type of billing transaction and the billing type associated with the part on
the line. It applies the pricing, discounts, and other parameters defined in the contract
for each billing line to derive the actual price to be billed as per the contract.
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Automatic Service Program Billing
Customers can automatically be billed for extended warranties they purchase. Oracle
Order Management uses Oracle Receivables, through the Receivables Interface, to create
invoices for service programs on sales orders. In this case, the service programs are
extended warranties. Billing can be done either in advance or in arrears using Oracle
Receivables invoicing rules. Upon renewal of the extended warranty, billing occurs in
Oracle Service Contracts as described in the Billing for Contracts section.

Summary Billing
Oracle Service Contracts provides the option to summarize billing lines for interface
to Oracle Receivables. When the Summary Transaction check box is selected for a
contract, billing for contract sublines will be consolidated under each service line
according to subline start and end dates.

Bill Settlement
It may be necessary to settle the billing with customers because of usage limits, fixed
usage billing, or termination. Settlement billing creates an invoice or credit memo based
on the difference between the actual readings and what was billed.

The following diagram illustrates how the Service Contract Billing engine calculates
the billing amount. Regardless of the line type, billing details are calculated and
stored. When the invoices are ready to be generated and sent to Oracle Receivables, the
customer billing profile is accessed to determine if summarized or detailed billing is
to occur.
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Oracle Service Contracts Billing Engine

Bill Termination
The following diagram shows the process flow for bill termination.

A customer can choose to terminate a whole contract or individual contract lines (service
or usage) or sublines. The termination of contract lines can be post dated (Services
only) or future dated. When service lines are terminated post dated, the customer can
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be credited as needed for any overpayment. When service lines are terminated future
dated, billing schedules are updated to reflect the appropriate end dates.

Process Flow for Bill Termination
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Service Settlement
Service settlement is based on whether a service or usage line is to be settled and involves
the generation of a credit memo or invoice depending on the time frame in which the
service is terminated. Settlement of a service line type is straightforward. On the other
hand, settlement for a usage line type is based on attributes that are set up for usage lines.

The following diagram highlights the logic for determining the amount of the settlement:

Service Settlement
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Executing Main Billing
Billing Execution procedures consist of the following topics:

• Overview, page 2-101

Running the Billing Program, page 2-102

Running the Fetch AR Program, page 2-103

Running Usage Averaging and Settlement Program, page 2-103

Overview
The procedures for executing service contract billing involves the following concurrent
requests:

• Service Contracts Main Billing: Detailed transactions are generated in billing
interface tables based on:

• Attributes set up in the contract and billing schedule

• Setup of Interface Price Break option in the Global Contracts Defaults form,
page 3-52.

• AutoInvoice Import Program: The billing transactions are then imported into Oracle
Receivables.

• Service Contracts Fetch Receivables Info for Billing. This concurrent request fetches
the invoice number and tax from Oracle Receivables and updates the contract billing
history. This information is displayed in the contract’s billing history.

Depending on the usage type, the following occurs when Service Contracts Main Billing
is executed:

• For Fixed and Negotiated Price usage types, billing may be submitted without any
counter updates. The actual invoice amount is based on the fixed counter value or
the negotiated price defined on the contract.

• For Actual by Quantity, the counter reading should be updated prior to any billing
using price breaks.

• For Actual per Period.

• If a counter reading has not been taken, Service Contracts Main Billing uses a
default counter value defined on the contract to determine the invoice amount. If
AMCV is set and the prerequisite billing periods have passed, the invoice
amount is the average over the defined interval, if not, it is the default.

• If the counter is updated and it is less than the minimum, the invoice amount is
the minimum counter value; otherwise it is the actual counter reading using
price breaks (also applies to Actual by Quantity).

• If the customer is billed for the minimum, the consumption is calculated without
regard to the previous under-usage. The usage calculation for each billing
period should be independent. That is, if the minimum usage is not used, then
the customer loses the consumption shortfall.

• If one or more billing periods have passed without any counter updates, the
Settlement concurrent request should be run after the counter is
updated. Settlement compensates or makes up for the estimated invoice value
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for each period after the counter readings have been taken for each period. This
is displayed as another line in the billing history.

Prerequisites

You must define the following:

• Transaction Types (Oracle Receivables) - Invoice and Credit memo

• Batch Source (Oracle Receivables)

• Grouping Rules (optional) (Oracle Receivables)

• Applicable usage items must be included on an active price list (Oracle Advanced
Pricing)

• Party and customer accounts and contacts must be defined (TCA)

• If Billing profiles are to be used they must be defined, for example, bill to
address, summarized billing, billing frequency, advanced or arrears billing

Running the Billing Program
Use this procedure to run the Billing program.

To run the Billing program:
1. In the Navigator, choose Control > Requests > Run. The Submit New Request

window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Request region, select Service Contracts Main Billing.

4. In the Parameters window, specify one or more of the following:

• Contract Number: Enter the numbers of the contracts to be billed.

• Default Date: Enter the date you want as the default. (The default offered is
the system date on your computer.)

• Organization Id.: Enter the organization id for which all the contracts
are to be billed.

• Customer Name: Enter the name of the customer for which all the contracts
are to be billed.

• Category: Enter the category for which all the contracts are to be billed.

• Group: Enter the name of the group for which all the contracts are to be
billed.

• Preview: Change this option to yes if you wish to send these transactions to
special preview tables. Leave it at no if you want the transactions interfaced
to Accounts Receivable.

5. Click OK.

6. In the Submit Request window, click Submit Request.

The billing program sends the invoice amount to Oracle Receivables, which then
generates the invoice. The process also populates some billing transaction history
information in the History tab of the Billing Schedule. Since the invoice number

2-102 Oracle Service Contracts Concepts and Procedures



is assigned and tax calculated by Oracle Receivables neither of these pieces of
information could be populated until after the Service Contracts Fetch Receivables
Info for Billing program is run. The tax amount will be left blank and the invoice
number will be populated with -99.

References

For more information on invoicing, see the Oracle Receivables User’s Guide.

Running the Fetch AR Program
The Service Contracts Fetch Receivables Info for the Billing program retrieves the
invoice number and tax amount from AR and updates the contract’s billing history
accordingly. The tax amount is nonzero if tax is “required” in the contract.

Prerequisites
In Oracle Receivables, run the AutoInvoice Import program to generate the
invoicing. The user who runs AutoInvoice must have the profile option AR: Define
Document Sequences set to Partially Used at either the user level or at the responsibility
level.

To run the AutoInvoice program:
1. From the Navigator, choose: Other > Control > Requests > Run. The Submit a

New Request window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Name field, select Fetch Receivables Info for Billing.

4. Click OK.

5. In the Submit Request window, click Submit Request. This updates the invoicing
information in the customer’s contract.

Running Usage Averaging and Settlement for Billing Program
Use this procedure to run the Usage Averaging and Settlement for Billing program.

To run the program:
1. In the Navigator, choose: Other > Submit Requests. The Submit New Request

window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Name field, select Usage Averaging and Settlement for Billing.

4. In the Parameters window, enter the number of the contract. If you leave this
field blank, all contracts will be used.

5. Click OK.

6. In the Submit Request window, click Submit Request.
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Commitment and Credit Card Billing Methods
Oracle Service Contracts integrates with Oracle Receivables to support multiple billing
methods including Prepayment (commitment) and Credit Card.

When entering the billing terms for a contract, you can select a method of payment from
a list of values. If the Credit Card method is selected, the authoring process mandates the
entry of credit card information such as credit card number, and credit card expiration
date. If you select the Commitment method, then the Authoring process requires the
entry of a commitment number. Customer commitments must be set up in Oracle
Receivables prior to use as a method of payment in Oracle Service Contracts.

Reviewing Entitlements
Along with the usual functionality of checking entitlements, for example, finding out if
a customer is calling during his coverage hours, or to find the agreed reaction time, a
separate component of Oracle Service Contracts allows other applications to view the
coverage for a particular contract.

Entitlement information is made available to any application that requests it such
as, Oracle TeleService, Field Service, Install Base, and Depot Repair.

Sharing Contract Information
Oracle Service Contracts provides detailed contract information through other Oracle
applications:

• Customer Support

• Contract details for a given customer such as account, end date, status, contract
type, and contract number

• Retrieval of all active, terminated, and expired contracts for a given customer

• Preferred, primary, and excluded engineers for a service

• Coverage time for a service request or customer call

• Coverage levels associated with a service

• Reaction and resolution times for coverage

• Billing rate for a specified coverage

• Material, labor, and expense Billing types

• Retrieves the list of contract lines with Preventive Maintenance program
attached and an existing schedule

• Retrieves preventive maintenance schedules for a contract line

• Retrieves the confirmation flag for a contract line

• Field Service

• Preferred, primary, and excluded engineers for a service

• Install Base

• Contract details for a given customer such as account, end date, status, contract
type, contract number
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• Usage items may be tracked by one or more counters

• Billing rate for a specified coverage

• Billing types: material, labor or expense

• Depot Repair

• Details for repairs, exchanges, replacements, and loaners

• Charges

• Details for billing types and billing rates (when applicable, billing rates apply to
labor)

• Advanced Service Online

• History and activities of any Preventative Maintenance program

Overview of Entitlements Processing
Once a contract is in effect, entitlement information for a customer is shared
automatically, based on the customer’s contract, and shows the amount to be billed
after service has been delivered.

Entitlement processing refers to the services that the customer is entitled to once the
contract is in effect. The entitlements cover the following:

• Checking for service overlaps

• Performing discount calculations

• Checking for coverage details and reaction times

• Applying requisite billing rates

The entitlements are defined in the Service Contracts window and are automatically
enforced through Oracle Support. The discounts and reaction times are defined in the
coverage window in Oracle Service Contracts. For every business process that is covered
in the contract you can define coverage times and reaction times. For example, an
onsite preventative maintenance transaction could be part of a 9-to-5 service, with 5
percent material covered in the service. The coverage times for an onsite preventive
maintenance service can be 9-to-5, five days a week, with a reaction time of two hours
for a high severity call. If a high priority call comes in at 10:00 A.M., then the service
request window would automatically calculate 12:00 P.M. as the time by which the
call needs to be resolved.

Similarly, the discounts that are defined in a contract are automatically applied in the
service request Charges window that the customer service is delivered. Therefore, the
onsite preventive maintenance service includes a replacement of parts transaction type
and an upgrade of part transaction type. Once you have the necessary entitlements
defined in the service contract, you can associate the contract with the service request
and have the charges and discounts applied to the service that is being rendered

Oracle Service Contracts determines the entitlement of a customer automatically. It
accomplishes the following:

• Entitlement processing is integrated with service requests and determines
deliverables, time frames, and coverage available for the product and serial number
listed on the service request window. The entitlements also determine performance
guidelines to be followed such as a 2-hour reaction time, whether specified parts are
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included, and whether service is covered between specified hours. More detailed
information regarding a contract is available through a drill down on the contract
coverage in the service request.

• In Oracle Depot Repair, contract entitlements deal with repairs, exchanges,
replacements, loaners, and returns from customers.

• In Charges billing, the entitlement engine determines the coverage for each line based
on the combination of type of billing transaction and the billing type associated with
the part on the line. It applies the pricing, discounts, and other parameters defined
in the contract for each Charges billing line to derive the actual price to be billed.

Entitlements Search
You can use the Entitlements Search window to search for all contracts that match your
search criteria, or limit the search to Entitled contracts. You can search for contracts
based on their covered levels attributes such as Product Name, and Item Name.

The Entitlements Search window includes the following regions:

• Search Option region: In this region you can select one of the following options:

• All Contracts: Select the All Contracts radio button, if you want to search for all
contracts that match your search criteria.

• Entitled Contracts: Select this option, if you want to search only for the entitled
contracts. If this option is selected, at least one covered level must be selected
prior to performing the search.

• Contract Covered Levels region: The Contract Covered Levels region allows
selection of all six types of covered levels, with appropriate attributes for every
level. The following table displays the covered levels and their attributes:

Covered Level Attribute 1 Attribute 2 Attribute 3

Product Product Name Serial Number Reference Number

Item Item Name Item Description -

Site Site Name Site Number -

System System Name System Number -

Customer Account Account Name Account Number -

Party Party Name Party Number -

• Contracts Additional Search region: If you select any search option from the Contract
Covered Levels region, this region will act as a filtering criteria, otherwise the
contract lines are retrieved based on the search criteria you enter in this region. The
following attributes are available in this region:

• Line Attributes: Service Name, Status, Renewal Type, Coverage Type, Bill To
Address, Ship To Address, Start Date range, and End Date range.
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• Header Attributes: Contract Number, Status, Renewal Type, Postal Code, Party
(Party role as Customer), Contract Group, Start Date range, End Date range, and
Date Terminated range.

After entering your search criteria, click the Search button. The search results are
displayed in the Results form. The Results window displays details of the contract lines
that match the search criteria:

• Contract unique identification (number and modifier) and description

• Contract line number

• Line type (for example, Service)

• Item name (for example, name of the service program)

• Line start and end dates

• Status of the line (for example, Active)

• Coverage name

In addition, in the Results window you have access to:

• View Coverage button: Select a contract line and click the View Coverage button to
open the Coverage form in read-only mode.

• Open button: Select a contract line and click the Open button to display:

• The Authoring window of Oracle Service Contracts. From the Authoring
window, you can manually adjust Warranty Start and End dates on , page
2-107installed products.

• Line Detail window (in read-only mode). When entitlements search is used by
any application other than Service Contracts (for example, when it is used by a
Customer Care agent in Oracle TeleService).

To adjust start and end dates for warranties:

The steps for adjusting the start and end dates for a warranty line are:

1. From the Result window, select a Warranty line.

2. Click Open to display the Authoring window.

3. Select the Cascade Attribute option from the Actions menu. The system displays the
Cascade Attribute window. In the Cascade Attribute window, all header attributes
are grayed out, except the Date attribute.

4. Saving Warranty Dates and Cascading from Header to Lines: You can change the
Start Date and End Date fields in Header and Lines regions. At this time, you can
update the Warranty Header and Lines dates. If a Line check box is not selected and
you click the Save button, the Header and Lines Dates will be saved as entered. If
any Line check box is selected, and you click the Submit button, the Header dates
are cascaded to those selected lines.

5. Saving Warranty Dates and Cascading from Lines to Sublines: Cascading from Lines
to Sublines option opens a similar window with Start Date and End Date in enable
mode. You can change the Start Date and End Date for the selected Sublines. If a
Line check box is not selected and you click the Save button, the Header and Lines
Dates are saved as entered. If any Line check box is selected, and you click the
Submit button, the header dates are cascaded to those selected sublines.
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Adjusting dates can also be done from Oracle Install Base. This is based on the
Synchronize Date Installed check box of the coverage associated with the install
base item.

Update Quantity initiated from Install Base, will update the warranty covered
levels quantities accordingly.

Managing Contracts
After the contract authoring process is complete, the contract will need to be managed
during its life cycle. Changes may have to be made to the coverage, duration, and so
on. This section describes some of the Contract Management features that can be used to
help streamline and control this administrative process.

Contract Management consists of the following tasks:

• Editing a Contract, page 2-108

Finding a Contract, page 2-109

Cascade Service Price, page 2-110

Contract Renewal, page 2-110

Termination Procedures, page 2-118

Extending a Contract Line, page 2-120

Grace Period, page 2-121

Mass Change, page 2-121

Reassigning Resources, page 2-127

Reporting, page 2-128

Editing a Contract

Handling Change Requests

A contract may be set to a status that does not allow changes to be made online through
the authoring form, but does allow changes through a change request. This provides
more control over tracking the changes made to a contract through its life cycle.

If the Active status does not allow “online updates’’, then any changes to the contract
would have to go through the change request process. Once a change request has been
approved, a notification is sent to the Contract Administrator. From the Inbox, the
contract may then be opened for update. (Note that in this instance the Open for
Update button is not visible in the contract itself.) After the contract updates have been
completed, the contract is run through the QA Check and if everything passes, the
contract status is set back to Active.

See the Oracle Contracts Core User Guide for the steps describing entering, approving, and
closing change requests.

Open for Update Button

This button is used to allow updates to a given contract and is applicable to contracts
having the status Active. If this status allows “online updates,” the Open for Update
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button is enabled. If other users try to access the same contract, they will be able to
display the contract, but unable to do any updates as the Open for Update button will
be disabled. For the selected contract, clicking the Open for Update button will set the
contract status to QA Hold. After the updates are completed, for example, pricing, billing
attributes or adding a new service line, select Check QA from the Actions menu to run
the quality assurance check. If it passes, hit cancel and the status will be set back to
Active when the QA window closes. Since the contract has already been approved and
signed, it is not necessary to Submit for Approval a second time.

Warranty contracts may not be updated using Open for Update. Extended Warranty and
Service Agreement contracts may be edited; however, the portion of the contract that
has already billed (whether via Oracle Service Contracts or Oracle Order Management)
may not be altered. A billed line may have new sublines added to it, but the billing
stream applied (periods, uom/period, uom) will be identical to the billing stream
under which the line has previously been billed. If a new line is entered, a new billing
stream is entered and may be different than the billing stream on any lines that have
been previously billed.

If, during the Open for Update action, lines have been added (which are technically in an
Entered state) those lines can be deleted without having to revert any other changes
as well. Since entered lines can be deleted from an Entered status contract, the same
behavior will apply to the new lines on a contract in QA Hold.

Revert Update

After a contract has been approved, the contract may be opened for update through the
Open for Update button. A series of updates (on multiple occasions) may be performed
on this contract. At any point, Revert Update will “undo” all the updates. However, once
the contract is has been through the QA check and is set back to Active status, it is not
possible to “undo” changes that were made prior to the QA Check. In other words, the
Revert Update feature is available only while the contract is QA Hold status.

Finding a Contract
To help in locating a contract or a template, Oracle Service Contracts provides a search
window. Use the Search Templates and Contracts window to enter your search criteria
and execute the search. When the search is completed, a list of contracts that match your
search criteria appear in the Results region. Select the contract and right click to open it.

To find a contract:
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window

appears.

2. From the View menu, select Find. The Search Templates and Contracts window
appears.

3. Enter your search criteria.

4. If applicable, click the More button. The More button provides an enhanced search
criteria for finding contracts. The button is activated when a Service Contract
category is selected as one of the search criteria. When you click the More button, the
system displays the Service Module Search window. This window provides the
ability to search on specific attributes for service contracts. Searchable fields are:

• Agreement Name

Using Oracle Service Contracts 2-109



• Date Signed

• Order Number

• Bill to Address

• Organization

• Contact e-mail

Cascading Service Price
The Cascade Service Price window is accessed from the Actions menu and is used to
cascade the service line price to the covered level prices at the same proportions. The
Cascade Service Price function is not available for Subscription lines.

For example in the table below, the current service line price is $2,000 and in this case, the
percentage of the service price applied to lines L1 & L2 is 75% and 25% respectively. The
same proportions are cascaded to the lines if $4,000 is applied.

Current New

S1 $2000 $4000

L1 $1500 $3000

L2 $500 $1000

To cascade the service price:
1. Select the contract line to which you want to make a price change.

2. From the Authoring window navigate to Actions > Cascade Service Price.

3. Review Service, Start Date, End Date, and Current Price fields. These are
display-only fields.

4. Enter the New Price that is to be allocated across the sublines.

5. Click Apply to save. The new price is cascaded in the appropriate proportions to
the final price of each covered level.

6. Refresh the billing schedule to reflect the new values.

Renewing Contract

Contract Renewal

The process of renewing a contract involves making a copy of an existing, active contract
as of a point in time. The dates are changed to reflect a period of time similar to the
existing contract; beginning on the first day after the existing contract expires. Other
attributes of the new contract may also be changed such as pricing. Because there may
be an overlap between the time the existing contract creates the renewal contract and the
time the renewal contract goes into effect, be aware that changes to the existing contract
will not update the renewal contract. For example, if a contract is renewed 90 days prior
to expiration and the customer requests changes to their existing contract 15 days after
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the renewal process has begun, the changes made to the existing contract will not
be reflected on the renewed agreement.

Note: When renewing a Subscription type contract:

• A new instance is NOT created in Install Base and the new contract continues to
cover the same parent item. However, if you use the Copy function to create a new
Subscription contract, a new instance is created in Install Base.

• The Fulfillment schedule is copied to the new contract.

Renewal and pricing attributes may be entered in the individual contracts and apply to
all contract categories. If not specified in contract, the renewal and pricing attributes
are retrieved from the renewal event or from the Global Contracts Defaults in the
following order of precedence:

• Event

• Party

• Organization

• Global

Some of the renewal information is held in profile options, which determine what
information will be obtained from the profile option settings upon contract renewal.

Setting the profile option OKS: Enable Sales Credits to Retain, will result in sales credits
from the prior contract being carried forward to the renewal contract.

By setting the profile option OKS: Enable Sales Credits to Derive, the system will use the
following profile options to derive a sales person for the renewal agreement:

• OKS: Use Territories to Default Sales Person: if set to Yes, sales person will be
derived from Territory Setup. If set to No, then Service contracts looks to the value
entered in OKS: Sales person to derive the vendor contact/sales person.

OKS: Sales Person: If OKS: Use Territories to Default Sales Person is set to No, this
profile determines the sales person for the Sales Credit form and for the vendor
contact on the contract summary. If OKS: Use Territories to Default Sales Person is
set to No, and you do not set a value for OKS: Sales Person, the contract will fail to
renew and instead produce an error message. You may manually add additional
sales people to the Sales Credits form after the renewal agreement has been created.

OKS: Revenue Type Distribution for Sales Credit - assigns the percentage of
revenue to the sales person whose name was determined by the Sales Person or Use
JTF profile options. Sales Credits must total 100% in order to pass the QA check. If
you add additional sales people to the Sales Credits form, remember to distribute
revenue to them until the total is 100%.

OKS: Revenue Type for Sales Credits - indicate whether this revenue is quota or
non-quota for the sales person that was defaulted.

OKS: Vendor Contact - adds a vendor contact role to the renewal agreement. This
information is in addition to copying any vendor contact roles and names
that are on the original contract. Ideally, you should set this profile option to
salesperson, however that is not required. The vendor contact name that will
populate this role is the person who is identified by the JTF territory assignment if
OKS: Use Territories to Default Sales Person is set to yes, or will be the salesperson
specified in the Sales Person profile option.
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If Enable Sales Credits is set to Drop, the information from these profile options is not
included in the renewal agreement nor is it copied from the original contract. No sales
credit information will default to the renewal agreement; it would be entered manually.

Contract renewal consists of the following topics:

• Renewal Types, page 2-112

• Renewal Procedures, page 2-112

• Renewal Consolidation, page 2-116

Renewal Types

Renewal types have been added so that the renewed contract isn’t automatically
defaulted to the Entered status, requiring it to go through approval again. You can set
the renewal type on the Administration tab at the header to be one of four options:

• Do Not Renew

• Active Contract

• Notify Salesrep

• Submit for Approval

• Electronic Renewal

The Do Not Renew option prevents the contract from being renewed.

Active Contract allows the contract to be renewed automatically and put straight to
Active, no approval required, no human intervention, this is called Evergreen.

Notify Salesrep places the renewed contract into entered status and sends a notification
to the sales representative who then must review it, make any necessary changes and
submit it for approval.

Submit for Approval, creates a contract in entered status, automatically submits it for
approval and sends a notification to the sales representative.

Electronic Renewal places the renewed contract into entered status and sends a
notification to both the sales representative and the customer. The customer receives
notification in the form of an e-mail with a link to a web page where customer can review
the quote and accept, reject, or request changes to the contract renewal.

Independent Conditions can be used to set the contract to auto renew a certain number
of days prior to contract expiration. This period of time can be used to negotiate the
terms of the contract and administer any required changes prior to the start date of
the new contract. For setting up an Independent Condition, see Defining Condition
Templates in the Oracle Contracts Core Implementation Guide.

Using Renewal Procedures
Once a contract has been renewed, use the processes below to prepare it for approval
when necessary:

• Verifying Party Information, page 2-113

• Repricing a Contract, page 2-113

• Reviewing Renewal and Administration Rules, page 2-113

• Defining Security Attributes, page 2-114
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• Determining Line Duration, page 2-114

• Reviewing Pricing Attributes, page 2-115

Verifying Party Information

Before the renewed contract can be approved, changes may need to be made to the
parties or contacts. Refer to Summary Parties Tab , page 2-39for more details.

Repricing a Contract
Repricing normally occurs at renewal but it is also possible to reprice a contract at
contract line or covered product level at any time. It could be based on a new price list
or on a price list in another currency. In the case of repricing in another currency, this
can be done on condition that no previous billing has been executed for the current
duration of the contract.

To reprice a contract:
1. Navigate to the Summary > Pricing/Billing.

2. If appropriate, select a new Price List from the list.

3. If multi-currency repricing is desired, enter the currency code of the price list in the
header context region.

4. Click Reprice. All service lines are repriced in the new currency and the contract
total is displayed in the header context region.

5. Save your work.

Reviewing Renewal and Administration Rules
Repricing rules may be specified at the time the order is created in Order
Management. However, if this is not the case, the renewal event may specify renewal and
administration rules, or they may be retrieved from the Global Contracts Defaults. These
rules are retrieved in the following order of precedence: party, organization, and
global. If a specific rule is not found at a given level, it is retrieved at the subsequent level
and ultimately at the global level if they do not exist in the other levels. In any case, the
renewed contract would have all the elements required for renewal and repricing and
submit the contract for approval.

To review renewal and administration rules:
1. Navigate to the Summary (T) Administration.

2. Select or validate the appropriate Quality Assurance Checklist from the list of values.

3. Select or validate the appropriate Contract Groups.

4. Select or validate the Process Type Workflow Name, and Workflow Process.

5. Navigate to the Summary (T) Renewal.

6. Select or validate the appropriate Renewal Type from the list of values.

7. Select or validate the appropriate Pricing Method from the list of values.
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8. If the Pricing Method is Price List or Markup Percent, validate the Price List by
selecting the appropriate Price List from the list of values.

9. If the pricing method is Markup Percent, validate the Markup by entering the
appropriate percent.

10. The PO Required check box may be selected from the renewal event or
party, organization or global levels. If selected, the PO Number field is
mandatory. Enter the corresponding PO number.

11. Save your work.

Defining Security Attributes

To define security attributes:
1. Navigate to the Summary > Security/Text.

2. Select the security type from the drop down list. The valid values are:

• Group: This specifies contract group security

• User: This specifies user security

3. Select the Group or User Name from the list of values, depending on the security
type.

4. Access to view a contract cannot be restricted. Access to modify a contract is granted
to the user who meets any one of the following criteria:

• The user is granted the Modify access in the Security tab of the contract.

• The user is part of a group that was granted the Modify access in the
Security tab of the contract.

• The user logged into a responsibility that has been granted the Modify
access for the contract category.

5. Select the security level appropriate to the security type. The contract offers
modify access to any user whose responsibility allows them modify access to the
application. You can reduce their access by restricting them to read-only for this
particular contract. Once you enter information in this security field, only the
users you name can access the agreement and only with the level of security you
indicate. If a user has read-only access to the application, granting them modify
access to a specific contract will give not them access to make changes to the
agreement. So these security attributes serve only to restrict access further, not to
grant any additional access. The valid values are:

• Modify: This allows update access to the given contract.

• Read Only: This allows read-only access to the given contract.

6. Save your changes.

Determining Line Duration
Previously, a single order translated into a single service contract. However, with the
ability to enter contract details in Oracle Order Management, it is possible to merge any
order line to an existing contract or to the contract on the current order. If a service
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contract has been interfaced through Oracle Order Management, the field Order / Line
number is populated at the service line level on Lines/Accounts tab. If the service
contract is created manually, this field is disabled.

If customer contacts are entered for the given service line, the address is automatically
displayed for the corresponding customer contact.

With the ability to merge an order line to an existing contract, the order line duration
in most cases would be shorter than the contract duration. In order to facilitate
contract renewal, all the service lines coterminate. In addition, a new line attribute
has been added to determine the line duration at the time of renewal. This attribute
would normally be automatically initialized from OM in the Contract Details window;
however, it may be manually changed during the renewal review.

To determine the line duration:
1. Navigate to Lines > Effectivities.

2. If the line duration requires changing, select a Duration from the list of values. The
valid values are:

• Full Duration: At renewal time, the service line would inherit the duration
of the contract.

• Keep Duration: At renewal time, the service line duration would remain the
same but would coterminate with the contract header.

• Do Not Renew: The service line cannot be renewed.

3. Enter Invoice Text. Invoice text may be entered for the invoice imported to
Oracle Receivables. By default, the invoice text is the same as the product
description. However, any free text may be entered in this field where there is no
validation.

Both attributes are also found at the subline level.

Reviewing Pricing Attributes
The upper portion of the Pricing and Products tab includes the pricing attributes for
the previous contract. If this is the initial contract, the last contract price and currency
would be null. If this is a renewed contract, the renewal event would have populated
last contract price and currency. The Final Price is the sum of all the sublines. All three
fields are display-only fields.

To review the pricing attributes:
1. Navigate to the Lines > Pricing/Products > Effectivities.

2. Review the Renewal Type and Invoice Text.

3. Navigate to the Pricing tab.

4. Review the last contract price and currency. Similarly to the upper half of this
tab, the renewal event would populate these fields, but they are null if this is the
initial contract.
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Renewal Consolidation
Renewing service contracts is an important part of any service business. Each contract
up for renewal represents an opportunity for revenue that should be easier to obtain
than a new sale.

Renewing service contracts can be complicated because some organizations will always
sell a full duration service contract the first time, resulting in a single customer having
numerous contracts expiring at different times over the course of a year. This requires
the customer be contacted multiple times per year for renewal confirmation and perhaps
renegotiation. This increases the workload for renewal.

Renewal Consolidation addresses the problem of multiple contracts expiring during a
year (or other given period) causing multiple renewals. With Renewal Consolidation, all
the contracts to be renewed over a given period are consolidated into a single renewal
contract.

Renewal Consolidation has several benefits:

• The number of renewal contracts is decreased, reducing workload and the
difficulties imposed by large numbers of contracts.

• Customer relationship is improved. All the customer’s services may be included
in a single contract, or several consolidated contracts based on how the contracts
are to be billed.

• It reduces the number of invoices sent to the customer.

Using Renewal Consolidation
The renewal consolidation process is initiated after a contract has been renewed, which
may have been the result of the renewal event where contracts are renewed in mass or
manually renewed from the Contract Navigator using the right mouse click. In both
cases the contract is in the Entered status and is considered the Target contract.

If a contract is not valid for consolidation, you will see the error message “Target contract
is invalid.” If the target contract is eligible for renewal consolidation, the Renewal
Consolidation window is displayed and is used to facilitate the selection of all the
“source” contracts for consolidation. The upper half of the window displays all the
details of the target contract. The lower half displays all the eligible source contracts in a
tree structure. The system will by default, automatically select all the source contracts for
consolidation and place a “**” next to the given source lines.

The following lines are displayed:

• Service lines

• Sublines or covered levels, for example, Party, Customer, Site, Product, Item, and
System

A contract is eligible as a source contract if the following are true:

• Customer account is the same as the target

• “End date plus one day” of the potential source contract must be prior to the
new, renewed target contract’s end date

• Potential source contract must be in Active or Expired status

When submitting the renewal consolidation, a concurrent request consolidates all of
the selected source lines into the target contract. If the services are the same on the
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source and target contracts, the covered levels of those services can be merged into
one contract line on the target contract.

Merging occurs if the following conditions are met:

• Target and source lines have the same:

• Service Item

• Organization ID

• Renewal Type

• Bill-To site

• Start and End Dates

In addition, setting the profile option OKS: Check Coverage Match, page 3-36 to
Yes, forces the renewal consolidation process to preserve differences in coverage.

The Check Coverage API compares each attribute of the coverage and stops as soon as
one difference is found. It returns the result to the renewal consolidation process. If the
coverages are the same, the sublines of the source contract are merged under the service
of the same name on the target contract. If the coverages are different, a new contract
line is created on the target contract for the service on the source contract.

The Check Coverage API checks the following attributes:

• Coverage Name

• Coverage Type

• Business Processes

• Preferred Resources

The start dates of the consolidated lines begin one day after the expiration of the
original source line and all the end dates coterminate with the target contract. When the
operation instance is reviewed at a later date, that is, after the concurrent request has
terminated normally, all the consolidated source lines are identified with “##”.

When the renewal consolidation or operation instance is created, a source line is eligible
for consolidation at that point in time. However, between the time it’s created and
the time it’s submitted, a given source line may have been renewed, whether it be by
consolidation in another operation instance or renewed manually. Therefore, at the time
of submission, the system verifies that the source is still eligible for consolidation. If not
eligible, Oracle Service Contracts excludes the source line from the consolidation.

If a source contract is deselected and the operation instance is submitted for renewal
consolidation, it may be selected at a later time for consolidation in the same target
contract as long as the target is still in “entered” status. If the target contract has
already been approved and activated, the contract may be consolidated as a source in
another target contract.

After consolidation has taken place, the target may be opened to verify that all the
source contracts have been consolidated successfully. The new terms and conditions
may then be reviewed with the customer. Once the customer agrees with its terms
and conditions, the contract may be submitted for approval and billed at the intervals
designated in the contract.
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To submit for renewal consolidation:
1. Navigate to Launch Contracts > Contract Navigator.

2. Select a target contract and perform right mouse click to select Renewal
Consolidation. The Renewal Consolidation window appears.

3. Click Query Source. If there are no contracts eligible as source contracts for the target
contract, the lower half of the window will remain empty.

4. To deselect a line, highlight the branch and click Deselect Line. If a branch with
child branches is deselected, all the child branches are also deselected. A single
child branch may be deselected, as required. If deselected, the source line(s) are no
longer identified with a “**”. You can reselect the Source lines by highlighting the
line and clicking the Select Line button.

5. Verify source lines are valid for consolidation.

6. If you want to save and retrieve the consolidation at a later review, click Save
(this will create an operation instance).

7. If you want to submit the Renewal Consolidation, click Submit. A concurrent
request id is immediately displayed.

8. Open the target contract and verify all source contracts have been consolidated
successfully.

9. Submit the contract for approval.

Termination

Generate Credit on Termination

While terminating a contract line or subline, if billing has been run in advance, a credit
would be generated and sent to AR at that point rather than waiting until the end of
the contract date. The credit would include the day that the contract is terminated
(the termination date).

For example, a customer has paid for ten days of service in advance (from January 1st to
January 10th), but informs you on January 6th that he wants to end the agreement. If you
terminate the contract on January 6th, the customer would be credited for 5 days (from
January 6th to January 10th).

After completing the Termination program, the termination date is displayed and the
status is changed to Terminated.

Contract Termination
Use the following procedures when terminating a contract.

To terminate a contract:
1. Navigate to Launch Contracts > Contract Navigator.

2. Select the contract(s) that you wish to terminate. Multi selects can be made using
shift-click, control-click with the mouse.

3. Select the Terminate option from the Tools menu to open the Terminate Contracts
window.
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4. In the Date field, enter the date of termination. The date can be in the past.

5. In the Reason field, select a termination reason from the list of values. The system
displays a description for the termination reason in the Description field.

6. If terminating multiple contracts, click the Preview button to enter additional
information regarding the individual contracts. For each contract, you can enter a
different termination date and reason.

7. Click the Review button to verify the information before completing the process.

8. If customer is due a credit for amounts paid prior to the termination date, the
amount is indicated.

9. Optionally, you can use the Override Amount field to override the calculated
amount. The amount entered for override cannot be negative or more than the
original credit. Entering zero in the Override field will not prevent a credit memo
from being generated; it will generate a credit memo for zero dollars.

10. If you want to issue a full credit during termination, check the Full Credit check
box. If you check the Full Credit check box, the Amount field displays the total
amount that was billed for the covered level, top line, or contract at the time
of termination.

11. If you do not want to generate any credit memo, check the Suppress Credit check box.

12. Click Terminate to complete the process.

Having terminated the contract(s), you can run the Main Billing program to generate
the necessary billing transactions as a result of the termination.

Terminating a Contract Line
Use the following procedures when terminating a contract line.

To terminate a contract line:
1. Navigate to Launch Contracts >Contract Navigator.

2. Select the contract that contains the line to terminate.

3. Double click the contract to open the Contract window.

4. Select the Overview tab. The lines of the contract are displayed in the lower of
this tabbed window.

5. Select the contract line(s) to terminate.

6. Right mouse click and select Terminate Line from the menu.

7. Enter a termination reason from the list of values. A description of the termination
reason will be displayed.

8. Click review to see the information before completing the process.

9. If customer is due a credit for amounts paid prior to the termination date, the
amount is indicated.

10. Optionally, you may override the calculated amount. The amount entered for
override cannot be negative and cannot be more than the original credit. Entering
zero in the override field will not prevent a credit memo from being generated; it
will generate a credit memo for zero dollars.
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11. If you do not wish to generate any credit memo, check the Suppress Credit check box.

12. Click Terminate to complete the process.

Having terminated the contract line(s), you can run the main billing program to
generate the necessary billing transactions as a result of the termination.

Terminating a Subline
Use the following procedures when terminating a subline:

To terminate a subline:
1. Navigate to Launch Contracts >Contract Navigator.

2. Select the contract in which the subline needs to be terminated.

3. Select the individual subline that needs to be terminated.

4. From the Tools menu, select Terminate Subline.

5. Select a termination reason from the list of values. A description of the termination
reason will be displayed.

6. Click review to see the information before completing the process.

7. If customer is due a credit for amounts paid prior to the termination date, the
amount is indicated.

8. Optionally, you may override the calculated amount. The amount entered for
override cannot be negative and cannot be more than the original credit. Entering
zero in the override field will not prevent a credit memo from being generated; it
will generate a credit memo for zero dollars.

9. If you do not wish to generate any credit memo, check the Suppress Credit check box.

10. Click Terminate to complete the process.

11. Save the contract and run billing.

Extending Contract Line
Anytime the dates of a contract header, line, or subline are changed, remember to
verify that amounts and billing schedules are updated or retained as appropriate for
the situation.

To extend a contract line:
1. Navigate to Launch Contracts >Contract Navigator.

2. Select the contract that contains the line that you wish to extend.

3. Double click the contract to open the Contract window.

4. Select the Overview tab. The lines of the contract are displayed in the lower portion
of this tab.

5. Right mouse click and select Extend Line from the menu.

6. Save your changes.
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Grace Period
When a contract is nearing the end date, or has already expired, it may be desirable to
provide a “grace period” so that service and entitlement may continue while progress is
made toward negotiating a renewal contract. The grace period is granted to the Active or
Expired contract, not the renewal contract being negotiated. The actual start and end
dates of the contract will be unaffected by the decision to add a grace period to the
contract. The billing schedule also remains unaffected.

You can use the Global Contracts Defaults form to set up a standard grace period for
the contracts that are renewed.

When an entitlement API is called, it will take into consideration whether a grace period
has been entered against the contract when calculating entitlement eligibility. Entitlement
is only extended for those contract lines and sublines that end on the same date as the
contract end date. For example:

Contract start date 01-JAN-2003 end date 31-DEC-2003

Service 1 start date 01-JAN-2003 end date 31-JAN-2003

Service 2 start date 01-JAN-2003 end date 31-DEC-2003

Service 3 start date 01-OCT-2003 end date 31-DEC-2003

The user updates the contract to add a Grace Period of 30 days, that is, up to
30-JAN-2004. Service 2 and Service 3 would be eligible for entitlement during the
extended period, but not Service 1.

The same logic applies to sublines and coverage terms. Only those items that end on
the same day as the contract end date are considered for coverage during the grace
period. As long as the business processes are eligible for entitlement, the original terms
associated with the business process (preferred engineer, coverage times, reaction
times, resolution times, and billing types) will continue through the extended period.

The grace period can be removed from the contract by the user either before the contract
expires (if the renewal agreement is completed in time) or during the grace period
once the renewed contract becomes active.

Prerequisites
You must set the profile option OKS: Enable Grace Period, page 3-36 to Yes at the Site
Level to update the grace period fields on the contract.

To extend a grace period:
1. Navigate to Summary > Administration.

2. Enter/Remove a Grace Duration (for example, 30).

3. Enter/Remove a Grace Period (for example, days).

4. Save your work.

Mass Change
The Mass Change window allows one attribute of multiple contracts to be updated in
a single request. The contracts that are eligible for update are based on the scope and
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criteria of mass change. Mass change is allowed for contracts that are in appropriate
status, where the Update Online operation is permitted.

Mass Change Scope
Mass Change will support changes to a particular instance selected in the update
level. For example, if changes are to be made at the organization, it will update records
pertaining to that organization.

Mass Change Operation Window
This window allows you to enter scope of mass change request and selection criteria. It
determines which contracts are to undergo a mass change. The top part of the
window, the Criteria tab, enables you to enter the scope (update level and update
level value), selection criteria (attribute, old value), and the new value for the attribute
that would be changed. You will enter the name of the mass change to facilitate
re-query. Update Level displays the list of values (LOV) to filter the contract. Based on
the update level, you select the value from the LOV. The update level is seeded, but may
also be restricted by use of the OKS: Mass Change Security Level profile option. If the
security of the profile option is turned on, the list may contain only the Contract and
Contract Group levels; otherwise, the following is the list of update levels available:

• Organization

• Category

• Contracts Group

• Party

• Contract

Mass Change Attributes
Mass change permits the following attributes to be changed. Making change on a
contract has a subsequent cascading effect and therefore needs to be carefully considered
before allowing such a change. Following attributes are permitted for mass change that
can be selected from the Attribute’s list of values (LOV) in the Mass Change header:

• Contract Group

• Contract Start Date

• Contract End Date

• Price List

• Contract Line Reference

• Product Alias

• Known As

• Coverage Time

• Reaction Time

• Header Bill to Address

• Header Ship to Address

• Sales Person
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• Header Billing Contact

• Header Shipping Contact

• Purchase Order Number (for Billing)

• Purchase Order Required (for Renewal)

• Summary Print

• Contract Renewal Type

• Business Process Price List

Field Description

Criteria Tab -

Name Name of the mass change.

Operation Status Status of the mass change request.

Mass Change Details Region -

Update Level Scope of selecting the contracts for a given
mass change request.

Value The actual value of the update level.

Attribute The attribute that is being changed in the
mass change.

Old Value The actual value of the attribute that has to
be updated. It can be a specific value, NULL
or ALL.

New Value The value to which the attribute is to be
updated.

Results Region -

Contract Number The number to identify a contract.

Modifier To identify a contract. It goes with the
contract number.

Description The description of the contract.

Party Name of the customer party.

Contract Status Current status of the contract. For
example, entered, signed, or active.

Start Date Start date of the contract.

End Date End date of the contract.
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Field Description

Old Value The actual value of the attribute that has to
be updated. It can be a specific value, NULL
or ALL.

Process Status Status of the mass change operation line

Select To select any particular contracts.

Contract Description Full description of the contract highlighted.

Buttons -

Deselect All To deselect the contracts.

Select All To select the contracts.

Cancel To cancel the operation

Preview To preview the request. When the button is
clicked the mass change submission window
pops up and accordingly you can make
selections

View Request Once previewed, you can view your request
through View Request.

Submit Submit the mass change request. When
the button is clicked, the mass change
submission window pops up and
accordingly you can make selections.

To perform a mass change:
1. Navigate to Mass Change from the Navigator. The Mass Change Operation window

appears with Criteria window on the top.

2. Enter the Name of mass change.

3. From Mass Change Details select the value Update Level from the LOV.

4. Select Value from the LOV.

5. Select an appropriate Attribute from the LOV. All the attributes supported by mass
change are listed in this list.

6. Select Old Value and New Value from the LOV.

7. Click Refresh if all entries are correct, or click Cancel and start over. If Refresh
button is clicked, all the contracts that meet the criteria are displayed in the Result
window. By default all the records are selected.

8. To deselect some contracts, check the Select check box.

9. Click Preview.

10. You have two options: OK or Cancel. If you click OK, you can choose to Run the
Job As Soon As Possible or On Specific Day. If Run the Job As Soon As Possible is
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selected, you have the option to View request and subsequently View Output. At
this stage you can also go back to the Mass Change Operation window and make
changes to the mass change request, if any.

11. Accordingly submit the request. Again two options will be available: Run the Job
As Soon As Possible or On Specific Day. If Run the Job As Soon As Possible is
selected, you have the option to View Request and subsequently View Output.

12. Click OK. The Mass Change concurrent request will be submitted. If you Cancel, you
will go back to the Mass Change window.

Note: While submitting the mass change request, if one of the
requests has an error it will display an error message. In this
case, you can resubmit the request after making the changes to that
request. This can be done till all the contracts in the mass change
request are successfully processed.

Electronic Renewals
Electronic Renewals takes advantage of workflow and XML reporting features to offer
improved efficiency and improved customer satisfaction.

This process offers:

• Improved efficiency renewing lower dollar contracts

• Allows resources to be focused on larger contracts and customers

• Improves customer satisfaction by making the renewals process more customer
driven

Overview

Only contracts with the category of Warranty and Extended Warranty are eligible for
electronic renewals. Contracts of this category may be given a Renewal Rule of Electronic
Renewal. When the renew contract API recognizes a contract with a Renewal Rule of
Electronic Renewal, a workflow process is launched and the following occurs:

• A contract is renewed with a status of Entered.

• A QA Check is run against the contract.

• If the QA Check fails, a notification is sent to the help desk e-mail address (if one has
been entered in Global Contracts Defaults).

• Once the contract has been corrected, it can be resubmitted and picked up by the
Autorenew workflow.

• E-mail notification is sent to the customer (Quote To contact on the contract). The
e-mail contains the following:

• Cover Letter (defined in OKC Print Contracts Setup)

• A URL for customer to view Quote Letter (defined in OKC Print Contracts Setup)

• Account\password that is required to log into the web page and view quote
(account\password is stored in FND USERS and is associated with the Quote
To contact)

Note: In the first e-mail sent to the “Quote To” user, the
password is sent in a readable format. For security, the
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password will be encrypted in the subsequent e-mails sent to
the same user.

Upon receipt of the e-mail, the customer may log into the web page to review the quote
and accept, reject, or request changes to the contract renewal.

There are two ways for the customer to accept the quote:

• Payment by Credit Card - the customer provides credit card information. The card
is validated (via integration to Payment Server). If the card passes validation, the
contract is put in Signed status.

• Payment by PO – the customer provides a PO Number. A workflow process is
launched which results in a QA Check being run against the contract. If the QA
Check passes, the contract status is updated to Submitted for Approval status and a
notification is sent to the contract approver. If the QA Check fails, a notification is
sent to the help desk e-mail account.

If the quote is rejected a notification is sent to the help desk e-mail account and the
contract is placed in Canceled status.

Changes to the quote may be requested by sending an e-mail to the help desk e-mail
account.

Note: When referring to quotes above, these are reports which contain
information about the renewal agreement. They are not generated by, or
interfaced with Oracle Quoting.

Prerequisites:

The following prerequisite steps must be performed for Electronic Renewals to work
properly:

• Enable the Electronic Renewals option in the Renewal Rule Defaults form, page
3-52. Also use this form to set up renewal defaults at the system, party, and
organization levels. You can set up the threshold amount, currency type, method of
payment, payment term, help desk e-mail, template set, and billing profile in the
Renewal Rule Defaults form. The Electronic Renewal rule may also be specified
at the contract level.

• Create templates for quote letter, cover letter, and so on, in OKC Print Contract Setup.

This is an XML reporting feature supported by Contracts Core. For guidance on
how to create XML reports, see the topic about setting up XML reports in the Oracle
Contracts Core Implementation Guide.

• Define a Template Set in Define Electronic Renewal Template.

Reports/Templates created in OKC Print Contract Setup are mapped to a
Template Set in this setup screen. This is also where you would map reminder
notices, cancellation notices, or similar reports created in OKC Print Contract Setup
that you would like to automatically send to a customer (see Autoreminder section).

• Set Profile Option OKS: Electronic Renewal URL to identify the URL that will be
used for customer responses to Electronic Renewal notifications.

Note: Template JSP files are provided. These files may be used as
is or modified to achieve the desired look, feel and content in
the HTML customer interface.
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Autoreminder

Oracle Service Contracts provides functionality to automate the process of reminding
customers to renew their contracts. After a particular notice is sent, the Autoreminder
functionality updates the contract status and monitors the Autoreminder process
interactions.

When a contract nears expiration, it may be automatically renewed, for example, 90 days
prior to its end date. Throughout this 90-day window, the appropriate level of attention
needs to be given to ensure that the renewal is secured with the customer. Rather than the
sales representative having to check for contracts due for renewal and contact customers
by phone or fax to renew a contract, which would be inefficient, a reminder notice will
be automatically generated and sent to the customer for review through e-mail.

Autoreminder notices can automatically be sent by scheduling the Service Contracts
Autoreminder program to run on a regular basis (for example, nightly).

The following prerequisite steps must be performed prior to scheduling auto reminder
notices:

• Create templates for a quote letter, cover letter, and so on, in OKC Print Contract
Setup.

This is an XML reporting feature supported by Contracts Core. For guidance on how to
create XML reports, see the Oracle Contracts Core Implementation Guide.

• Define a Template Set using the Define Electronic Renewal Template, page 3-35.

Reports/Templates created in OKC Print Contract Setup are mapped to a Template
Set in this setup screen. Create templates for a quote letter, cover letter, and so on, in
OKC Print Contract Setup. A Template Set used for AutoReminders may be the same
one that is used for Electronic Renewals.

For each report (reminder notice) that is added to a Template Set, you can also set a
lead date and, optionally, a status code. There are two types of reminders: Reminder
Notice and Cancellation Notice. The Reminder Notice can have any Entered status
type associated with it. The Cancellation Notice can have any Canceled status typed
associated to it. The AutoReminder Program updates contract status to the status
associated with the relevant reminder notice as defined in the Template Set. Only
contracts that qualify to have a particular reminder notice sent to the customer would
have their statuses updated.

• Associate a Template Set in the Global Contracts Defaults. See: Setting Up , page
3-52Global Contract Defaults

Reassigning Resources

Service Contracts Concurrent Program for Reassigning Resources

Service contracts are generally assigned to a resource that is responsible for following
through on inquiries from the customer through the life of the contract, from the initial
sale through the renewal process. If that person moves to another department, or leaves
the company, the appropriate level of attention may not be given to the contract.

This process ensures that contract assignments are correct and that no contract is left
assigned to an inactive contact.

This concurrent process can be scheduled to run as often as necessary, for
example, nightly. The process will check all contracts in an ’Entered’ status type. It will
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compare the Vendor Contact resource that is assigned to the contract with the resource
assigned to the territory that the contract maps to in JTF territory management. If
the resources are different, the resource associated to the territory will overwrite the
resource that was assigned to the contract. The resource to which the contract is being
assigned will receive a workflow notification.

Prerequisites

The JTF Territory assignments will have to be set up. The profile option OKS: Use
Territories to Default Sales Person should be set to ’Yes’ to use this process. The profile
option OKS: Enable Sales Credits should be set to Derive.

The resource will have to be assigned to the contract on the Summary Parties tab in the
Contacts region for the vendor.

Reporting
Many report programs contain parameters for running the report, which enable you
to narrow down the results that are returned. You can run some reports for as little
as a single contract to as broad every contract in your database. So where there are
parameters listed for the reports, this means you can constrain your search to find only
the contracts that meet criteria in those fields.

Contracts QA Report

Use this report to run QA for multiple contracts. You can select a range of contracts
based on the following parameters:

• Contract Number range

• Start Date range

• Contract Status

You can also choose a report, which details the results of the QA for all contracts
selected, or just for contracts which passed or failed. The report includes details of
the data checked including whether the checked data had warnings and errors and if
so, what results where found.

OKS Products Not Renewed Report

This report lists products on contracts that have expired and not been
renewed. Parameters include organization, range of contract end dates, sales rep, and
customer.

Service Contracts Bookings Report

This report lists the service contracts booked in a stated period along with the
corresponding invoice details (if applicable). Parameters are organization, sales
representative, range of approved dates or start dates, and contract value. You can choose
to sort this report by any of these parameters as well as the customer name, invoice
date, invoice number, invoice value, modifier, contract number, or start date.
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Service Contracts by Status Report

This report allows the sales representative to track contracts by status. Parameters
include organization, sales rep, customer number or name, currency code, range of start
dates, range of end dates, status code, and status type.

Service Contracts Detail Report

This report will display key details of the contract headers, contract lines, and covered
products for contracts in the Warranty and Extended Warranty category. It will not be
possible to extract all Service Agreement information into this report, since it is focused
on covered products. Parameters include Contract number, Customer, Status type, Status
code, Start Date (From and To), and End Date (From and To).

Service Contract Forecast Management Report

This report allows the sales representative and management to track the anticipated
close of contract renewals. Parameters include organization, sales rep, status, forecast
period start and end, minimum and maximum contract values, currency code, and
revenue recognition date.

The report can be sorted in two different ways:

• Sales representative, contract value, status type, and customer name

• Status type, status code, contract value, and customer name

You can run this report only for contracts that:

• Have one or more Service or Extended Warranty line

• Are in the Entered status type

• Have a valid Customer and Vendor role

• Have a valid Vendor Contact Role of Sales Person or Support Sales

Example:

If you run the report with the following parameters:

• Forecast Start Period: 01-Dec-03

• Forecast End Period: 31-Dec-03

• Revenue Recognized Date: 31-Dec-03

Output:

Contract Value = Total value of contracts with estimated close date between 01-Dec-03
and 31-DEC-03.

Contract Forecast = Sum of (Contract Value * Estimated Percent) for all contracts
estimated to close between 01-Dec-03 and 31-Dec-03.

Revenue to Be Recognized = Total amount of revenue that can be recognized as of
31-Dec-03 for all contracts expected to close between 01-Dec-03 and 31-Dec-03.

Forecast Revenue = Sum of (Revenue to Be Recognized * Estimated Percent) for all
contracts estimated to close between 01-Dec-03 and 31-Dec-03

The values for above fields are calculated based on the information you enter in the
Administration tab of the Authoring window (Estimation Percent and Date fields).
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Service Contracts Forecast Summary Report

This report lists the contracts eligible for renewal for a given period along with the
recognized revenue date. Parameters are organization, currency code, start and end
dates, minimum and maximum contract value, and recognized revenue date.

Service Contracts Setup Report

The Service Contracts Setup Report is a diagnostic tool provided to facilitate debugging
of implementation issues. This report also helps in implementation by summarizing
the set ups and providing information on mandatory set up items. It provides a
comprehensive report on the set up done in any application environment and highlights
incomplete mandatory setup steps in red. The output from this report is a PDF, which
can be displayed by clicking View Output on the concurrent request form, after the
report is complete. Run this report to review:

• Profiles Setup: This section provides a list of User Profile Option Names and Values
set for them. If any of the mandatory settings are missing or not properly set, they
will be highlighted in red. The Profile Setup values and mandatory column are as
follows. Global Contracts Defaults: The report shows the values set in the Global
Contracts Defaults set up.

• Transaction Type Setup: For this setup, the report checks for Batch Transaction
Source OKS_CONTRACTS and Transaction Type Invoice-OKS and Credit-OKS.

• Service Key Flexfield Setup: Checks whether the key Flexfield Code SERV has
been set up.

• Category Setup: Under Category set up, the report displays the categories and
responsibilities set and the access level for Service and Warranty Categories.

• Order Quoting Integration Setup: Validates that Oracle Service Contracts is set
for Order Quoting integration.

• Time Units Mapping: The report displays the user-defined time code units.

• Coverage Template Setup: The report shows if any coverage template has been
defined for warranty as well as service items.

• Statuses and Operations: The report displays all the contract statuses and operations
for each status type.

Service Contracts Summary Report

This report allows the sales representative to track all contracts by customer. Parameters
include organization, sales representative, customer name or number, and from and
to dates.

Service Contracts Quote Printing Program for US

This will generate a printed quote for a selection of contracts by country, party, or
organization for a given X number of days before expiration. The program does not
create the renewal agreement but prints the details of the entered status renewal contract
in a report along with a cover letter. This is designed to be a sample report that can be
tailored to meet the needs of the organization.

Service Contracts Billing Report

When the Contracts Main Billing program completes, a log file is generated. That
information contains the total value processed, total value successful, and total value
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rejected. For all unsuccessful transactions, further contract information will be displayed
so that you can pinpoint the contract and/or line that caused the issue. The information
includes:

• Contract number and modifier

• Customer bill to account name and number

• Contract group

• Contract line and subline number

• Item name

• Line amount

• Reason for failure of main billing

Speeding Up Access to Other Applications Using the Quick Menu
You can use the Quick Menu to quickly navigate to windows in other applications
and preserve the current customer context. This saves you from having to change
responsibilities and performing queries again to display the same customer information.

For example, if you are working on a contract for a product a customer owns, you can
display information about that product from Oracle Install Base with two clicks of the
mouse.

Only Quick Menu-enabled applications preserve the context in the new window. Contact
your application administrator for more information.

Prerequisites
• Your responsibility must enable you to access the application you wish to open.

• Your application administrator must set up the Quick Menu selections.

• Display a contract in the Service Contracts Authoring window.

To access other applications using the Quick Menu:
1. From the Tools menu, choose Quick Menu.

The Quick Menu window appears.

2. Double-click on the desired menu option.

The application opens in a new window and, where available, displays information
related to the contract customer.

Creating or Modifying a Contact Record
The procedures in this section explain how you can create and modify a contact record
for a customer or for an account associated with a contract line:

• Creating or Modifying a Customer or Third-Party Contact Record, page 2-132

• Creating or Modifying a Contact Record for an Account in a Contract Line, page
2-133
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Using these procedures you can enter or modify only the basic information such as the
contact name, phone number, and e-mail address. You cannot use them to create a
new customer address, for example. To create a full customer contact record, use the
Customer Standard window in Oracle Receivables or the Contact Center window
which is available under the Customer Support responsibility. See the contact creation
procedures described in the Oracle TeleService User’s Guide and Oracle Receivables User
Guide for details.

Creating or Modifying a Customer or Third-Party Contact Record
Use this procedure to create a new contact for a customer or a third party or to modify an
existing contact record.

Prerequisites
• Display a contract for the customer in the Service Contract Authoring window.

• You must enter the customer or third party as a party before you can enter the
contact.

To create a customer or third party contact record:
1. Select the Summary tab and the Parties subtab.

2. In the Party region, select the party for which you wish to create the contact. You can
create a contact either for the customer or a third party.

3. In the Contacts region, place the cursor in the Role field.

4. Choose Maintain Contact from the Actions menu.

The Contact window appears.

5. If you are creating a new contact, then:

1. Choose a role for this contact using the Contact Role List of Values (LOV).

2. Enter the contact last and first name.

3. Use the following guidelines for entering other information:

• Choose the titles and job descriptions from the Titles and Job LOVs. These
are preset by your application administrator.

• Phone, fax, and mobile numbers are composed of three fields: a country
code (LOV), an area code, and the number itself. Do not use any
delimiters in entering your number.

• For the contact address, you can only choose one of the existing party
locations. You can add a mail stop or a mail box, however, by pressing
the Tab key after entering the address.

6. If you are modifying an existing contact, then you can:

• Change the title and job description by selecting a different one from the Title
and Job LOVs.

• Change the phone, fax, and mobile numbers.

• Change the e-mail address.
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Note: When modifying existing contact information, be
aware that you are modifying the contact record for all
Oracle eBusiness Suite applications.

You cannot modify the address or mail stop number. If
you wish to select another address or enter a different
mail stop, then you must:

• Navigate back to the Service Contracts Authoring window.

• Delete the contact by selecting it and clicking Delete in the Toolbar.

• Create a replacement contact with the correct address information.

Note: Deleting the contact from the contract does not
delete it from the database. Creating a replacement record
creates a duplicate.

7. If you are modifying an existing contact and wish to revert to the existing
record, then click Reset.

8. Click OK to return to the Service Contracts Authoring window.

9. Click Save to save the contact record.

Creating or Modifying a Contact Record for an Account in a Contract Line
Use this procedure to create a new contact for a contract line. The contact you create
becomes a contact for the bill to account, the ship to account, or both, depending on
your selection.

Prerequisites
• Display a contract for the customer in the Service Contract Authoring window.

• You must enter a service contract line before you can create a contact.

To create a contact for the contract line account:
1. Select the Lines tab and the Accounts subtab.

2. Select the contract line where you wish to create a contact.

3. In the Customer Contacts region, place the cursor in the Role field.

4. Choose Maintain Contact from the Actions menu.

The Contact window appears.

5. If you are creating a new contact, then:

1. Choose a role for this contract using the Contact Role List of Values
(LOV). Usually this is either Billing Contact or Shipping Contact.

2. Select the Bill To or the Ship To radio button depending on whether you wish to
create a contact for the billing or shipping account in the contract line.
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The role you selected in the previous step restricts your choices: if you selected
the Billing Contact role, then you cannot select the Ship To radio button and
vice versa.

3. Enter the contact last and first name.

4. Use the following guidelines for entering other information:

• Choose the titles and job descriptions from the Titles and Job LOVs. These
are preset by your application administrator.

• Phone, fax, and mobile numbers are composed of three fields: a country
code (LOV), an area code, and the number itself. Do not use any delimiters
in entering your number.

• For the contact address, you can only choose one of the existing customer
locations associated with the account. You can add a mail stop or a mail
box, however, by pressing the Tab key after entering the address.

6. If you are modifying an existing contact, then you can:

• Change the title and job description by selecting a different one from the Title
and Job LOVs.

• Change the phone, fax, and mobile numbers.

• Change the e-mail address.

Note: When modifying existing contact information, be
aware that you are modifying the contact record for all
Oracle eBusiness Suite applications.

You cannot modify the address or mail stop number after
you have saved them. If you wish to select another address
or enter a different mail stop, then you must:

• Navigate back to the Service Contracts Authoring window.

• Delete the contact by selecting it and clicking Delete in the Toolbar.

• Create a replacement contact with the correct address information.

Note: Deleting the contact from the contract does not
delete it from the database. Creating a replacement record
creates a duplicate.

7. If you are modifying an existing contact and wish to revert to the existing
record, then click Reset.

8. Click OK to return to the Service Contracts Authoring window.

9. Click Save to save the contact record.

Creating and Enabling Templates for E-Mails to Customers
This group of topics explains how application administrators can take advantage of the
Oracle Service Contracts integration with Oracle XML Publisher to create and enable
templates for personalized e-mail communications with customers.
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The overview, page 2-135 describes the two types of e-mail communications you can
create. The two topics that follow provide the general steps for creating each:

• Creating and Enabling Templates for E-mail Attachments Sent by Agents, page 2-136

• Creating and Enabling Templates for Communications Generated by Electronic ,
page 2-137Renewals

Use the references in each step to view the detailed procedures required.

Overview
Using the procedures in this section, you can create templates for e-mail communications
with customers that can be used:

• By agents to send quotes and other communications as e-mail attachments

• For e-mail renewal notices generated automatically during electronic renewals

About E-mail Attachments Sent by Agents to Customers

Agents can send e-mails to contacts from the Service Contracts Authoring window by
choosing E-Mail Quote from the Tools menu. The agent types the e-mail address, the
subject, and the body, and can attach a PDF communication that is automatically
generated from the template you create using the procedures in this section.

This PDF can be either a report about the current contract, or any other communication
such as a general announcement.

About E-mails Generated by Electronic Renewals

You can also have the automatic renewal process use the template for one or more of the
e-mail communications generated by the automatic renewal process. These are:

• An initial renewal notification (called a Cover Letter in this application) (HTML)

• One or more reminder notices (HTML)

• One or more cancellation notices (HTML)

• The PDF attachment sent with all of the above e-mails (called a Quote Letter in
this application)

For each e-mail communication, the application generates an HTML e-mail body from
the template and attaches the PDF attachment.

The subject line for each e-mail type is preset and cannot be modified. The following
table lists the subject lines for the three types of e-mail communications:

E-mail Communication Type Automatically-generated Subject Line Text

Cover letters Contract <contract number and modifier>
requires your approval.

Reminder notices Reminder notice for contract <contract number
and modifier>.

Cancellation notices Cancellation notice for contract <contract
number and modifier>.
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The application sends all communications to the e-mail address the agent enters into the
contract authoring window (the Quote To region of the Summary tab, Renewals subtab).

You can create multiple sets of templates for use on different dates, by different internal
organizations, or targeted to different customers.

Process Overview

You must complete the following two steps to create both e-mail attachments and
electronic renewal communications:

1. Create the template documents, using Microsoft Word (or another application
capable of saving files in the RTF format), following the procedures described in
the Oracle XML Publisher User’s Guide.

In the document you can embed codes (XML data elements) which the application
uses to supply contract-specific information including:

• Details about the contract

• The URL the customer can use to log into an application-generated Web
page. There they can review the quote, indicate their acceptance, or request
changes.

• The user name and password for the login.

For a complete list of contract data you can include see Contract-Specific Data
Available for Inclusion in Template Documents, page 2-137. You can view
sample documents provided with this application by following the instructions
described in Viewing Sample Marked-Up Documents Provided with the
Application, page 2-157.

2. Upload the document and register it as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 2-150 for
details.

To create templates for e-mails sent automatically by the electronic renewals feature of
this application you must also complete these two additional steps:

1. Specify the set of templates that are going to be used for a specific renewal flow. See
Creating the Set of Templates Used for a Specific Renewal Flow, page 2-152 for
details.

2. Specify how the template set is to be used. See Specifying How the Template Sets
Are to Be Used, page 2-153 for details.

Creating and Enabling Templates for E-mail Attachments Sent by Agents
Use this procedure to create templates for E-mail Attachments sent by agents.

Prerequisites
System profile OKS: Layout Template Source must be set to XML Publisher at the
Site level.

To create and enable templates for PDF attachments to agent e-mails:
1. Create the RTF document according to the procedures in the Oracle XML Publisher

User’s Guide.
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2. Change responsibility to XML Publisher Administrator.

3. Upload and register the document as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 2-150.

The document is now available for agents to send as a PDF attachment when they
send out an e-mail from the Oracle Service Contracts Authoring window.

Creating and Enabling Templates for Electronic Renewals
Use this procedure to create and enable the templates the electronic renewal process uses
to generate e-mail communications with the customer.

Note: Electronic renewals are available only for contracts of categories
Service and Warranty and Extended Warranty.

To create and enable templates for renewal communications:
1. Create the RTF document according to the procedures in the Oracle XML Publisher

User’s Guide.

2. Change responsibility to XML Publisher Administrator.

3. Upload and register the document as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 2-150.

4. Change responsibility back to Service Contracts Manger.

5. Group the templates into sets and specify when renewal and cancellation notices are
to be sent. Creating the Set of Templates Used for a Specific , page 2-152Renewal
Flow.

6. Specify how you wish to use the template sets. See Specifying How the , page
2-153Template Sets Are to Be Used.

7. Optionally, you can preview the communications generated by the template set for a
specific contract, for a party, or for an entire internal organization by running the
Generate Quotes concurrent program. See Viewing PDF , page 2-155Attachments.

Contract-Specific Data Available for Inclusion in Template Documents
The data definition supplied by Oracle, OKSCONDATA, makes it possible for you to
include information about the following aspects of the contract in the e-mail body or
PDF quote attachment:

• Basic contract information from the contract header, page 2-138

• The recipient of e-mails generated by the electronic renewal process, page 2-138

• The sales agent on the contract , page 2-140

• Customer name and number, page 2-141

• The default contract billing schedule, page 2-142

• Contract billing address, page 2-142

• Contract shipping address, page 2-144

• Contract taxes, page 2-144
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• Contract line information, page 2-144

• Contract line taxes, page 2-145

• Contract line billing schedule, page 2-145

• Contract line billing contact, page 2-146

• Contract sublines (what the line covers), page 2-147

• Login information for the URL for customer renewals, page 2-148

• Current date, page 2-148

• Contract payment terms, page 2-149

Note: For this release, you are restricted to the data definition
provided by Oracle. You can view the structure of the data
definition by following the procedure described in Viewing the Data
Definition Structure, page 2-149.

Contract Header

The following table lists XML data elements you can use to insert information from the
contract header (basic information about the contract the agent enters at the top of the
Service Contract Authoring window).

You must preface any of the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/

For example, to insert the contract number into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/ContractNumber

Contract Header Field XML Data Element

Contract Number ContractNumber

Contract Modifier ContractModifier

Start Date StartDate

End Date EndDate

Status Status

Short Description ShortDescription

Currency Currency

Contract Amount ContractAmount

Electronic Renewal Recipient Information

The following table lists the XML data elements for inserting information about the
recipient of electronic renewals communications.
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Agents enter this information in the Quote To region of the contract. This region is found
either on the Summary tab, Renewals subtab of the Service Contracts Authoring window
or, if you are generating contracts automatically from Oracle Order Management, in
the Contract Details window.

Note: Some of the XML data elements are derived from information
entered by agents in applications other than Oracle Service
Contracts. For example, address details are entered in Oracle
TeleService, Oracle Receivables, Oracle TeleSales and other applications.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/QuoteToContDtlsVO/QuoteToCo
ntDtlsVORow/

For example, to insert the full name of the recipient into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/QuoteToContDtlsVO/QuoteToCo
ntDtlsVORow/FirstLast

Quote to Contact Attributes XML Data Element

First Name FirstName

Middle Name MiddleName

Last Name LastName

Full Name FirstLast

Job Title JobTitle

Phone Area Code PhoneAreaCode

Phone Number PhoneNumber

Email EmailAddress

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State
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Sales Agent Information

The following table lists the XML data elements for information you can insert in your
documents regarding the sales agent on the contract.

This sales agent can be:

• The vendor contact of role Salesperson entered on the Summary tab, Parties subtab
of the Service Contracts Authoring window.

• If you are using Oracle Order Management to create contracts, the sales agent
in the Sales Order window.

• Assigned by the application automatically if your organization has implemented
territories.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/SalesRepVO/SalesRepVORow/

For example, to insert the full name of the sales agent into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/SalesRepVO/SalesRepVORow/Fu
llName
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Sales Representative Attributes XML Data Element

First Name FirstName

Middle Name MiddleName

Last Name LastName

Full Name FullName

Phone Area Code PhoneAreaCode

Phone Number PhoneNumber

Email EmailAddress

Job Title JobTitle

Manager Name ManagerName

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State

Customer Name and Number

The following table lists the XML data elements for the customer name and number you
can insert in your documents. The customer for the contract is the party of role customer.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/CustomerVO/CustomerVORow/

For example, to insert the customer name into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/CustomerVO/CustomerVORow/Pa
rtyName

Customer Attributes XML Data Element

Party Number PartyNumber

Party Name PartyName
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Default Contract Billing Schedule Information

The following table lists the XML data elements you can use to insert information
on the default billing schedule.

Agents set up the default billing schedule on the Summary tab, Pricing/Billing subtab of
the Service Contracts Authoring window. Agents use this contract-level billing schedule
to default schedules to contract lines, so entry is optional.

If you have only one billing period in the schedule, preface the XML data elements
with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillSchdVO/HdrBillSchdVO
Row/

For example, to insert the date of start date of the billing period in your document
you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillSchdVO/HdrBillSchdVO
Row/StartDate

If your billing schedule has multiple billing periods, follow the instructions described in
the Oracle XML Publisher User’s Guide.

Header Billing Schedule Attributes XML Data Element

Start Date StartDate

End Date EndDate

Invoice Date TransactionDate

Interface Date DateToInterface

Amount Amount

Contract Billing Address

The following table lists the XML data elements for contract billing address
information. Agents select the billing address in the Bill To region of the Summary
tab, Parties subtab. The address itself must be entered in other applications.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToAddrVO/HdrBillToAd
drVORow/

For example, to insert the city in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToAddrVO/HdrBillToAd
drVORow/City
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Header Bill To Address Attributes XML Data Element

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State

Province Province

County County

Contract Billing Contact Information

The following table lists the XML data elements you can use to insert information about
the contract’s billing contact. Agents enter the billing contact by entering a customer
or a third party contact with the role of Billing in the Contact region of the Summary
tab, Parties subtab.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToContDtlsVO/HdrBill
ToContDtlsVORow/

For example, to insert the last name of the contact in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToContDtlsVO/HdrBill
ToContDtlsVORow/LastName

Header Billing Contact Attributes XML Data Element

First Name FirstName

Last Name LastName

Phone BillToPhone

Fax BillToFax

Email BillToEmail
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Contract Shipping Address

The following table lists the XML data elements for the contract shipping address
information. Agents select the shipping address in the Ship To region of the Summary
tab, Parties subtab. The address itself must be entered in other applications.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrShipToAddrVO/HdrShipToAd
drVORow/

For example, to insert the city in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrShipToAddrVO/HdrShipToAd
drVORow/City

Header Ship to Address Attributes XML Data Element

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

State State

Province Province

County County

Postal Code PostalCode

Contract Taxes

If you wish to enter the amount of taxes for the contract as a whole into your
document, then enter the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrTaxAmountVO/HdrTaxAmount
VORow/TaxAmount

The contract tax amount is calculated by the application and appears in the Tax field on
the Service Contracts Authoring window header.

Contract Line Information

The following table lists the XML data elements you can use to insert information
about the lines in your contract.

If you have only one contract line, preface the XML data elements with the following
string:
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/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/

For example, to insert the name of the service, usage, or subscription in your document
you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/Name

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Contract Line Attributes XML Data Element

Line Number LineNumber

Line Name Name

Start Date StartDate

End Date EndDate

Line Amount LineAmount

Contract Line Taxes

If you have only one line in your contract, you can display the tax for that line in your
document, by entering the following string and the XML data element:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineTaxA
mountVO/LineTaxAmountVORow/TaxAmount

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Contract Line Billing Schedule

The following table lists the XML data elements you can use to enter information about
billing schedules for individual contract lines into your document.

If you have only one line in your contract, preface the XML data elements with the
following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
SchdVO/LineBillSchdVORow/

For example, to insert the date of the invoice in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
SchdVO/LineBillSchdVORow/TransactionDate

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.
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Line Billing Schedule Attributes XML Data Element

Start Date StartDate

End Date EndDate

Invoice Date TransactionDate

Date To Interface DateToInterface

Amount Amount

Line Billing Contact

The following table lists the XML data elements you can use to enter into your document
billing contact information for individual contract lines. Agents enter the billing contact
by entering a customer contact of role Billing Contact on the Lines Tab, Accounts subtab
of the Service Contracts Authoring window.

If you have only one contract line, then preface the XML data elements with the
following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
ToContDtlsVO/LineBillToContDtlsVORow/

For example, to insert the name of the contact in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
ToContDtlsVO/LineBillToContDtlsVORow/Name

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.
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Line Billing Contact Attributes XML Data Element

Name (first and last name) Name

Email Email

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

State State

Province Province

County County

Postal Code PostalCode

Sublines

The following table lists the XML data elements you can use to enter information about
sublines. For service lines, this is what the service covers (for example, a product, or a
customer site). For usage lines, this is the individual counter used to track usage.

If you have only one subline in your contract, then preface the XML data elements
with the following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/SubLines
VO/SubLinesVORow/

For example, to insert the level of coverage for a service line in your document you
must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/SubLines
VO/SubLinesVORow/CoveredLevel

To insert information from multiple sublines, follow the instructions described in the
Oracle XML Publisher User’s Guide.
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SubLine Attributes XML Data Element

SubLine Number SubLineNumber

Name Name

Covered Level CoveredLevel

Start Date StartDate

End Date EndDate

Quantity Quantity

UOM Uom

SubLine Amount SubLineAmount

Login Information for Electronic Renewals

The following table lists the XML data elements you can use to include in your document
information users can use to log into an automatically generated HTML page where
they can review and renew their contract.

The URL for that page must be entered by the application administrator in the system
profile OKS: Electronic Renewals URL.

The application automatically creates a user name and password which you can insert
in the renewal e-mail by including the XML names tags listed below. If you include
the password tag name, the application sends the automatically generated password
with the first communication to the customer and encrypts the password as a series of
stars in all subsequent e-mails.

You must preface the XML data elements with the following string:

/ContractDetails/

For example, to insert the user name into your document you must enter:

/ContractDetails/UserName

Web UI Login Attributes XML Data Element

User Name UserName

Password Password

Web UI Login URL WebUILoginURL

Current Date

If you wish to insert the current date (sysdate) into your document, then enter the
following string as the XML tag name:
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/ContractDetails/HeaderVO/HeaderVORow/ReportGeneratedDate

Contract Payment Terms

If you wish to insert the contract payment terms into your document, then enter the
following string as the XML tag name:

/ContractDetails/HeaderVO/HeaderVORow/PayTermVO/PayTermVORow/Paym
entTerms

Viewing the Data Definition Structure
Use this procedure to display a sample document with all of the available data elements.

To view the data definition structure:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Data Definitions in the Navigator.

The Data Definitions search page appears in a new browser window.

3. Enter Service Contracts in the Application field.

4. Click Go.

5. Select the Service Contract Data link.

The View Data Definition page appears.
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6. Click the OKSCONDATA.xml link in the Preview Data field to view or save the file.

Uploading and Registering a Template in Oracle XML Publisher
Use this procedure to upload and register a template in Oracle XML Publisher. This step
is required to use your document for electronic renewals.

Prerequisites
You must first create the template as an RTF document.

To upload and register a template:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Templates in the Navigator.

The Templates search page appears in a new browser window.

3. Click Create Template.

The Create Template page appears.

2-150 Oracle Service Contracts Concepts and Procedures



4. In the Name field, enter a user-friendly name for your template.

5. In the Code field, enter a code (no longer than 10 characters) for the
template. start with this product’s short code (OKS) and a descriptive ending. For
example: OKS_cover.

6. Choose Service Contracts from the Application List of Values (LOV).

7. Choose OKSCONDATA from the Data Definition LOV. This is the data definition
supplied by Oracle. In this release, you are restricted to using this data definition
only.

8. Choose RTF from the Type LOV.

9. In Start Date, enter the date from which the template will be active.

10. In the End Date, enter the date when this template becomes inactive. This is optional.

11. Sub-templates are not supported in this release.

12. Optionally, enter a description in the Description field.

13. Click Browse and select the RTF template file.

14. Choose the language of the template you have uploaded from the Language LOV.

15. Language territories are not supported in this release, so you can leave the Territory
field blank.

16. Click Apply.

17. You can preview a PDF of your template to validate your work by navigating to the
View Template page and selecting the Preview icon. See the Viewing and Updating
section of the Oracle XML Publisher User’s Guide for details.
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Creating the Set of Templates Used for a Specific Renewal Flow
Use this procedure to create a set of templates that the application uses for a specific
renewal flow.

In the template set, you specify which RTF template is used for which
communication. For reminder and cancellation notices, you also specify when they will
be sent. For example, you may wish to send one renewal reminder 30 days before the
contract expires and, if the customer does not respond, send out another 15 days before
expiration. If the customer has not responded two weeks after the expiration date, you
may wish to send a reminder that the contract is being cancelled.

You can set up just one template set to be used for communications for all renewals. Or
you can set up different sets to go to different customers or to be used by different
organizations within your company.

This step is required to use your document for electronic renewals.

Prerequisites
You must first create and upload into Oracle XML Publisher RTF templates for:

• The cover letter (the HTML body of the initial renewal e-mail)

• The quote letter (the PDF attachment)

Reminder and cancellation notices are optional.

To specify a set of templates to be used for electronic renewals:
1. Navigate to Setup > Define Electronic Renewal Template.

The Template Set window appears.

2. Enter a name for the template set in the Name field.

3. Optionally, enter a start and end date if you wish to restrict the availability of
this template set.
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4. Using the Quote Letter LOV, choose the Oracle XML Publisher template the
application will use to generate the PDF attachment sent with every e-mail to
the customer.

5. Using the Cover Letter LOV, choose the Oracle XML Publisher template the
application will use to generate the HTML body for the initial renewal e-mail.

6. If you wish to send one or more reminder notices if the contact does not reply to the
initial e-mail. Then for each reminder notice:

1. Choose Reminder Notice from the Report Type LOV.

2. From the Report Name LOV, choose the template the application will use to
generate the HTML body of the reminder.

3. If you wish to restrict the use of this reminder to a specific time period, then
enter a start date, an end date, or both.

4. Specify when you wish the reminder to be sent in relationship to the start date
of the renewed contract. This is done by entering a negative number in the
Duration field and choosing the time unit of measure from the Period LOV. For
example, if you wish to send the reminder two weeks before the start date of the
renewed contract, then enter -2 as the duration and choose Week as the period.

5. You can have the application reset the status of the contract after the notice is
sent. If you wish to do so, choose a status from the Status LOV.

You can set a contract to any status of type Entered.

7. If you wish to send one or more cancellation notices to the contact if the customer
does not renew the contract the end date, then, for each cancellation notice:

1. Choose Cancellation Notice From the Report Type LOV.

2. From the Report Name LOV, choose the template the application will use to
generate the HTML body of the cancellation notice.

3. If you wish to restrict the use of this cancellation notice to a specific time
period, then enter a start date, an end date, or both.

4. Specify when you wish to send the cancellation notice in relationship to the
planned start date for the renewed contract. This is accomplished by entering a
positive number in the Duration field and choosing the time unit of measure
from the Period LOV. For example, if you wish to send the cancellation notice
two weeks after the planned start date of the renewed contract, then enter 2 as
the duration and choose Week as the period.

5. You can have the application reset the status of the contract after the cancellation
notice is sent. If you wish to do so, choose a status from the Status LOV.

You can set a contract to any status of type Cancelled.

Note: The application must periodically run the concurrent
request Service Contracts Autoreminder program to send
reminder and cancellation notices.

Specifying How the Template Sets Are to Be Used
Use this procedure to specify how the template sets you have created will be used
by the application.
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You can:

• Specify a single template set for all electronic renewals, the global level.

• Specify different template sets for use by different organizations within your
company.

• Specify different template sets to be used for different individual customers.

The application looks for an appropriate template set from the most specific to the
global. If the application does not find a template set specified at the customer level, it
looks at the organization level, if none is found at the organization level either, it uses
the template specified at the global level.

For example, if you specify Set 1 of renewal e-mail communications to be used at the
global level, and specify Set 2 to be used for customers A and B. Then any contract for
customers A and B will use Set 2, and contracts for all other customers will use Set 1.

Note: For electronic renewals to work, you must at least associate a
template set at the global level.

Prerequisites
You must first create the template sets used to generate the renewal communications.

To specify how the template sets are to be used:
1. Navigate to Setup > Global Contracts Defaults.

The Global Contracts Defaults window appears.

2. Choose a template set to be used for electronic renewals at the global level using the
Template Set List of Values (LOV) in the Global region at the top of the window.

3. If you wish to specify different template sets for individual customers, then for
each customer:
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1. Select the Parties Tab and Electronic Renewal subtab.

2. Choose the customer from the Party Name LOV.

3. Choose the template set from the Template Set LOV.

4. If you wish to specify different template sets for organizations in your own
company, then for each organization:

1. Select the Organizations tab and Electronic Renewal subtab.

2. Choose the organization from the Organization Name LOV.

3. Choose the template set from the Template Set LOV.

5. Click Save.

Viewing PDF Attachments
The application automatically generates and e-mails the PDF attachment with every
electronic renewal communication. Use this procedure to generate the PDF for your own
review. You can view the PDF to be sent for a single contract, all the PDFs being sent to a
customer, or all the PDFs generated for an internal organization.

Prerequisites
You must be familiar with submitting concurrent requests for Oracle Applications. See
the Oracle Applications Users Guide for instructions.

To generate PDF attachment for review:
1. Navigate to Control > Requests > Run.

The Submit a New Request window appears.

2. Select the Single Request radio button.

3. Click OK.

The Submit Request window appears.

4. Enter Generate Quote in the Name field using the List of Values (LOV).

The Parameters window appears.
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5. Choose the template set name from the Quote Template LOV.

6. Enter any of the following to limit the number of contracts to be generated:

Note: If you do not enter any values, the application generates the
communications for the entire database of contracts.

• If you wish to generate communications for an internal organization, then enter
the organization name using the Org LOV.

• For a single customer, choose the customer from the Party LOV.

• For a single contract, choose the contract number from the Contract Number
LOV.

7. Click OK to exit the Parameters window.

8. Click Submit.

The Decision window appears with the identification number of the request you
have submitted. Use this number to monitor the progress of your request.

9. Click No if you do not wish to submit another request.

10. Choose Requests from the View menu.

The Find Requests window opens.

11. Click Find to find the requests you have submitted.

The Requests window appears showing the status of your concurrent requests.

The Generate Quotes process you have submitted automatically launches the Service
Contracts Quote request. Both have to complete successfully for the communications
to be generated successfully.

12. Place your cursor in the line displaying the Service Contracts Quote process status.

13. Click View Output to display the generated communications in a separate browser
window.
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Viewing Sample Marked-Up Documents Provided with the Application
Oracle supplies sample templates in Oracle XML Publisher with XML name tags already
embedded. Use this procedure to view and download these documents.

To view the sample documents provided with your application:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Templates in the Navigator.

The Templates search page appears in a new browser window.

3. Enter %sample% in the Name field.

4. Choose Service Contracts from the Application List of Values (LOV).

5. Click OK.

6. The window displays the sample documents.

7. To download a document:

1. Select a link in the Name column.

The View Template page opens.

2. Click Download.
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3
Implementing Oracle Service Contracts

This section describes the setup forms and gives references that help you understand
the underlying dependencies.

The implementation section consists of the following topics:

• Confirming Setups of Oracle Applications, page 3-2

• Setting Up Service Contracts, page 3-8

This chapter covers the following topics:

• Confirming Setups of Oracle Applications

• Confirm Setup Steps

• Service Contracts Setups

• Defining Lookup Codes

• Registering in Quoting

• Mapping Time Units of Measure

• Setting Up Status and Operations

• Defining Quality Assurance Checklists

• Defining Access to a Category

• Defining Coverage Templates

• Coverage Template Fields

• Defining Coverage Types

• Defining Warranty Inheritance for Coverage

• Billing Rates Fields

• Defining Contract Groups

• Setting Up Contract Numbering

• Defining a Billing Profile

• Defining Service Availability

• Defining Service Cotermination

• Setting Up Service Billing

• Invoice Level Loading
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• Invoice Preview

• Setting Up Transaction Type

• Setting Up Batch Transaction Sources

• Setting Up Transaction FlexField Segments

• Setting Up Service Renewals

• Defining Renewal Notification Letters

• Defining Electronic Renewal Templates (Template Sets)

• Setting Up Renewal Events

• Setting Up System Profile Options

• Setup for Service Key Flexfields

• Setting Up Global Contract Defaults

• Setting Up Subscription Templates

• Service Contracts Setup Report

• Implementing Sales Territories to Assign Sales People

• Implementing Quick Menu

• Implementing Multi-Currency Price List Support

Confirming Setups of Oracle Applications
Complete the following steps in the order shown in this table:
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Required Step Title

Yes Set up System Administrator, page 3-3

Yes Define Key Flexfields, page 3-3

Yes Define Calendar, Currency, and Set of Books,
page 3-4

Yes Set up Organizations, page 3-5

Yes Set up Employees, page 3-5

Yes Set up Inventory, page 3-5

Optional Set up Bills of Material, page 3-6

Optional Set up Work in Process, page 3-6

Yes Setup Order Management, page 3-6

Yes Set up Advanced Pricing, page 3-6

Optional Set up TeleService, page 3-7

Optional Set up Knowledge Base, page 3-7

Optional Set up Notes, page 3-7

Yes Set up Resources, page 3-7

Yes Set up Install Base, page 3-7

Optional Set up Depot Repair, page 3-7

Yes Set up Oracle Contracts, page 3-8

Confirm Setup Steps

Step 1: Set Up System Administrator

This step involves the following tasks:

• Define responsibilities. See Oracle Applications System Administrator’s Guide.

• Set up printers (optional). See the topic about setting up printers in Oracle
Applications System Administrator’s Guide.

Step 2: Define Key Flexfields

When fully installing other applications, such as Oracle Human Resource Management
or Oracle Inventory, be sure to coordinate the flexfield setup for these products before
defining the key flexfields for this application. It is not recommended to change flexfields
frequently. For more information, see Oracle Applications Flexfields Guide.

For each key flexfield, perform the following tasks (some are optional):
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• Define the flexfield structure

• Define value sets

• Define flexfield segments

• Define flexfield segment values

• Define security rules

• Assign security rules

• Define roll–up groups

• Define cross–validation rules

Set up the following Accounting flexfield (you may not need to perform this step
if you have already installed and set up Oracle General Ledger or performed a
common–applications setup. For additional information, see Oracle General Ledger
User’s Guide.

Set up the following Human Resources key flexfields (you may not need to set up
these key flexfields if you have already installed and set up Oracle Human Resource
Management Systems or performed a common–applications setup. For additional
information, see Oracle Human Resources User’s Guide.

• Grade

• Job

• Position

• People Group

Step 3: Define Calendars, Currencies, and Set of Books

If you have defined your calendars, currencies, and set of books while setting up a
different Oracle Applications product, proceed to the next step. However, if you are
performing a Multi–Org implementation, see the note below.

Note: If you are performing a Multi–Org implementation, you
may optionally create more than one calendar, currency, or set of
books. See: Multiple Organizations in Oracle Applications.

This step involves the following tasks:

• Set up calendars.

• Define period types. See Defining Period Types in Oracle General Ledger User’s Guide.

• Define accounting calendar. See Defining Calendars in Oracle General Ledger User’s
Guide.

• Define transaction calendar. See Defining Transaction Calendars in Oracle General
Ledger User’s Guide. (Optional)

• Define workday calendar. See Overview of Workday Calendar in Oracle Bills of
Material User’s Guide. (Optional)

• Define exception templates. See Creating a Workday Exception Template in Oracle
Bills of Material User’s Guide. (Optional)

• Define currencies. See Defining Currencies in Oracle General Ledger User’s Guide.
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• Define conversion rate types. See Defining Conversion Rate Types in Oracle General
Ledger User’s Guide.

• Assign your set of books to a responsibility. See Assigning Responsibility to Set of
Books in Oracle General Ledger User’s Guide.

• Set up currency rates.

• Set up accounting code combinations. See Setting up Accounting Code
Combinations in Oracle General Ledger User’s Guide.

• Open and close accounting periods. See Opening and Closing Accounting Periods
in Oracle General Ledger User’s Guide.

Step 4: Set Up Organizations

You may not need to perform this step if you have already installed and set up Oracle
Inventory or performed a common–applications setup. For the following tasks relating
to setting up organization, see Oracle Human Resources User’s Guide.

• Define organization QuickCodes

Define business groups (if you want to define new business groups rather than using the
default Setup Business Group, see the section View–all Responsibility in: Setting Up
Security for Applications Using Some HRMS windows.

• Define organizations

• Define human resources organizations

• Define legal entities organizations

• Define Oracle users for operating–unit organizations

• Assign operating units to legal entities

• Set up inventory organizations. For the tasks relating to setting up inventory
organizations, see Oracle Inventory User’s Guide

• Define organization hierarchies. See Oracle Human Resources User’s Guide

• Assign business groups and operating units to responsibilities (make sure that the
profile option HR: Business Group is set at the responsibility level to the business
group for that responsibility. See Oracle Human Resources User’s Guide

Define profile options:

• MO: Security Profile

• Top Reporting Level

Step 5: Set Up Employees

If you do not install Oracle Human Resource Management Systems with Oracle Depot
Repair, use the Enter Employee form to define and maintain employees in Oracle
Purchasing, otherwise, the forms in Oracle Human Resource Management Systems are
used to enter and maintain employees.

Step 6: Confirm Setup of Oracle Inventory

Ensure that all the setups listed below have been reviewed and completed as
necessary. See Overview of Setting Up in the Oracle Inventory User’s Guide.
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Item flexfield, Account aliases flexfield, Receiving options, Unit of Measure classes, Stock
locators, Default category set, Item templates, Cost types, Material overhead
rates, Movement statistics parameters, Transaction types, Interface managers, Customer
items, Category, Sales orders flexfield, Picking rules, Transaction source types, Shortage
parameter, Unit of Measure, Item attribute controls, Statuses, Items, Cost
activities, Freight carriers, Economic zones, Transaction reasons, Profile
options, Customer items cross reference, Catalog group flexfield, Change
organization, ATP, Unit of Measure Conversion, Categories, Item catalog
groups, Accounting periods, Cross-reference types, Material sub-elements, Organization
shipping network, Account aliases, Purchasing options, Container types, Notification
list, Stock locator flexfield, Intercompany relations, Planners, Sub inventories, Category
set, Item types, Item delete constraints, Material overheads, Shipping method, and
Commodity codes.

Note: Prior to setting up Items in Oracle Inventory, you need to set up Coverage , page
3-12Templates and Subscription Templates , page 3-59in Oracle Service Contracts.

Step 7: Confirm Setup of Oracle Bills of Material

Ensure that all the following setups have been reviewed and completed as necessary. See
Overview of Setting Up in Oracle Bills of Material User’s Guide.

• Profile options, Workday calendar for organization, Resource
groups, Departments, Overheads with departments, Standard
instructions, Exception tables, Define parameters, Simulation sets, Resource
and resource shifts to departments, Alternates, Change order types, Workday
calendar, Resources, Locations, Overheads, Standard BOM comments, and Delete
constraints.

Step 8: Confirm Setup of Oracle Work in Process

Ensure that all the following setups have been reviewed and completed as necessary. See
Overview of Setting Up in the Oracle Work in Process User’s Guide.

• Profile Options, WIP parameters, WIP accounting class, Schedule Groups, Labor
Rates, Job and Schedule Documents, and Operation Documents.

Step 9: Confirm Setup of Oracle Order Management

Ensure that all the following setups displayed in the table below have been reviewed
and completed as necessary. See Overview of Setting Up in the Oracle Order Management
User’s Guide.

• Profile options, Sales persons, Workflow, Customer classes, Cost of goods
sold, Credit checking, Freight changes and carriers, Parameters, Tax, Document
sequences, Customers, Processing constraints, Holds, Pricing, Invoicing, Quick
codes, Order import sources, Transaction types, Defaulting rules, Attachments, and
Shipping.

Step 10: Confirm Setup of Oracle Advanced Pricing

While there may be a few, very limited, instances where a customer would not need
to use Oracle Advanced Pricing when implementing Oracle Service Contracts, in the
majority of situations it will be needed for discounts or price breaks. In addition, the
APIs which Oracle Service Contracts calls for pricing covered products are part of
Oracle Advanced Pricing and therefore the product is required if that feature will be
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used. Ensure that all the setups displayed below have been reviewed and completed as
necessary. See Overview of Setting Up in the Oracle Advanced Pricing User’s Guide.

• Profile options, Pricing attributes, Pricing lookup, Shipping lookup, Line
types, Freight cost, types, System sourcing, Qualifiers, Attribute sourcing, Order
Management lookup, Order types, Freight terms, Payment terms, and Event phasing.

Step 11:Confirm Setup of Oracle TeleService

Ensure that all the following setups have been reviewed and completed as necessary:

• Profile options, Service request types, Business processes, Lookup codes, Problem
and resolution codes, Billing types, Request status, Request severity and
urgencies, and Billing rates.

For more information, see the Oracle TeleService Implementation Guide.

Step 12:Confirm Setup of Oracle Knowledge Management

Ensure that all the following setups have been reviewed and completed as necessary:

• Profile Options, and Lookups.

For more information, see Oracle Knowledge Management Implementation Guide

Step 13:Set Up Notes

Ensure that all the following setups have been reviewed and completed as necessary:

• Profile Options, Source Type And Note Type Mapping, and Note Types.

For more information, see Oracle Common Application Components Implementation Guide.

Step 14:Set Up Resources

Ensure that all the following steps have been reviewed and completed as necessary:

• Profile Options, Lookup Codes, Roles, and Role Types.

For more information, see the Oracle Common Application Components Implementation
Guide.

Step 15: Confirm Setup of Oracle Install Base

Ensure that all the following setups displayed below have been reviewed and completed
as necessary:

• Counters, Estimation Methods, Profile options, Product types, System types, Lookup
codes, Split product reasons, Product status codes, and Customer product
configuration.

For more information, see Oracle Install Base Implementation Guide.

Step 16: Confirm Setup of Oracle Depot Repair

Ensure that all the following setups have been reviewed and completed as necessary:

Profile Options, Depot Repair Types, and Depot Repair Reason Codes.

For more information, see the Oracle Depot Repair Implementation Guide.
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Step 17: Confirm Setup of Oracle Contracts

Ensure that all the setups described in the Oracle Contracts Implementation and
Administration Guide have been reviewed and completed as necessary.

Service Contracts Setups
Follow the guidelines in this table for setting up Oracle Service Contracts.

Step Title

Defining Lookup Codes, page 3-9

Registering in Quoting, page 3-10

Mapping Time Units of Measure, page 3-10

Setting Up Status and Operations, page 3-11

Defining Quality Assurance Checklist, page 3-11

Defining Access to a Category, page 3-12

Defining Coverage Templates, page 3-12

Defining Contract Groups, page 3-23

Setting Up Contract Numbering, page 3-23

Defining a Billing Profile, page 3-23

Defining Service Availability, page 3-24

Defining Service Cotermination, page 3-25

Setting Up Service Pricing and Billing, page 3-26

Setting Up Service Renewals, page 3-34

Setting Up System Profile Options, page 3-36

Defining Key Flexfields, page 3-3

Setting Up Renewal Rule Defaults, page 3-52

Setting Up Subscription Templates, page 3-59

Setting Up Report, page 3-59s

Implementing Sales Territories to Assign Sales People, page 3-60

Implementing Quick Menu, page 3-62

Implementing Multi-Currency Price List Support, page 3-63
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Defining Lookup Codes
To locate Lookup Codes from the navigator, choose Service Contracts Manager > Setup
> Others > System > Lookups.

Use the list displayed in the table below to identify lookup codes (QuickCodes) you need
to define for your implementation. You can enter them in any order. Please follow the
standard procedure outlined in the Oracle Applications Users Guide.

Code Description

OKC_ARTICLE_SET Defines sets of articles

OKC_BILLING_RATE_CODE_RDF Billing rate code

OKC_CHANGE_REQUEST_STATUS Change request status

OKC_CONTACT ROLE Defines contact roles

OKC_CONTINGENT_EVENTS Contingent events

OKC_INHERITANCE_TYPE_RDF Inheritance type

OKC_PRICE_TYPE Pricing types

OKC_PROCESS_USAGE_TYPES Process usage type

OKC_REL_OBJ Related object types

OKC_LINE_RENEWAL_TYPE Defines renewals for line types

OKC_RENEWAL_PRICING_TYPE Defines renewal pricing types

OKC_RENEWAL_TYPE Defines renewal types

OKC_ROLE Party contact roles

OKC_RULE_DEF Rule definitions

OKC_RULE_DEF Rule group definitions

OKC_STATUS_TYPE Contract status types

OKC_SUBJECT Standard article subject types

OKC_TERMINATION_ REASON You must specify a reason for terminating a
contract

OKC_TIME Seeded time units of measure

OKC_WINDOW_TITLES Dynamic window titles

OKS_WHE_TYPE Warranty inheritance rule type

OKS_BILL_ACTIONS Billing action rules

OKS_MEDIA_DEF Invoice media definitions

Implementing Oracle Service Contracts 3-9



Code Description

OKS_SC_DISTRIBUTION Sales credit definition

OKS_SC_YES_NO Service Contracts yes/no

OKS_SVC_PERIOD Service periods

OKS_USAGE_TYPE Billing types for usage items

OKS_SUB_TYPE Available subscription type items

OKS_MED_PRTY_TYPE Subscription media and property types

Registering in Quoting
Service Contracts must be registered in Oracle Quoting, to enable contracts to be created
for any immediate services or delayed services, as well as, warranties and extended
warranties originating from Oracle Order Management.

Prerequisites
You must define Oracle Service Contracts as an application (System Administrator).

To register:
1. From the Navigator, choose Quoting Sales Manager > Quick Codes.

2. Query lookup: ASO_ORDER_FEEDBACK_CRM_APPS.

3. Enter the code OKS.

4. Enter Service Contracts as the code meaning.

5. Optionally, enter the description.

6. Enter the effective dates (from/to dates).

7. Save your work.

Mapping Time Units of Measure
Oracle Service Contracts defines unit of measure conversion for time differently from
other Oracle applications. This helps ensure that the scheduling is more accurate than
a simple conversion such as 1 month = 30 days, which is only correct for 5 out of the
12 months. To define your own time unit conversions for extending a contract or for
scheduling, you must define your own time unit conversions.

There are five internal time units: minutes, hours, days, months, and years. Make sure
to map each time unit you want to use in Oracle Service Contracts. An example of a
mapping: Day (your definition) = 1 day (base definition).

To map time Units of Measure:
1. Navigate to Service Contracts Manager > Setup > Contract > Units of Measure >

Time Units of Measure.
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2. Select a user unit of measure from the list of units of measure.

3. Select the base unit of measure that equals the user unit of measure.

4. If needed, enter conversion information.

5. Optionally, enter a description.

6. Save your work.

Setting Up Status and Operations
Oracle Service Contracts enables you to control the operations (such as update online
and delete contract) that can be performed on a contract depending upon the category
assigned to the contract when it is created and the status of the contract (such as active or
terminated). For example, if you define a new status for the status type Active, then
you have to make sure that you specifically allow operations such as online update. If
you create a new status without specifying any allowed operations, then you implicitly
allow no operations for this contract status. In order for the concurrent program Status
Change to automatically update contract status, you must define a default status for
each status type.

To define status and operations:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > Status

and Operations.

2. Select a status type.

3. Optionally, enter additional statuses for the status type, enter the text to display
in application windows in the Meanings field, and select the default status for the
contract when it first reaches the stage of the selected status type.

4. For each status, select every category, operation, and level (header or line level)
combination you want to relate to the status.

5. For each line you created in the Allowed Operations by Category section, select
Allowed to allow the operation. Clear Allowed to prohibit the operation.

6. Save your work.

Defining Quality Assurance Checklists
Service Contracts validates a contract before you can submit it for approval using a
quality assurance (QA) checklist. Each checklist consists of one or more processes
which have been defined in the Setup > Contract > Process Definition screen prior
to selecting them for the QA Checklist.

In addition to the seeded QA checklist, you can define additional checklists for Service
Contracts. The seeded QA checklist is executed automatically for any contract, in
addition to any other checklist you may wish to run against the contract. You cannot
modify or update the default checklist. If you create an additional checklist and would
like it to default to your contracts during authoring, make sure to set the profile options
OKS: Default QA Checklist.
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To define a quality assurance checklist:
1. Navigate to Service Contracts Manager > Setup > Contract > Quality Assurance.

2. Enter a name and a description.

3. In the Processes region, select the process that will become a part of the QA checklist.

4. Make sure the Active check box is selected.

5. From the Severity list, select one of the following levels:

• Warning: The contract passes Approval.

• Stop: The contract does not pass Quality Assurance if this process fails

6. Optionally, override the default values for the parameters.

7. Save your work.

Defining Access to a Category
A category is a type of contract, such as a service agreement, subscription agreement, or
warranty contract. Contract categories are seeded in Oracle Service Contracts and do
not need to be set up. User defined categories are not supported for Service Contracts
because certain processes in the application are dependent upon data being present that
may be missing in a user defined category. The structure of the contract is conducive
to the needs of the industry for which the module is designed and enables a more
functionality rich application. Responsibilities that have been defined need to be
assigned access to a category before they can read or modify service contracts.

Prerequisites
You must define the Responsibilities in System Administrator

To define access to a category:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract >

Categories and Sources> Define Categories.

2. Hit F11 to enter the query mode.

3. Select Service Agreement for Class. The class you select determines what authoring
window is used.

4. In the Responsibilities tab, select the responsibilities to which you wish to grant
access and assign access level rights to the responsibilities along with effective dates.

5. Save your work.

Defining Coverage Templates
Service coverage describes the situations under which the customer is covered for
service. Services are broken down into business processes, which are related the service
(such as Customer Support or Depot Repair). Coverage Terms are then defined for these
business processes. The information you enter to define coverage terms include:

• Coverage Details: This includes coverage name, type, importance level, effective
dates, warranty inheritance, and so on.
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• Coverage Times: The days of the week and hours during the day that the customer
can request service. The coverage times are defined for each business process as part
of coverage terms, and are applicable to one time zone.

• Reaction Times: The amount of time allowed by which action must be initiated for
a particular process being requested.

• Resolution Times: A fixed time per contract by which a normal operation should
be restored. The Resolution Times will be made available to other functions (for
example, Service Request).

• Resources: This is the list of resources that are eligible to work on a specific task when
a service request is created. Resources can be classified as Primary, Preferred, or
Excluded.

• Billing Types and Rates: For each Business Process, define what type of work is
covered, to what limit and at what rate. The billing types and rates are used when
calculating the amount to charge a customer when work has been performed.

Prerequisites
The following must be defined:

• Coverage Type Lookup Code (Service Contracts)

• Business Processes (Customer Support)

• Price List (Order Management)

• Time Zone

• Service Request Severity (Customer Support)

• Resource Types (Customer Support)

• Resources (Customer Support)

• Billing Types (Customer Support)

• Billing Rates (Customer Support)

• Preventive Maintenance Program with the Complete Status (Oracle Complex
Maintenance, Repair, and Overhaul)

References
For using Coverage Templates, see the Coverage Templates section., page 2-6

For setting up a Preventive Maintenance program, see the Managing Maintenance
Routes section of Oracle Complex Maintenance, Repair, and Overhaul User’s Guide.

Guidelines
To sell a service contract, at least one coverage template must be created and linked to
the service items, defined in Oracle Inventory. You should define one coverage template
for each of your service offerings.
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Coverage Template Fields
From the Navigator, choose Service Contracts Manager > Coverage Templates. You can
change Coverage Name, Description, Suitable as Exception check boxes, and Exception
Coverage on the coverage template. When editing coverage from the contract, you
cannot change coverage dates, Suitable as Exception, and Warranty fields.

The following table displays the fields and field descriptions for the Coverage Template
window.

Field Description

Coverage region -

Name Enter a name for the coverage template. A
duplicate coverage name is not allowed.

Type Select the type of coverage such as
Gold, Silver, or Bronze from the list of values.

Importance Level Displays Importance Level of the selected
Coverage Type. The Importance Level is
mapped to the Coverage Type and is a numeric
indication of coverage priority, with highest
priority being number one. The Importance
Level helps the customer care agent select
the appropriate coverage in the event that an
entitlement call returns multiple coverages.

Effective Dates If the coverage template should only be valid
for a certain time frame, enter a date range for
the Effective Dates. The effective Start Date is
required and the End date is optional.

Description Use the Description field to enter brief
description for the coverage.

Exception Exception coverage is applicable between
the time that coverage expires and the time
it is renewed. Optionally, select an exception
coverage from the list of values.

Suitable as Exception When creating a coverage template, you can
identify the selected coverage as Suitable as
Exception for another coverage. When another
coverage template is created, the LOV for
Exception would show the coverage template
identified as ’Suitable as Exception’.
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Field Description

Line Details Click the Line Details button to open the
Line Details form. When reviewing a service
request, this option enables the customer
care agent to view the covered level details
and compare the products covered under the
contract with those that are related to the
service call.

Note:

• The Line Details button is active only
when the contract coverage is viewed from
the Service Request form. It is disabled
when you create or update a coverage
template.

• The Line Details function provides
only view capabilities. To make
any changes, use the appropriate
responsibility.

Notes Click the Notes button to open the Note
page. See the Coverage , page 2-89Template
Note section for additional information.

Warranty If applicable, select the Warranty check
box. If selected, Warranty Inheritance
may be entered. In the case of a coverage
template, the Warranty check box can be
updated. However, if an Inheritance has been
entered in conjunction with the Warranty
check box, the Inheritance must be set to
NULL before the Warranty check box can be
unchecked. Billing Types may be set up for
warranties as for any other type of coverage.

Inheritance If the warranty should continue when the
product is replaced, select the inheritance
criteria. The duration of the warranty on
the replaced product is determined by the
inheritance type you select. You can select:

• Remaining Duration: By selecting
this option, the replacement product’s
warranty is the remaining duration of the
original warranty.

• Full New Duration: The replacement
product’s warranty is a brand new
warranty duration.
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Field Description

Synchronize Date Installed Select the Synchronize Date Installed check
box, if you want to set the warranty start date
to be the same as the installation date. When
a product installation date is changed, Service
Contracts checks for contracts that cover that
product. For every service that covers the
product, the coverage definition is checked for
warranty coverage that has the attribute set to
allow the installation date synchronization. If
this option is selected, Service Contracts
checks whether any service request has been
logged on dates that would be outside the
warranty period if it were changed to start
on the new installation date. If no service
request exists, the warranty start date is
changed to the installation date. To preserve
the original duration of the warranty, the end
date is also changed. The effect of the change
is automatically cascaded to the coverage
definition.

Free Upgrade Select the Free Upgrade check box, if you want
to track this coverage as having a free upgrade.

This flag does not provide any automated
functionality at this time.
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Field Description

Transfer A customer product can be transferred from
one owner to another and the changes are
cascaded to install base, warranty, extended
warranty and service agreement.

The Transfer flag on coverages would
determine the status of the contract in case of
transfer of a customer product from one owner
to another.

Select one of the following transfer options
from the list of values:

No Change: There would not be any changes
in the existing owners contract. No new
contract is created for the new owner.

Terminate: The current contract subline is
terminated. The termination date would be the
transfer date. No new contract is created for
the new owner.

Terminate if Not Related: If the new owner is
related to the current owner, no changes are
made to the contract. If the parties are not
related, the current contract is terminated. The
termination date would be the Transfer date.

Transfer: The current contract subline is
terminated with the Termination date set to
Transfer date. If the Contract Transferred is
a Warranty Contract, then a Contract for the
new Owner is created in Active Status. If the
Contract transferred is an Extended Warranty
or Service Contract, a contract is created for the
new owner in the status defined by the profile
option OKS: Transfer Status. The contract will
have a one-time billing schedule and advance
billing.

Transfer if Not Related: If the new owner is
related to the current owner, this option would
keep the current owners contract in force. If
the owners are not related, the current contract
is terminated and a contract for the new
owner is created. If the contract transferred
is a Warranty contract, then the new contract
is created in the Active status. If the contract
transferred is an Extended Warranty or Service
type contract, the contract will have an advance
one-time billing schedule and the status of the
contract would be defined by the profile option
OKS: Transfer Status.

Preventive Maintenance - Program Name If applicable, select a Preventive Maintenance
program from the list of values. The list
of values displays all programs, with the
Complete status.

Preventive Maintenance programs are created
in Oracle Complex Maintenance, Repair, and
Overhaul.
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Field Description

Preventive Maintenance - Program Description Displays the description for the Preventive
Maintenance program.

Schedule button The Schedule button is enabled only when a
Preventive Maintenance program is associated
to the coverage template. Click this button to
open the Preventive Maintenance Schedule
form and view or modify the information
related to the selected Preventive Maintenance
program.

Business Process region -

Business Process Select a Business Process from the list of
values. For example, Hotline, or On-Site
Support.

Offset Duration Enter the offset duration or amount of time
you would like the service to be offset from the
authored contract’s start date. For example, set
onsite support to start one month after the
contract comes into effect and set hotline
support to be available immediately.

Offset Period Specify the unit of measure for the offset
duration, such as hour or day. If the Offset
Duration is modified, the Start and End dates
are automatically adjusted as long as they’re
within the range of the service coverage
dates, and conversely, if the Start and End
dates are modified, the Offset Duration is
automatically adjusted.

Start and End Dates These dates are automatically inserted when
you specify an offset period. The transaction
group dates may not be outside of the service
dates. If the Offset Duration is modified, then
the start and end dates are automatically
adjusted as long as they’re within the range of
the service coverage dates, and conversely, if
the start and end dates are modified, the offset
duration is automatically adjusted.

Price List Select the default price list that should be used
when billing service charges, from the list of
values.

Discount Enter the percentage of discount allowed for
the transaction group, for example 10%, from
the list of values.

Coverage Times tab -
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Field Description

Time Zone Select a Time Zone from the list of values. You
can define more than one time zone for
each business line. However, it is required
to define, at least, one time zone for every
business process line.

Default Time Zone Select the Default check box to specify the
time zone as the default for the business
process. You can set only one time zone as the
default for a specific business process.

Apply Default to Other Time Zones To apply the Default coverage times to any
other time zone for which you have not entered
any coverage times, select the Apply Default to
Other Time Zones check box.

Start Time and End Time For every time zone, enter the Start Time, End
Time, and select the check box for the
applicable days.

For a given business process, the coverage time
for at least one day must be entered. You can
enter multiple coverage times for a specific
time zone record. You can also define multiple
coverage times for the same day, as long as the
coverage time records do not overlap.

Valid time values range from 00:00 to
23:59. Leaving blanks indicates that there is no
coverage for a given day.

Always Covered If applicable, click the Always Covered button
to set the Start Time and End Time for all days
to 00:00 and 23:59 respectively.

Reaction Times tab -

Severity Name Enter a name for the severity definition, for
example, Level 1 or Important.

Severity Select the level of severity, for example
High, from a list of values.

Work Through Select the Work Through check box, to
override the normal coverage times for that
transaction. For example, suppose you have
9-to-5 support, Monday through Friday, with
a 2-hour reaction time. If a customer calls
midweek for support at 4:45 P.M., and Work
Through is checked, the customer is entitled
to receive support by 6:45 that evening. If the
Work Through option is not selected, then the
support representative has until 10:45 the next
morning to respond to the call.
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Field Description

Active Select the Active check box to indicate
this severity level is active and to make
these reaction times available through an
entitlements call. This allows you to easily
switch between different severity definitions.

Reaction Times Enter specific reaction times, in hours, for each
applicable day.

Workflow Select the applicable workflow for each
reaction time name specified.

Resolution Times tab -

Severity Name Enter a name for the severity definition, for
example, Level 1 or Important.

Severity Specify the level of severity, for example
High, from a list of values.

Work Through Select the Work Through check box, to override
the normal coverage times for that transaction.

Active Select the Active check box to indicate
this severity level is active and to make
these reaction times available through an
entitlements call. This allows you to easily
switch between different severity definitions.

Resolution Times Enter specific resolution times, in hours, for
each applicable day.

Resources tab -

Type Select a resource type from the list of
values. For example, Engineer.

Name Use the Name field to identify the resource by
name.

Classification Select the proper classification for the resource
from the list of values. You can classify a
resource as Preferred, Primary or Excluded. If
you classify a resource as Excluded, the
Assignment Manager removes the resource
from the list of available resources.

Billing Types tab -

Service Activity Billing Type Select the billing type from the list of
values. Duplicates are not allowed. If the
billing type is Labor, then the Billing Rates
button is enabled showing Flat Rate field.
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Field Description

Up To Amount Enter the maximum allowed amount. If you
leave this field blank, the upper limit would
only be restricted by the percentage covered or
discount you enter in the % Covered field.

% Covered Enter the percentage covered or discount.

Allow Full Discount When checked on the template, provides 100%
coverage for warranties without requiring
setup of billing types. If unchecked on the
template, the box will be grayed out on the
contract. Any bill types data populated on the
template will override the use of this check
box.

Billing Rates If you select Labor as the Service Activity
Billing Type, the Billing Rates button is
enabled. Click the Billing Rates button to open
the Billing Rates form, page 3-22.

Defining Coverage Types
Use the Coverage Types window to define Coverage types and associated Importance
Level. The same Coverage type code cannot be defined twice. Importance Level must be
a numeric value. Once a code is defined, the field is disabled on the Coverage Types
window. Coverage Types defined as lookups with lookup type OKSCVETYPE have been
migrated to the Coverage Types window.

To define coverage types:
1. Navigate to the Coverage Types window: (N) Service Contracts Manager > Setup

> Contract > Define Coverage Types

2. Code: Enter an alphanumeric code.

3. Coverage Type: Enter a name for the coverage type.

4. Description: Enter a description for the coverage type.

5. Importance Level: Enter the importance level (numeric value). In the Coverage
window the importance level will be automatically displayed, once the Coverage
Type is selected.

6. Effective Dates From: Effective Dates From defaults to the system date.

7. Effective Dates To: Enter a date in the Effective Dates To field, if applicable. The
date in the Effective Date From field should be less than or equal to the date in the
Effective Date To field.

8. Save your work.

Defining Warranty Inheritance for Coverage
In the Service Contracts Coverage Template you can set inheritance criteria that
determines how the warranty coverage should behave, when a product is replaced. This
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is applicable only to Warranty lines, so the Warranty check box must be selected before
you can enter information in this field. Inheritance types are:

• Full New Duration: The Full New Duration type means the replacement part
receives a new warranty for the full duration of the covered period.

• Remaining Duration: The Remaining Duration type means the warranty on the
replacement part is good for the remainder of the original warranty duration.

Example:

• A warranty exists on a desktop PC (serial # 123) from 1/1/2001 - 12/31/2001.

Desktop serial # 123 is returned for a replacement with serial # 456 on 3/3/2001.

Scenario 1: Warranty inheritance type is Remaining Duration

In this scenario, the above warranty would be updated as follows:

Desktop warranty on serial # 123 would run from 1/1/2001 - 3/2/2001 (Expired)

A new warranty line would be created on the contract to cover desktop PC serial #
456 for the remainder of the original warranty from 3/3/2001 - 12/31/2001

Scenario 2: Warranty inheritance type is Full New Duration

In this scenario, the above warranty would be updated as follows:

Desktop warranty on serial # 123 would run from 1/1/2001 - 3/2/2001 (Expired)

A new warranty line would be created on the contract to cover desktop PC serial #
456 for a full year from 3/3/2001 - 3/2/2002 2

Billing Rates Fields
Use the Billing Rates form to review and update the Regular and Holiday billing
rates. Billing rates control the discounts that should be applied when work is performed
under contract. For example, if new parts have been installed to fix a problem at a
customer site, the bill for the work needs to be calculated, taking the coverage on the
service contract into account. If parts are covered 50% up to a maximum of $300, and the
charge for parts was $800, after applying the rates agreed on the contract, the charge
would be calculated as $500, after the maximum discount of $300 has been applied. For
the same contract rates, if the charge for parts came to $500, the customer would receive
the full 50% discount ($250) since the discount is below the $300 maximum.

The following table displays the fields and field descriptions for the Billing Rates form.
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Field Description

Start Time and End Time For every labor item, enter the Start Time, End
Time, and select the check box for the
applicable days.

Labor Item Select the Labor Item from the list of values.

Description The system displays the description for the
labor item.

Bill Rate Select the Billing Rate Name from the list of
values. For example, Normal, Double, and
Overtime.

Flat Rate Enter the rate for the labor item.

UOM Enter the unit of measure for the Flat Rate. For
example, Day and Hour.

% Over Price List Enter the allowed percentage over the list price.

Defining Contract Groups
Contract groups are used to logically group contracts into folders for easy access and
may be defined as private or public. For example, a set of contracts may be grouped by
customer or by persons administering the contracts. In addition, a contract may exist in
multiple groups. The system requirement is that at least one group must be defined
for the contract. Contracts created via integration with Order Management as well as
warranties created when a product is created in the Install Base are assigned a contract
group based on the information provided in the Global Contract Defaults. When
manually authoring contracts, any contract group can be selected from the list of values
on the Summary > Administration tab under Groups.

From the Navigator, choose Service Contracts Manager > Contract Groups > Define
Contract Groups.

For more information please refer to Contract Groups in the Oracle Contracts Core
User Guide.

Setting Up Contract Numbering
Service Contracts supports the same contract numbering processes used by Contracts
Core. Ranges of numbers, prefixes and/or suffixes, manual numbering, and number
lengths maybe set up for different business groups, operating units, classes or
categories. For guidance on how to set up automatic and manual contract number, see
Oracle Contracts Core implementation Guide.

Defining a Billing Profile
All customer account information is set up in Oracle Receivables, which includes a
single billing profile that is applicable when invoicing all customers. You can set
up multiple, ad hoc billing profiles in Oracle Service Contracts. Billing profiles
include information about accounting and invoicing rules, type of billing, and its
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frequency. Invoices are generated according to the billing profile attributes. The billing
engine accesses the billing profile and bills accordingly.

You can use the billing profile to overwrite any existing line level billing schedule
information on the contract authoring form by selecting it in the Cascade Attributes
form. You can also default billing profile information onto the contract by associate a
billing profile template to a customer in the Global Contract Defaults form.

Prerequisites
The following options must be defined:

• Accounting Rules

• Invoicing Rules

• Billing Levels

• Recurring Intervals.

To define billing profiles:

1. Navigate to Service Contracts Manager > Setup > Contract > Billing Profile

2. Enter an alphanumeric profile number.

3. Enter the profile description.

4. Select an Accounting Rule from the list of values.

5. Select an Invoicing Rule from the list of values.

6. Select a Billing Level from the list of values.

7. Select One Time or Recurring as the Billing Type option.

8. For the Recurring billing, select a billing Interval from the list of values, for
example, Month.

9. In the Invoice Offset field, enter the number of days to move forward or push
back the invoice date.

10. In the Interface Offset field, enter the number of days to move forward or push back
the date that the billing period will interface to Oracle Receivables.

Guidelines

A billing profile should be defined according to the billing requirements. If multiple
customer accounts have different billing requirements, the number of billing profiles
should be defined accordingly. There are no restrictions on the number of billing profiles.

Defining Service Availability
Service availability is used to define the available services for service
programs, warranties, and extended warranties. Exceptions can be listed for parties
and for products. The Generally Available check box determines whether the entries in
Product and Party tabs are inclusions or exclusions. By selecting the Generally Available
check box for a service, all products and parties listed will be excluded from receiving
that service. By leaving the Generally Available check box unselected, the products and
parties listed will be the only ones eligible to receive that service.
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Prerequisites
You must define Service items as well as Serviceable Products in Oracle Inventory
and define Parties in Oracle Receivables.

To define service availability:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract >

Service Availability.

2. Select a service item from the LOV.

3. Access the Party tab and select the Generally Available check box (if applicable).

4. Enter the effective dates.

5. Select a Party from the LOV.

6. Enter the start and end dates.

7. Access the Product tab and select the Generally Available check box (if applicable).

8. Enter the effective dates.

9. Select a Product from the LOV.

10. Enter the low and high item revision numbers (if applicable).

11. Enter the start and end dates.

12. Save your changes.

Defining Service Cotermination
The Service Cotermination option enables you to set any or all of a customer’s service
lines to a pre-determined end date. You can set up the Service Cotermination for
Parties or Systems. When using Cotermination for a party, set up the Cotermination as
described below. Then when selling service to that party, either in Service Contracts
or in Order Management, the end date of the services can be set to the established
cotermination date. In Service Contracts you would do this by clicking the Coterminate
or Coterminate All buttons on the Lines> Effectivities tab. See Oracle Order Management
User’s Guide for guidance on how to coterminate service sold on sales orders.

The system level Cotermination is set up in Customer Support and will apply to any
new items added to the system going forward.

Prerequisites
You must define the parties and their customer accounts in advance.

To define service cotermination for party level:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > Service

Cotermination.

2. Select a Party from the list of values. The corresponding customer account is
displayed.

3. Enter the cotermination day.

4. Enter the cotermination month.
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5. Save your work.

To define service cotermination for system level:

1. From the Navigator, choose Customer Support > Installed Base > Maintain
Systems.

2. Select a System from the list of values.

3. Enter the cotermination day.

4. Select the cotermination month.

5. Save your work.

Setting Up Service Billing
This topic covers the following set up processes for service billing:

• Invoice Level Loading (Parallel Worker), page 3-27

• Invoice Preview, page 3-27

• Setting Up Transaction Type, page 3-28

• Setting Up Batch Transaction Sources, page 3-31

• Setting Up Transaction Flexfield Segments, page 3-34

The procedures for executing service contract billing involve the following concurrent
requests:

• Service Contracts Main Billing: According to pricing attributes set up in the contract
and billing schedule, detailed transactions are generated in the Service Contracts
billing interface table.

• Autoinvoice Import Program: The billing transactions are then imported into Oracle
Receivables.

• Service Contracts Fetch Receivables Info for Billing. This concurrent request obtains
the invoice number and tax from Oracle Receivables, and updates the contract billing
history. This information is displayed in the contract’s billing history.

These processes should be set to run on a periodic basis, the frequency of which
is dependent on your billing policy. For more information on running these
processes, see the Executing Main Billing section., page 2-101

Prerequisites
You must define the following:

• Transaction Types (Oracle Receivables)

Credit Memo Batch Sources (optional) (Oracle Receivables)

Grouping Rules (optional) (Oracle Receivables)

Service items Inventory (Oracle Inventory)

Applicable service items must be included on one or more price lists (Oracle
Order Management)

Party and Customer Accounts (Oracle Receivables)
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Invoice Level Loading
The Service Contracts Main Billing process utilizes Invoice Level Loading, a parallel
program to assign groups of invoices to different concurrent programs. The program
first determines the COUNT for all of the contract lines that qualify for the master
request submission. If the COUNT is greater than the threshold value (currently set to
500) the program splits up the master request into sub requests. There is no setup for
this functionality other than to enable the profile option. For more details, see the
OKS: Parallel Worker profile option, page 3-36.

Invoice Preview
Before sending billing transactions directly to Oracle Receivables, you have the option of
previewing the invoice information to ensure it is accurate. When initiating the billing
process, it can be set to place the transactions into a separate set of Service Contracts
tables. These tables will mirror the billing transaction tables used during the normal
main billing process.

Guidelines:

If necessary, you can create a simple report to access the required information in these
tables.

The tables used for Invoice Preview are:

oks_bcl_pr

oks_bsl_pr

oks_btn_pr

oks_bsd_pr

oks_btl_pr

The preview process will run in much the same way as the normal billing process. It
will include only those contracts that meet the same criteria that need to be met to
be included in the actual contract billing process (for example, status is eligible for
invoicing, bill on date is due). The process will not include invoices for services not
covered under contract and not normally billed by the Contracts application (for
example, time and material charges).

If potential billing errors are found during the preview, you can make adjustments
manually in the appropriate application, for example, Oracle Service Contracts or Oracle
Install Base, and re-run the pre-invoice report. This iterative process would continue
until the pre-invoice process gives the expected results, at which point you may choose
to run the actual billing process.

The billing process would use the latest data in calculating the invoices, so it should be
recognized that the actual invoices created may be different from those included in the
last pre-invoice process, if there is sufficient delay between running the process and the
actual billing process. Changes may have occurred such as counters updated, contracts
terminated, new products added to coverage, all of which will affect the actual invoices
created from the Contracts application.

Contracts data (for example, contract statuses) will not be automatically updated as a
result of running the pre-invoice process. For example, to identify them as ready to bill
or not.
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The process will include the same information that would normally be sent to Oracle
Receivables during the actual billing process. Service Contracts sends either detailed
or summary information to Oracle Receivables, depending on the value of the
OKS: Summary Transactions profile option.

Setting Up Transaction Type
Transaction types are used to define the accounting for the debit memos, charge
backs, commitments, and invoices you create in Oracle Receivables. Transaction types
also determine whether your transaction entries update your customer’s balances and
whether Oracle Receivables posts these transactions to your general ledger. To bill from
Service Contracts, transaction types must be defined for invoices and credit memos.

To Set Up Transaction Types for Invoices and Credit Memos:
These steps are case sensitive and must be entered exactly as described.

Invoice Transaction Type
1. From the Responsibilities menu, choose Receivables Manager > Setup > Transactions

> Transaction Types.

2. Enter a transaction name: Invoice-OKS (this OKS transaction type is case sensitive
and must be entered as: Invoice-OKS). Optionally enter a description.

3. Select Invoice as transaction class for this transaction type.

4. Select the Open Receivable check box. This updates your customer balances each
time you create a complete debit memo, chargeback, or on–account credit with this
transaction type. Oracle Receivables also includes these transactions in the standard
aging and collection processes.

5. Select the Post To GL check box to be able to post transactions with this type to
your general ledger.

6. Choose a default Printing Option for transactions with this transaction type. Select
Print or Do Not Print. You can override this value when entering transactions.

7. Choose a Transaction Status of Open, Closed, Pending, or Void. Use these statuses to
implement your own invoice approval system.

8. Optionally select the Allow Freight check box to allow freight to be entered for
transactions with this transaction type.

9. Select the Tax Calculation check box to let Oracle Receivables calculate tax for
transactions with this transaction type.

10. Choose a Creation Sign. If you are using the Cash Basis accounting method, your
transaction’s creation sign must be either Positive or Negative. You cannot update
this field after you enter transactions with this type.

11. If you want to restrict the direction in which items with this transaction type can be
updated by applications entered against them select the Natural Application Only
check box. If you select this box, Oracle Receivables sets Allow Overapplication to
No. You cannot update this option after you save this transaction type.

12. Enter an Application Rule Set for this transaction type or select one from the list
of values (optional). An Application Rule Set determines the default payment
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steps when you use the Applications window or AutoLockbox to apply receipts to
transactions using this type. If you do not enter a rule set, Oracle Receivables uses
the rule set in the System Options window as the default.

13. If you did not select the Natural Application Only check box, choose whether to
Allow Overapplication against items with this transaction type by selecting or
deselecting this box. If you select this check box, Oracle Receivables sets Natural
Application to No and you cannot update it after you save this transaction type. If
you use the Cash Basis accounting method, the default value is No and you cannot
change it.

14. Enter the Receivable Account for transactions with this transaction type. Oracle
Receivables uses this information, along with your AutoAccounting definition, to
determine the receivable accounts for transactions with these types. Oracle
Receivables creates a transaction record using this account so you can transfer to
your general ledger and create a journal entry if the Post To GL check box is selected
for this transaction type.

15. Enter a Freight Account for transactions with this transaction type. Oracle
Receivables uses this information, along with your AutoAccounting definition to
determine the freight account for transactions with this transaction type. Oracle
Receivables skips this field if the Allow Freight check box is not selected.

16. Enter a Revenue Account for transactions with this transaction type. Oracle
Receivables skips this field if the Allow Freight is not selected. Oracle Receivables
uses this information, along with your AutoAccounting definition, to determine the
revenue account for transactions with this transaction type.

17. Enter a Clearing Account for transactions with this transaction type. Oracle
Receivables uses this account to hold any difference between the revenue amount
specified for the Revenue Account and the selling price times the quantity for
imported invoice lines. Oracle Receivables only uses the Clearing Account if you
have enabled this feature for transaction sources that you use for your imported
transactions.

18. Enter an Unbilled Receivable Account. When you use the Bill In Arrears invoicing
rule, Oracle Receivables uses this information, along with your AutoAccounting
definition, to determine the Unbilled Receivable account for transactions with
this transaction type.

19. Enter an Unearned Revenue Account. Oracle Receivables uses this
information, along with your AutoAccounting definition, to determine the unearned
revenue account for transactions with this transaction type. Oracle Receivables only
uses this account when your transaction’s invoicing rule is Bill In Advance.

20. Enter a Tax Account. Oracle Receivables uses this information along with your
AutoAccounting definition to determine the tax account for transactions with
this transaction type.

21. Enter the Credit Memo Type to use when crediting items with this transaction type
(optional). When you enter a credit memo against an invoice with this transaction
type, the value you enter here is the default credit memo transaction type.

22. Enter the range of dates that this transaction type will be active. The default Start
Date is today’s date, but you can change it. If you do not enter an End Date, this
transaction type will be active indefinitely.

23. Save your work.
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Credit Memo Transaction Type

1. From the Responsibilities menu, choose Receivables Manager > Setup >
Transactions > Transaction Types.

2. Enter a transaction name: Credit-OKS (this OKS transaction type is
case sensitive and must be entered as: Credit-OKS). Optionally enter
a description.

3. Select Credit Memo as transaction class for this transaction type.

4. Select the Open Receivable check box. This updates your customer balances
each time you create a complete debit memo, chargeback, or on-account
credit with this transaction type. Oracle Receivables also includes these
transactions in the standard aging and collection processes.

5. Select the Post To GL check box to be able to post transactions with this
type to your general ledger.

6. Choose a default Printing Option for transactions with this transaction
type. Select Print or Do Not Print. You can override this value when
entering transactions.

7. Choose a Transaction Status of Open, Closed, Pending, or Void. Use these
statuses to implement your own invoice approval system.

8. Optionally select the Allow Freight check box to allow freight to be entered
for transactions with this transaction type

9. Optionally select the Tax Calculation check box to let Oracle Receivables
calculate tax for transactions with this transaction type.

10. Choose a Creation Sign. If you are using the Cash Basis accounting
method, your transaction’s creation sign must be either Positive or
Negative. You cannot update this field after you enter transactions with
this type.

11. If you want to restrict the direction in which items with this transaction type
can be updated by applications entered against them, select the Natural
Application Only check box. If you select this box, Oracle Receivables sets
Allow Overapplication to No. You cannot update this option after you
save this transaction type.

12. Enter an Application Rule Set for this transaction type or select one from the
list of values (optional). An Application Rule Set determines the default
payment steps when you use the Applications window or AutoLockbox
to apply receipts to transactions using this type. If you do not enter a rule
set, Oracle Receivables uses the rule set in the System Options window
as the default.

13. If you did not select the Natural Application Only check box, choose
whether to Allow Overapplication against items with this transaction type
by selecting or deselecting this box. If you select this check box, Oracle
Receivables sets Natural Application to No and you cannot update it after
you save this transaction type. If you use the Cash Basis accounting
method, the default value is No and you cannot change it.

14. Enter the Receivable Account for transactions with this transaction
type. Oracle Receivables uses this information, along with your
AutoAccounting definition, to determine the receivable accounts for
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transactions with these types. Oracle Receivables creates a transaction record
using this account so you can transfer to your general ledger and create a
journal entry, if the Post To GL check box is selected for this transaction type.

15. Enter a Freight Account for transactions with this transaction type. Oracle
Receivables uses this information, along with your AutoAccounting
definition to determine the freight account for transactions with this
transaction type. Oracle Receivables skips this field if the Allow Freight
check box is not selected.

16. Enter a Revenue Account for transactions with this transaction type. Oracle
Receivables skips this field if the Allow Freight is not selected. Oracle
Receivables uses this information, along with your AutoAccounting
definition, to determine the revenue account for transactions with this
transaction type.

17. Enter an Unbilled Receivable Account. When you use the Bill In Arrears
invoicing rule, Oracle Receivables uses this information, along with your
AutoAccounting definition, to determine the Unbilled Receivable account
for transactions with this transaction type.

18. Enter an Unearned Revenue Account. Receivables uses this
information, along with your AutoAccounting definition, to determine
the unearned revenue account for transactions with this transaction
type. Receivables only uses this account when your transaction’s invoicing
rule is Bill In Advance.

19. Enter a Tax Account. Receivables uses this information along with your
AutoAccounting definition to determine the tax account for transactions
with this transaction type.

20. Enter the range of dates that this transaction type will be active. The default
Start Date is today’s date, but you can change it. If you do not enter an End
Date, this transaction type will be active indefinitely.

21. Save your work.

Setting Up Batch Transaction Sources
Batch sources control the standard transaction type assigned to a transaction and
determine whether Oracle Receivables automatically numbers your transactions and
transaction batches. Active transaction batch sources appear as list of values choices in
the Transactions, Transactions Summary, and Credit Transactions windows.

You can define two types of transaction batch sources:

• Manual: Use manual batch sources with transactions that you enter manually in
the Transaction and Transactions Summary windows.

• Imported: Use imported batch sources to import transactions into Oracle Receivables
using AutoInvoice. Batches are automatically numbered with the batch source
name - request ID.

You can make a batch source inactive by deselecting the Active check box and saving
your work. Oracle Receivables does not display inactive transaction batch sources as list
of values choices or let you assign them to your transactions.

Suggestion: If you have installed multiple organization support (multi–org), define an
imported batch source with the same name in each organization (these sources can have
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the same or different settings). This enables you to import order lines that belong to
different organizations in Oracle Order Management into Oracle Receivables.

To set up batch transaction sources:
1. From the Responsibilities menu, choose Receivables Manager > Setup > Transactions

> Sources.

2. Select the Batch Source tab.

3. Enter OKS_CONTRACTS as the name.

4. Select Imported as the type.

5. Enter a description.

6. Enter the range of Effective Dates for this source. The Start date is the current
date, but you can change it. If you do not enter an end date, this transaction batch
source will be active indefinitely.

7. Select the Automatic Transaction Numbering check box and enter a Last Number to
automatically number new transactions you create using this source. You can use
automatic transaction numbering with both Imported and Manual sources.

8. Select the Copy Document Number to Transaction Number check box (optional) to
use the same value for both the document number and the transaction number for
transactions assigned to this source.

9. Enter Invoice-OKS as the Standard Transaction Type for this batch source. When
you choose a batch source during transaction entry, this is the default transaction
type. You can define new transaction types in the Transaction Types window.

10. Select the AutoInvoice Options tab.

11. Specify how you want AutoInvoice to handle imported transactions that have Invalid
Tax Rates. An invalid tax rate is one in which the imported transaction’s tax rate does
not match its tax code. Enter “Correct” if you want AutoInvoice to automatically
update the tax rate that you supplied to the one that you defined previously for the
tax code. Enter “Reject” if you want AutoInvoice to reject the transaction.

12. Specify how you want AutoInvoice to handle imported transactions with Invalid
Lines by entering either “Reject Invoice” or “Create Invoice.”

13. Specify how you want AutoInvoice to handle imported transactions that have
lines in the Interface Lines table that are in a closed period. To have AutoInvoice
automatically adjust the GL dates to the first GL date of the next open or future
enterable period, enter “Adjust” in the GL Date in a Closed Period field. This
attribute is called “GL Date in a Closed Period.” Enter “Reject” to reject these
transactions.

14. Enter a Grouping Rule to use for a transaction line (optional). If you do not enter
a grouping rule, AutoInvoice uses the following hierarchy to determine which
rule to use:

• The grouping rule specified in the Transaction Sources window for the batch
source of the transaction line.

• The grouping rule specified in the Customer Profile Classes window for the
bill–to customer and bill–to site of the transaction line.
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• The grouping rule specified in the Customer Profile Classes window for the
bill–to customer of the transaction line.

• The default grouping rule specified in the System Options window.

15. If you want AutoInvoice to require that the revenue amount for each transaction
line is equal to the selling price times the quantity specified for that line, select the
Create Clearing check box. Use this option to distribute revenue on a transaction
in an amount that is not equal to the transaction line amount. If you select this
check box, AutoInvoice puts any difference between the revenue amount and the
selling price times the quantity for a transaction into the AutoInvoice Clearing
account that you have defined. Otherwise, AutoInvoice requires that the revenue
amount be equal to the selling price times the quantity for all of the transactions it is
processing. Define your clearing account in the Automatic Accounting window.

16. Indicate whether sales credits can be entered for transactions using this source by
selecting or deselecting the Allow Sales Credit check box. This option and the
Require Salesreps option in the System Options window determine whether sales
credits are optional or required.

17. Select the Customer Information tab.

18. Select "Id" for each option to indicate that AutoInvoice validates your customer
information for this batch source using an identifier. Choose Value if you use this
source to import data from a non–Oracle system.

19. Select the Accounting Information tab.

20. Select “Id” to indicate how AutoInvoice validates your Invoice and Accounting
Rule data for this batch source.

21. Select “Id” to indicate whether you want AutoInvoice to validate the identifier
for this batch source.

22. Select the Derive Date check box to derive the default rule start date and default GL
date from the ship date, rule start date, order date and the default date that you
supply when you submit AutoInvoice. If Oracle Inventory is installed, this must
be selected.

23. Select “Id” to indicate that AutoInvoice validates your Payment Terms for this
batch source using identifiers.

24. Select “Percent” to indicate that AutoInvoice validates your Revenue Account
Allocation data for this batch source.

25. Select the Other Information tab.

26. Select “Id” to validate other data except for Agreement, Sales Territory, and Related
Document.

27. Select the Sales Credit Validation tab.

28. Select “Id” for first two options to validate information using identifiers for this
batch source.

29. Select Percent to validate sales credits based on percent.

30. Save your work.
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Setting Up Transaction FlexField Segments
Transaction flexfields are descriptive flexfields that AutoInvoice uses to uniquely
identify transaction lines. Oracle Receivables lets you determine how to build your
transaction flexfield structure and what information you want to capture. To define the
line-level Transaction Flexfield, query “Line transaction Flexfield” in the title field of
the Descriptive Flexfield Segments window and enter the text and segments associated
with this transaction flexfield.

The table below shows the values for the transaction flexfields.

Column Name Segment Name Value Set Req

INTERFACE_LINE_
ATTRIBUTE1

CONTRACT_
NUMBER

OKS_K_NUMBER Y

INTERFACE_LINE_
ATTRIBUTE2

CONTRACT_MODIF
IER

OKS_K_NUMBER N

INTERFACE_LINE_
ATTRIBUTE3

INSTANCE_NO CE_NUMBER30 Y

INTERFACE_LINE_
ATTRIBUTE4

BILLED_FROM CE_DATE Y

INTERFACE_LINE_
ATTRIBUTE5

BILLED_TO CE_DATE Y

INTERFACE_LINE_
ATTRIBUTE6

AMOUNT CE_NUMBER30 Y

To set up transaction flexfield segments:
1. From the Responsibilities menu, choose System Administrator > Application >

FlexField > Descriptive > Segments.

2. Select Oracle Receivables as the application and Line Transaction Flexfield for
the Title.

3. Deselect the Freeze Flexfield Definition check box (otherwise you cannot create a
new record).

4. Select OKS CONTRACTS in the Context Field Values region.

5. Click Segments to edit the definition.

6. Enter the values listed in the above table. Note: These must be entered in upper case.

7. Compile the flexfield by selecting Compile.

8. Select the Freeze Flexfield Definition check box to freeze the definition.

Setting Up Service Renewals
To set up service renewals:

• Define Renewal Notification Letters, page 3-35

• Define Electronic Renewal Templates, page 3-35

3-34 Oracle Service Contracts Concepts and Procedures



• Set Up Renewal Events, page 3-35

Defining Renewal Notification Letters
Oracle Service Contracts supports two ways of creating renewal notification letters:

• You can create the text of the e-mails and attachments using Microsoft Word (or
other software capable of producing RTF files) and use Oracle Service Contracts’
integration with Oracle XML Publisher to create the templates used by the electronic
renewals process. To use this preferred method you must set the system profile
OKS: Layout Template Source to XML Publisher at the Site level. For details about
creating the e-mail communications using this method, see Creating and Enabling
Templates for E-Mails to Customers, page 2-134.

• Use the XML reporting functionality from Contracts Core. If you are planning to use
this method set the system profile OKS: Layout Template Source to Standard at the
Site level. This is the default setting. For guidance on how to create XML reports, see
Oracle Contracts Core Implementation Guide.

Defining Electronic Renewal Templates (Template Sets)
Use the Template Set form to define an electronic renewal template. This form includes a
field for status code at the header level and for each report defined at the lower portion. A
status defined at the header level will be used as part of Electronic renewals. When an
e-mail along with quote is sent to the customer, the status will be used to update the
contract status for which the quote is sent. An interaction will be logged. For each report
(reminder notice) that is added to a template set, you can define lead days and have the
option to select a status code that contracts will be updated to, when the reminder notice
is sent to the customer. If no status code is selected for a report, then no update would be
made to the contract status when Service Contracts Autoreminder program runs.

The steps for creating a template are:

• Navigate to the Template Set form. (N) Setup> Contracts> Define Electronic
Renewal Template

• Name: Enter a name for the template set.

• Description: Enter a description for the template set (optional).

• Start and End Dates: Enter the start and end dates for the template set (optional).

• Quote Letter: Select a quote letter from the list of values.

• Cover Letters: Select a cover letter from the list of values.

• In the Report section of the form, enter the necessary information.

• Save your work.

Setting Up Renewal Events
Events can be set up to track contract renewals automatically and take appropriate
action on the expiring contracts. For more information, see the Entering a Condition
section of Oracle Contracts Core User Guide.
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You also need to set up the required concurrent programs to run periodically, to check
the conditions and events to trigger the renewal process. For further information, see
MetaLink Note # 223708.1 - Service Contracts Auto Renewal Setup Steps.

Setting Up System Profile Options
Use this list to identify profile options you need to change for your implementation. You
can set these profile options in any order you like. You can access the profile option
window by navigating to: Service Contracts Manager > Control > Profile Option.

To change profile options, please follow the standard procedure outlined in the Oracle
Applications Users Guide.

Option Sample Values Required Description

Sequential
Numbering

Partially Y Sequential
Numbering assigns
numbers to
documents created
by Oracle Financial
products and provides
a method of checking
whether documents
have been posted
or lost. This profile
option must be set at
the application level
to Always Used. Do
not set this option
at the Responsibility
level.

OKC: Batch size 1 N Determines the
number of records
to be updated before
they are saved
in the database
(this parameter
should be fine-tuned
by the database
administrator).

OKC: Change Request
Approver

Able, Marsha N This profile identifies
the default change
request approver,
which would override
the workflow
approver.

OKC: Contract
Approver

Sysadmin N This profile identifies
the default contract
approver, which
would override the
workflow approver.
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Option Sample Values Required Description

OKC: Public Group
Creator

Able, Marsha N Users assigned to
this profile would
be able to create a
public group in Oracle
Service Contracts.

OKC: Renewed
Contract Identifier

R N This identifier will be
a prefix attached to
the system date and
shown as a modifier
on the renewed
contract.

OKC: Schedule Rule
Alert Window

3 N The number of days
before a task is due
that the user is notified
of an upcoming task.

OKC: Schedule Rule
Escalate

1 N The number of days
after an incomplete
task’s due date when
escalation begins.

OKC: Time UOM
Class

Time Y Limits the units in
the Map Time Units
window. Note: This is
case sensitive and
Time should be
entered using the
exact case.

OKC: View Contracts
By Organization

Yes Required for multi-
org installation

By setting this profile
option to Yes, users
would only have
visibility to contracts
that are authored in
the operating unit that
is associated to their
responsibility.

QP: Time UOM
Conversion

Oracle Contracts N Allows users to price
for service based on
the calendar, as used
by Service Contracts,
or the standard
Oracle Applications
conversion. If set to
Service Contracts,
pricing will take the
calendar into account,
including irregular
length months or leap
years.
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Option Sample Values Required Description

OKS: Billing Schedule
Level

Top Level N Defines the default
level for billing
schedules. You can:

• Define billing
periods with
complete control
of dates and
amount (Equal
Amount).

• Define billing
periods so that
Service Contracts
calculates the
amount (Top
Level).

• Define billing
dates and
amounts to be
charged for each
period for each
covered level
(Covered Level).

OKS: Check Coverage
Match

Yes N Set this profile
option to Yes, to
force the renewal
consolidation process
to preserve differences
in coverage between
source and target
contracts.

OKS: Contracts
Validation Source

Install Base N Defines the
organization
information that
should be referenced,
when creating a
warranty contract
from Oracle Order
Management.
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Option Sample Values Required Description

OKS: Credit Card
Display Privileges

Limited N Determines how
much of a customer’s
credit card number is
displayed on screen.
Valid values are:

• All: Complete
credit card
number is
displayed.

• Limited: The last
four digits are
displayed.

• None: The card
number is not
displayed.

OKS: Credit Card
Validation Level

Validate N Used by the QA
process to determine
whether to validate
the entered credit
card number,
by calculating
the checksum
or obtaining an
authorization.

OKS: Counter
Validate

Yes N If set to Yes, only
counter readings that
are marked as being
valid in Install Base
are considered for
billing. If set to No, all
counter readings are
considered for billing.

OKS: Debug Error Log No N If set to Yes, it will
generate a debug
file. Should remain set
to No, unless directed
by a support analyst.

OKS: Default Line
Style

Service Y Defines the default
line style of a service
contract. Only
Service, Extended
Warranty, Warranty,
Subscription, and
Usage line styles are
supported for Service
Contracts.
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Option Sample Values Required Description

OKS: Default Pricing
Date

Subline start date N Defines the date
used to determine
the correct price
list and pricing
effectivity. Valid
values are Contract
Subline (covered
level) Start Date,
Contract Signed Date,
Contract (header)
Start Date, System
Date, or Top Line
(service line) Start
Date. The default is
the System Date.

OKS: Default QA
Checklist

Default Y Specifies the QA
checklist to be
used as the default
when authoring new
contracts. This profile
option applies only
to new contracts that
are created during
authoring.

OKS: Default Time
Zone

America/New_York N Defines the default
time zone for
business process
while authoring a
contract.

OKS: Electronic
Renewal URL

http:// webpage.
yourcorp.com:port/
jtflogin.jsp

N Setup the URL for
the web page that
will be provided
to customers for
Electronic Renewals.
Customers can use
the web page to
review and respond to
renewal notifications.

OKS: Enable Install
Base Integration
Notifications

Y N Determines if
notifications, from
Install Base, are
enabled when a
warranty or extended
warranty is created or
updated.

OKS: Notify
User of Install
Base Integration
Notifications

Able, Marsha N Identifies the user to
be notified whenever
a warranty or
extended warranty
is created or updated
in Install Base.
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Option Sample Values Required Description

OKS: Enable Negative
Invoicing

Yes N Set to Yes, to enable
negative amounts
on invoices. If set to
No, negative values
are invoiced at zero
value.

OKS: Enable Sales
Credits

Derive N When renewing a
contract, determines
Sales Person, Revenue
Type Distribution,
Revenue Type, and
Vendor Contact.

If set to Derive,
upon renewal of the
contract, this profile
option will refer to the
following other profile
options to obtain
information with
which to populate the
new contract:

• Sales Person
(unless OKS: Use
Territories to
Default Sales
Representative is
set to Yes)

• Revenue Type
Distribution

• Revenue Type

• Vendor Contact.

If set to
Retain, existing
information will
be copied into the
renewed contract.

If set to Drop,
none of this
information will
populate in the
new contract.
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Option Sample Values Required Description

OKS: Enable Grace
Period

Yes N Indicates whether
users should be able
set up a Grace Period,
when authoring or
updating a contract.
This site level profile
option defaults to No,
which causes Grace
Period fields on the
Contracts Authoring
form to be grayed out.
If set to Yes, users can
populate the Grace
Duration and Grace
Period fields.

OKS: Item Display
Preference

Description Y Specifies the display
order in the list of
values for Inventory
items when selecting
Covered Products or
Covered Items, while
creating a subline in
the Authoring form.

OKS: Mass Change
Security Level

Basic Y Defines list of update
levels available to the
user when making
mass change. If set
to Basic, then only
the Contract and
Contract Group level
can be selected for
updates. If set to
Advanced, users can
perform mass change
updates at all levels.

OKS: Credit Card
Minimum Authorized
Amount

100 N Defines minimum
amount to block
during credit card
authorization,
if Credit Card
Validation Level is
set to Authorize.
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Option Sample Values Required Description

OKS: Layout Template
Source

Standard N Specifies the method
you wish to use to
create the e-mail
renewal notices sent
by the electronic
renewals process:

• XML Publisher:
Permits you to
create the text
of the e-mail
communications
to customers
using software
capable of
producing an
RTF file, such as
Microsoft Word,
and use Oracle
Service Contract’s
Integration
with Oracle
XML Publisher
to create the
templates.

• Standard: You
must use the
XML reporting
capablility
supplied by
Oracle Contracts
Core. This is the
default setting.

OKS: Minimum
Service Duration

1 N Defines the minimum
duration of a service
for cotermination. If
a service program
sets its cotermination
date for duration less
than the minimum
service duration, then
the service program
honors the minimum
service duration
to determine the
cotermination date.
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Option Sample Values Required Description

OKS: Minimum
Service Period

1 N Defines the minimum
period of a service
for cotermination. If
a service program
sets its cotermination
date for duration less
than the minimum
service duration, then
the service program
honors the minimum
service duration
to determine the
cotermination date.

OKS: Notify Contract
Administrator

Marsha Able Required for
reassignment of sales
reps

Identifies the
administrator to be
notified if unable to
reassign the sales
representative on the
contract.

OKS: Notify Sales
Administrator

Marsha Able Required for
reassignment of sales
reps

Identifies the
administrator to be
notified if the sales
representative setup is
incomplete.

OKS: Notify Territory
Administrator

Marsha Able Required for
reassignment of sales
reps

Identifies the
administrator to be
notified if the territory
setup is incomplete.

OKS: Parallel Worker Yes N Defines how the
Service Contracts
Main Billing
concurrent program
is run for efficient
performance. If set
to Yes, will spawn
multiple concurrent
requests for Service
Contracts Main Billing
program, when the
billing load exceeds
500 lines.

OKS: Payment
Method for AR
Interface

Credit Card N Captures the payment
method for a customer
for integration with
iPayment Server.
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Option Sample Values Required Description

OKS: Raise Credit
Memo for IB Instance
Termination

Yes N Determines if a credit
memo is raised when
a contract subline
is terminated due
to transfer, return,
or termination of a
customer product in
Install Base.

OKS: Reprice Warning
Message

Yes N Used to suppress the
warning message
while repricing or
manually overriding
the final price. If set
to No, the warning
message "This action
is irreversible. Do you
wish to Continue?"
will be suppressed.
Default value is set to
Yes.

OKS: Revenue Type
Distribution for Sales
Credit

100 N Used to set the credit
percentage on a
renewed contract for a
sales representative.
In order to pass QA,
revenue distribution
for a renewal contract
must be 100%. If OKS:
Enable Sales Credits is
set to No, this profile
option will be ignored.

OKS: Revenue Type
for Sales Credits

Quota N This Profile Option
is for setting the
Sales Credit type, for
example quota or non-
quota, for creating the
sales credits during
renewal. If OKS:
Enable Sales Credits
is set to Drop, this
profile option will be
ignored.
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Option Sample Values Required Description

OKS: Default Sales
Person for Renewal

Able, Marsha N Sets the default sales
person for sales credits
on a renewed contract.
It also populates this
name in the Vendor
Contact in the Party
Contact Role. If the
profile option OKS:
Use Territories to
Default Sales Person
is set to Yes, the
sales representative
is retrieved from
resource management
instead of this profile
option. If OKS: Enable
Sales Credits profile
option is set to Drop,
this profile option is
ignored.

OKS: Service Request
Creator

Able, Marsha Y

(if using automated
service request
creation)

Sets default username
for automated
creation of service
requests.

OKS: SMTP HOST xyx.oracle.com Required for e-mail
quote

Identifies name of
the outgoing mail
server used to deliver
external e-mail
notifications. This
is a required profile
for e-mail quotes.

OKS: SMTP PORT 25 Required for e-mail
quote

Identifies SMTP port
number used by the
SMTP server defined
in OKS: SMTP Host
profile option. This is
a required profile for
e-mail quotes.

OKS: Summary
Transactions

Yes Y If not specified at the
contract header level,
this determines if the
summary or detailed
transactions are sent
to Oracle Receivables.
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Option Sample Values Required Description

OKS: Territory Sales
Person for First Year
Contracts

Retain N Determines whether
the application uses
sales territories to
assign sales agents
(vendor contacts of
role Salesperson) to
new contracts created
from orders in Oracle
Order Management.

By default this system
profile is set to
Retain, causing the
application to copy
the sales person on the
order.

A setting of Derive
uses sales territories to
assigns one resource
as a vendor contact of
type Salesperson to
each contract.

OKS: Use Territories
to Default Sales
Person

Y N Determines whether
to use Territories
to default the sales
representative for a
renewed contract. If
set to No, the sales
representative is
retrieved from OKS:
Default Sales Person
for Renewal. If set to
Yes, it will retrieve
the sales person
assigned by territory.
Territories must be
setup if this profile
is set to ’Yes.’ This
profile must be set to
’Yes’ if using Reassign
Resources concurrent
request. If OKS:
Enable Sales Credits
is set to ’Drop,’ this
profile option is not
used to populate the
sales person renewal
agreement.
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Option Sample Values Required Description

OKS: Use Advanced
Pricing for Manual
Adjustment

Yes N Controls integration
with Advanced
Pricing for manual
override of the final
price. If set to No,
Advanced Pricing
will not be used to
create or derive price
adjustments. If set to
Yes, Advanced Pricing
will be used to derive
price adjustments. All
adjustments will
be stored in Oracle
Service Contracts and
can be viewed via the
pricing adjustment
screen. Default value
is Yes.
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Option Sample Values Required Description

OKS: Vendor Contact
Role

Admin N Sets the role for
creating contacts
during contract
renewal. Select any
role from the list of
values to be added to
the party role contacts,
which will be copied
from the expiring
contract. This profile
option populates only
the role. The person
assigned to this role
is named in the
profile option OKS:
Default Sales Person
for Renewal. The
Concurrent Process
for Reassigning
Resources looks to
the Vendor Contact
Role of SalesPerson to
validate the name
of the sales rep
indicated in the
territory assignment.
Therefore, consider
setting this profile
option to SalesPerson.
If OKS: Use Territories
to Default Sales
Person is set to yes and
the vendor contact
role is SalesPerson,
this party role contact
name may be changed
to match the territory
assignment. If OKS:
Enable Sales Credit is
set to no, this profile
option will be ignored.

OKS: Category for
Order Management
Originated Contracts

Service N Determines the
contract category for
Order Management
originated contracts.
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Option Sample Values Required Description

OKS: Subscription
Item Filter

All N Determines which
items the user
can select in a
subscription line
under a subscription
agreement. If the
value is set to
Subscription, only
subscription items
can be selected. If
the value is set to
All, the user can select
any subscription
or products (except
service warranty and
usage items) at the
subscription line.

OKS: UOM Code Each N Sets the Unit of
Measure (UOM) code
for covered party, site,
system, and customer.

OKS: Contact Center
Date Range

30 Y (for viewing
contracts from the
Contact Center)

Controls the date
range of contracts that
can be viewed from
the Contact Center.
Enter the number
of days prior to the
current date.

OKS: Default Order
Type for Subscriptions

Mixed Y (if using tangible
subscriptions)

Defines order type
for subscription line
orders.

OKS: Intangible
Subscription Pricing
Method

Subscription Based N Determines the
pricing method
for Intangible
Subscription items.
Pricing method can be
set to Effectivity based
or Subscription based.

OKS: Transfer Party
Relationship

PARTNER Y Used to specify the
relationship that
would identify related
parties during the
transfer management
process. If this
relationship does
not exist between the
parties, the parties are
considered unrelated.
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Option Sample Values Required Description

OKS: Transfer Status ACTIVE Y Used to specify the
default contract
status for the new
contract(s) after a
covered product or
system is transferred.

OKS: Update Contract
with Install Base
Quantity

Yes Y Determines if the
contract covered
product quantity is
updated as a result
of the update to item
instance quantity in
Install Base.

OKS: Usage Billing
Calculation

Actual Y Determines whether
’Default’ or ’Actual’
counter readings to be
considered in Usage
billing computation.

OKS: Wallet Path N When the
environment is
set up for HTTP
communications
over SSL, a wallet
is required to make a
HTTPS request. This
profile specifies the
directory path where
the wallet is saved
and that wallet will
be used in the E-mail
Quote functionality.
Wallet password is
appended to this path
with a ’$$’ prefix in the
format ’path$$pswd’.

OKS: Consolidate
Warranty for Multiple
Order

No Y Determines if an
order for products
with warranties or
extended warranties,
sold in Order
Management, should
be consolidated
when the service
contract is created.
Similar warranties or
extended warranties
are grouped on a
single contract rather
than creating separate
contracts.
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Option Sample Values Required Description

OKS: Full Credit for
Product Return

Yes N Determines if a full
or partial credit
should be issued
when a subline is
terminated as a result
of a customer product
return.

OKS: Merge System
Transfers

Yes N Determines if
contracts covering
multiple products in
a system are merged
into a single contract.

Setup for Service Key Flexfields
This key flexfield allows pricing attributes to be stored at the covered product level in
the contract authoring form. This function is available from the Actions menu.

Key Flexfield Registration

To register key flexfields:
1. Log on to Application Developer.

2. Navigate to Flexfields > Key > Register.

3. Double Click Register to open Key Flexfields form.

4. Enter Oracle Inventory as the Application.

5. Enter the code: SERV.

6. Enter the title: ORACLE_SERVICE_ITEM_FLEXFIELD.

7. Enter a description: Item Flex Field that displays segments in different sequence.

8. Enter the Table Application: Oracle Inventory.

9. Enter the Table Name: MTL_SYSTEM_ITEMS_B.

10. Enter the Unique ID Column: INVENTORY_ITEM_ID.

11. Enter the Structure Column: ORGANIZATION_ID.

12. Deselect the Dynamic Inserts Feasible check box.

13. Select the Check Allow ID Value Sets check box.

14. Save your work.

Setting Up Global Contract Defaults
If renewal rules are not specified in Order Management, a contract will be created
without any renewal criteria. To renew a contract, renewal criteria should be retrieved
from the defaults defined at the contract, event, party, organization, and global
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levels. The Renewal Event evaluates the renewal criteria in the following precedence
and applies them to a renewed contract:

• Contract

• Event

• Party

• Organization

• Global

If a specific rule is not found at a given level, it is retrieved at the subsequent level and
ultimately at the global level if they do not exist in the other levels. In any case, the
renewed contract would have all the elements required for renewal and repricing and to
submit the contract for approval.

Use the Renewal Rule Defaults form to set up renewal defaults at the system, party, and
organization levels. You can set up the defaults at the system level in the Global region
of the form. The defaults at the organization and party levels are set up in the Parties
and Organization tabs respectively. The Administration tab is the same for both.

To set up global defaults:
1. Navigate to Service Contracts Manager > Setup > Contract > Global Contracts

Defaults. The system displays the Global Contracts Default window.

2. The following table displays the fields and field descriptions for the Global
Contracts Default window.

Field Description

Global Region -
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Field Description

Renewal Type Select the Renewal Type from the drop down
list. The valid values are:

• Notify Sales Rep: This will send a
notification to the sales rep, based
on the territory in which he/she
resides, to facilitate the renewal. For
example, when the sales rep needs
to negotiate the pricing with the
customer prior to sending the
contract for approval.

• Submit for Approval: This will
create a renewed contract in an
entered state awaiting review and
approval before it can become
active. If the autorenewal process
has been implemented, a contract
with an Active Contract renewal
type will either become signed or
active, depending on whether the
start date has passed. If the contract
has not passed QA however, it will
remain in an entered state.

• Active Contract: The renewal
event automatically approves and
activates the contract.

• Do Not Renew: When the contract
expires, no further action is taken.

• Electronic Renewal: Places the
renewed contract into the Entered
status and sends a notification
to both the sales representative
and the customer. The customer
receives notification in the form
of an e-mail with a link to a
web page. From that page, the
customer can review the quote and
accept, reject, or request changes to
the renewed contract.

PO Required Select the PO Required check box to specify
that a purchase order is required during the
renewal process. If selected, the renewal
cannot be sent for approval without a
purchase order.

Interface Price Break check box Use this option to control the interface of
price breaks details to Oracle Receivables.
Select the Interface Price Break check box if
you want the price break details to be sent to
Oracle Receivables during billing. The Price
break information includes quantity, unit
price, and amount.
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Field Description

Pricing Method Select the pricing method from the list. This
determines how pricing is to take place in
contracts during renewals. The valid values
are:

• Price List: Renewal pricing is based
on the current price list.

• Markup Percent: Renewal pricing
is based on a markup percentage
(%) and a cap price list. For
example, last year’s negotiated
markup % is subject to a capped
list price.

• Manual: Renewal pricing uses last
year’s negotiated price.

Price List If either the Price List or Markup Percent
method is selected, then the Price List field
is enabled. Select a Price List from the list
of values.

Markup % If the Markup Percent Method is selected,
then the Markup% field is enabled. This
represents the percentage that is to be used
to markup or markdown the contract lines
during contract renewal. The value may be
entered as a positive or negative percent.

Approval Workflow Select the approval workflow from the
list. This workflow is used to approve the
renewed contract

Role Select a Role from the list of values. The
valid values include:

• Customer

• Merchant

• Subscriber

• Third party

QA Checklist Select the QA checklist from the list. This
checklist will be used to QA the renewed
contract.

Help Desk Select the Help Desk E-mail account that
should receive notifications when an
Electronic Renewal contract notification
cannot be sent to a customer due to problems
with the contract renewal.

Template Set Select the Template Set that will be used for
electronic renewals.

Billing Profile Select the Billing Profile that will be used for
electronic renewal contracts.
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Field Description

Contract Group Region -

New Order Select a group from the LOV for New
Order. Any contract that is created from a
sales order will be placed in this group.

Renewal Select a group from the list for Renewal.
Renewed contracts will be placed in this
group

Revenue Region -

Estimated % Enter the percentage revenue for Estimated
%. This is an estimate to be achieved for the
renewed contract.

Duration Enter Duration. This represents the duration
before the expiration of the contract for
when it is predicted the percentage revenue
will be achieved.

Period Select the period from the list of values.

Grace Region Use the Grace region to set up a standard
grace period for the contracts that are
renewed.

Duration Enter the duration for grace period.

Period Enter the period type. For example, Day or
Month.

Credit Card Threshold Region Use the Credit Card Threshold region to
specify a threshold amount that would
make credit card the only available method
of payment. In the Credit Card Threshold
region, enter the threshold Amount and
Currency type.

Active Threshold Region Use the Active Threshold region to set
a threshold amount for Active renewals
such that all contracts below the threshold
amount would renew and invoice customers
automatically. In the Active Threshold
region, enter the threshold Amount and
select the Currency type.

Electronic Renewal Region -

Enable Select the Enable check box to enable
Electronic Renewals.
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Field Description

Payment Terms for Credit Card Use the Payment Terms for Credit Card field
to set up the default payment terms for credit
card orders. When customers log into the
portal web page to respond to an Electronic
Renewal notification, they may select the
Credit Card payment method in the process
of accepting the contract renewal. When the
Credit Card payment method is selected, the
payment term that is entered in this field
is defaulted as the payment terms on the
contract.

Threshold Currency and Threshold Amount Enter the Threshold Currency and Threshold
Amount, if the Enable check box has been
selected. The amount entered will be
the threshold amount used to determine
whether or not a contract qualifies for
Electronic Renewals. All contracts having a
total value less than or equal to the amount
entered will generate an Electronic Renewal.

Organizations - Renewal Rules Tab This tab is used to specify the renewal and
pricing attributes at the organization level.

Organization Select the Organization number from the
list of values. The Organization Name is
automatically displayed.

Start and End Dates Enter the effective Start and End dates
for the organization. These fields are
mandatory. The end date must be greater
than the start date.

Renewal Type Select the renewal rules per Global
defaults. In this tab, the renewal and pricing
rules are optional.

Organizations - Admin Tab The Organization Name and effective Start
and End dates are displayed. Select the
Contract Group, QA Checklist, Approval
Workflow, and Role. These values are
optional.

Organizations - Revenue Tab The Organization Name and effective Start
and End dates are displayed.

Enter the Revenue Estimated %, Duration,
Period, Credit Card Threshold Amount, and
Currency type. These values are optional.

Organizations - Electronic Renewal Tab The Organization Name and effective Start
and End dates are displayed.

Enter the Threshold Amount and
Currency, Payment Terms for Credit
Card, Help Desk Email, Template Set, and
Billing Profile. These values are optional.
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Field Description

Organizations - Preferences Tab The Organization Name and effective Start
and End dates are displayed.

Enter the Active Threshold Amount and
Currency type, Grace Duration, and Period
type. These values are optional.

Parties Tab Use the Parties tab to specify the renewal
and pricing attributes at the party level.

Parties - Renewal Rules Tab -

Party Number Select the Party Number from the list of
values. The Party Name is automatically
displayed.

Start Date and End Date Enter the effective Start and End dates. These
dates are mandatory. The end date must be
greater than the start date.

Renewal Type Select the Renewal Type and Pricing
Method. If applicable, enter the Markup%
and Price List. These values are optional.

Parties - Admin Tab This tab has the same administration
attributes as the Organization - Admin tab.

Select the QA checklist, Approval Workflow
and Role. These values are optional.

Parties - Revenue Tab The Organization Name and effective Start
and End dates are displayed.

In the Revenue region, enter the Estimated
percent, Duration, and Period. These values
are optional.

In the Credit Card Threshold region, enter the
Currency type and threshold Amount. These
values are optional.

Parties -Electronic Renewal Tab The Organization Name and effective Start
and End dates are displayed.

Select the threshold Amount and Currency,
Help Desk Email, Template Set, and Billing
Profile. These values are optional.

Parties -Preference Tab The Organization Name and effective Start
and End dates are displayed.

Enter the Active Threshold Amount and
Currency type. These values are optional.

Enter the Grace Duration and Period
type. These values are optional.
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Setting Up Subscription Templates
Subscription items are created in the Inventory Master Items form. Before creating the
subscription items, a Subscription Template must be created. The subscription template
will control the fulfillment of the subscription.

To set up subscription templates:
1. Open the Subscription Template form by navigating to Service Contracts Manager >

Subscription Template.

2. In the Name filed, enter a name for the template.

3. In the Description field, enter a description for the template.

4. In the Subscription Type field, select the type of subscription such as
Journals, Magazines, and News Letters from the list of values.

5. In the Media Type field, select the type of medium such as Document, Image, and
Audio from the list of values.

6. In the Fulfillment Channel field, select of one the following options:

• Order Management: for tangible items that need to shipped

• None: for intangible items

7. In the Frequency field, select one of the following subscription frequency options:

• Daily

• Weekly

• Monthly

• Yearly

8. Enter any additional information in the Comments field.

Service Contracts Setup Report
The Service Contracts Setup Report is a diagnostic tool provided to facilitate debugging
the issues reported in Oracle Service Contracts. This report also helps in implementing
Service Contracts by summarizing the set ups. A comprehensive report is provided on
the setup done in any application environment. This report not only summarizes all the
setups at one place, but also provides information on any mandatory setup that need to
be done in that environment for Service Contracts to function effectively. This report is
part of the Oracle Service Contracts and is applicable only to Service Contracts.

To run the Service Contract Setup report:
1. From the responsibility menu, choose Service Contracts Manager >Request >Run>

Single Request.

2. In Name choose “Service Contracts Setup report.”

3. Click Submit.

The report can be viewed from the “View Output” of the concurrent request. The
output of this report is in PDF format and it gives all the setups done for the Service
Contracts Module. If any of the setups are mandatory and are not set, the report
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will highlight them in red. This report consists of mandatory and non-mandatory
settings.

• Profiles Setup: This section provides a list of User Profile Option Names and
Values set for them. If any of the mandatory settings are missing or not properly
set, they will be highlighted in Red. The Profile Setup values and Mandatory
column are as follows.

• Transaction Type Setup: For this setup, the report checks for Batch Transaction
Source OKS_CONTRACTS and Transaction Type “Invoice-OKS” and
“Credit-OKS.”

• Service Key Flexfield Setup: Verifies whether the key Flexfield Code SERV
has been set up.

• Category Setup: Displays the categories and responsibilities that have been
setup and the access level for Service and Warranty Categories.

• Oracle Quoting Integration Setup: Oracle Service Contracts must be set for
Order Quoting Integration.

• Time Units Mapping: The report displays the user defined time code units.

• Global Contracts Defaults: The report shows the values in the Global Contracts
Defaults setup.

• Coverage Template Setup: Shows any coverage templates that have been
defined for warranty as well as service item.

• Statuses and Operations: Displays all the contract statuses and operations
for each status type.

Implementing Sales Territories to Assign Sales People
You can set up sales territories using Oracle Territory Manager to have the application:

• Automatically assign sales agents as vendor contacts to new contracts created
from Oracle Order Management orders.

By default, service contracts created through Oracle Order Management carry over
the sales person on the sales order as the vendor contact for the contract itself. Using
the procedures described here you can instead use sales territories to assign the sales
agent to the contract. This feature is most useful for customers that use different
organizations for selling and renewing service contracts.

• Automatically assign new sales agents to contracts after personnel changes and
reorganizations.

Application administrators can run the concurrent program Service Contracts
Concurrent Program for Reassigning Resources to assign new sales agents to
contracts in entered, active, signed, and hold statuses. For contracts in the
active, signed, and hold statuses. the concurrent program adds the resource in the
territory as a new vendor contact of role Salesperson and enters an end date for any
existing vendor contacts of role Salesperson. For contracts in the entered status, the
concurrent program replaces the existing vendor contacts of role Salesperson with
the one derived from the territory.

When the application cannot assign a resource from the territory, for example for
new or dormant customers that have no territories set up for them, the application
automatically notifies the territory administrator defined in system profile
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OKS: Notify Territory Admin that the contract remains unassigned. If this profile
is not set, the application looks for the individual to notify first in OKS: Contract
Administrator and, if none is set, then in OKC: Contract Approver.

Use these guidelines to use territories for assigning vendor contacts of role Salesperson.

To use sales territories to assign sales people to contracts:
1. Set up sales territories for Oracle Service Contracts as described in the Oracle Territory

Manager User Guide. Follow these guidelines during your setup:

2. Under the CRM Administrator responsibility, navigate to Territory Manager >
Territory Administration.

3. Enable Oracle Service Contracts qualifiers:

1. From the Administration Menu, choose Setup Qualifiers.

The Setup Qualifier window appears.

2. From the Usage List of Values, choose Oracle Service Contracts.

3. Click Find.

The application displays the list of qualifiers available for use in Oracle Service
Contracts:

• Country

• Customer Name

• Customer Range (alphabetical range)

• State

4. Enable the qualifiers you wish to use by selecting the Enabled check box.

5. Click Update Qualifiers.

6. Close the window to return to the territory Navigator.

7. Navigate to Select the Oracle Service Contracts folder in the territory manager
Navigator and create your territories. For each territory:

1. Choose Contract Renewal as the Transaction Type (it is the only choice available).

2. On the Transaction Qualifiers tab, choose the qualifiers using the Name
LOV. (Only those you have enabled are available for use.)

3. Enter the qualifier values for the territory.

4. Enter the name of one resource. (If you enter multiple resources, the application
uses only the first one on the list.)

8. Set the system profile OKS: Notify Territory Admin to the resource you wish to
notify if the contract if territory assignment fails to assign a sales agent.

9. Run the concurrent program Generate Territory Packages with the following
parameters:

• Usage: Oracle Service Contracts

• Transaction Type: Contract Renewal
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10. If you wish to have the application use the sales territories to automatically assign a
resource as a vendor contact in contracts created through Oracle Order Management
orders, then:

1. Set the system profile OKS: Territory Sales Person for First Year Contracts to
Derive. (By default this system profile is set to Retain, causing the application to
copy the sales person on the order to be the vendor contact or type Salesperson
on the contract.)

2. Make sure the following system profiles are set to the resource you wish to
notify if the application cannot assign a sales person to the contract based on
the territory setup. In this case, the application creates the contract without a
vendor contact and looks for a resource to notify in the following system profiles
and in the following order:

• OKS: Notify Territory Admin

• OKS: Contract Administrator

• OKC: Contract Approver

11. If you wish to reassign sales agents to contracts based on the sales territories, for
example, as a result of personnel changes or reorganizations, then run the concurrent
program Service Contracts Concurrent Program for Reassigning Resources. This
program reassigns sales agents to in Entered, Active, Signed and Hold statuses. For
contracts in the Entered status, the application replaces all vendor contacts of
role Salesperson with the resource supplied by the territory. For contracts in the
Active, Signed, and Hold statuses, the application end-dates (sysdate -1) the current
vendor contact(s) of role Salesperson and appends the resource supplied by the
territory. The application sets the new sales person’s start date to the sysdate. You
can restrict the scope of the concurrent program’s assignment by entering any
of the following parameters:

• Contract Number

• Contract Status

• Organization

• Sales Person (sales person within that organization)

If you do not enter any of these parameters, the program reassigns sales
agents to all contracts.

Implementing Quick Menu
Oracle Service Contracts’ agents can use the Quick Menu to navigate to windows in
other applications without having to change responsibility and requery the customer as
in past releases. The Quick Menu (which is available as a selection on the Tools menu)
increases agent productivity by preserving the customer context. For example, an agent
working on a contract for Business World can, with two clicks of a mouse, display
detailed information on Business World and its contacts in the Contact Center. There
the agent can modify customer information, including addresses, accounts, and other
details, and then switch back to the contract.

To enable the Quick Menu for Oracle Service Contracts follow the instructions in the
Oracle TeleService Implementation Guide in addition to the guidelines below.
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To enable the Quick Menu:
1. Select the Application Developer responsibility.

2. Navigate to Application > Menu

3. Verify that the Quick Menu for Service Contracts is added to
OKS_MANAGER_TOP_MENU as a submenu.

4. Add the forms you wish to use to the menu Quick Menu for Service Contracts
(OKS_QUICKMENU).

5. You can add forms from any application, but only forms that are Quick-Menu-enabled
will pass the customer context from the contract. For a complete list, see the seeded
Quick Menu for Customer Support (CSX_CUSTOMER_SUPPORT_QM).

6. Set the system profile Customer Care: Start Menu for Quick menu to Quick Menu
for Service Contracts at the Responsibility level. (By default, this system profile is set
to Quick Menu for Customer Support at the Site level.)

Note: Even if you do not set up the Quick Menu, the selection
remains enabled in the Tools menu. In this case, selecting the quick
menu displays the seeded Quick Menu for Customer Support (this
is the menu for the Oracle TeleService application). However, Oracle
Service Contracts agents cannot use this quick menu. If they attempt
to do so, they receive an error message that their responsibility does
not permit them to use its functions.

Implementing Multi-Currency Price List Support
Set up multi-currency price lists as specified in the Multi-Currency Conversion Lists
chapter of the Oracle Advanced Pricing User’s Guide.

To implement multi-currency price lists you must:
1. Set the system profile QP:Multi Currency Installed to Yes.

2. Run the concurrent program Update Price Lists with Multi-Currency Conversion
Criteria.

Note: After you have run the concurrent program, you cannot
revert your price lists back to single-currency price lists. Oracle does
not support changing the profile QP: Multi Currency Installed
back to No.
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